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Foreword 

Thanks a lot for choosing the 4041 series spectrum analyzer developed and manufactured by CETI. 

We are devoted to providing for you high-quality products and first-class after-sales service with your most 

concerns and demands in mind. Following the consistent tenet of “High Quality and Considerable Service”, we 

are committed to provide for our customers satisfactory products and services. For any questions, please contact 

us:

 

Tel +86-0532-86896691 

Website www.ceyear.com 

E-mail sales@ceyear.com 

Address: No.98 Xiangjiang Road, Qingdao City, China 

Postcode 266555 

This manual describes the applications, operation instructions, notices of use, performance characteristics, basic 

working principle, fault diagnosis and other directions regarding the 4041 series spectrum analyzer developed and 

manufactured by CETI, enabling you to get familiar with the operation methods and key points of use as soon as 

possible. For a proper use of this instrument, please carefully read and strictly follow this manual. 

This manual consists of 12 chapters: 

Chapter I describes the basic information of the 4041 series spectrum analyzer, including main technical features, 

already available or potentially available functions, and technical specifications. 

Chapters II~IX mainly covers operation instructions. Specifically speaking, Chapter II describes the method to 

handle a newly-received spectrum analyzer and the notices for use. Chapter III mainly introduces the front panel 

and external interfaces of the unit. Chapter IV, Chapter V, Chapter VI, Chapter VII, Chapter VIII and Chapter IX 

respectively introduce the Spectrum Analyzer measurement mode, Interference Analyzer measurement mode 

(option), Power meter mode (option), AM/FM/PM analyzer measurement mode (option), Channel scanner 

measurement mode (option) and field strength measurement mode (option) of the 4041 series spectrum analyzer. 

Chapters X and XI contain technical instructions, including brief description of working principle, as well as main 

technical specifications and test methods of performance characteristics. 

 
Statements 

This is the first version of User Manual for 4041 Series Spectrum Analyzer. 

This manual may be subject to change without notice. 

CETI reserves all the rights to the final explanation for all the information and 

terminologies referred to in this manual. 

This manual is the property of CETI. Without our permission, any 

organizations or individuals shall neither alter/temper nor duplicate/transmit 

this manual for profits; otherwise, CETI reserves the right to pursue any 

liabilities therefrom. 



 

 

Chapter XII contains maintenance instructions, including fault diagnosis steps, fault information description and 

repair methods. 

However, due to limitations of the author, the manual may be subject to errors or deficiencies. We sincerely 

welcome your corrections! We apologize for any inconvenience caused by our mistake in our work. 

The Author 

Oct. 2018 



 

 

Environment and Safety Instructions 
I. Safety Protection 

1. Safety precautions for the instrument 

1) Please use the designated packaging box for transportation, and protect the instrument against damage from 

dropping or violent impacting. 

2) Please select 100 V~120 V or 200 V~240 V AC 3-core stabilized power supply, so as to prevent the internal 

hardware from being damaged by high-power peak pulse interference. 

3) Keep the power supply properly grounded, as improper or wrong grounding may lead to unit damage. 

4) Wear anti-electrostatic wrist or take other anti-electrostatic measures when operating the unit, so as to 

prevent the unit from being damaged by the static electricity. 

5) Avoid signals above 16 VDC, and prevent the signal power from exceeding 30 dBm; otherwise, the unit may 

be damaged. 

6) Neither insert any objects from the opening on the housing of unit nor pour fluids on or into the unit; 

otherwise, short circuit may occur inside the unit and cause electrical shock, fire hazard or personal injury. 

7) Never cover the grooves or openings that serve for internal ventilation on the unit; otherwise, the unit may 

become overheated. Never place the unit on sofa, blanket or in a closed enclosure, unless a good ventilation 

is provided. 

8) Never place the unit on the heater, heating fan or other heat sources, and ensure that the ambient temperature 

is not above the maximum temperature specified in this manual. 

9) Please note that, the unit, once catching fire, may emit toxic gases or fluids that are harmful to human health. 

2. Safety precautions for other instrument & equipment 

1) Before connecting this unit, check its working condition and switch off the RF output, so as to prevent the 

tested device from being damaged by the high-power signals output by the unit. 

2) As the unit may output a higher power during self-test, please disconnect all the external equipment in this 

case. 

3) If, during the use of the spectrum analyzer, a fault warning indication occurs to tell the user that the spectrum 

analyzer involves an abnormality, please turn off the RF switch or power switch and disconnect all the 

external equipment to eliminate any possible influences on the tested device. 

3. Personal safety precautions 

1) Use a proper tool to transport the unit and its packaging box, and handle it gently to prevent personal injury 

when the unit drops. 

2) Keep the power supply properly grounded, as improper or wrong grounding may lead to personal injury. 

3) When it becomes necessary to wipe off the unit, please power it off in advance to prevent hazard of electrical 

shock. It is allowed to wipe the outside of unit using a dry or slightly wet soft cloth, and never attempt to 

wipe its inside. 

4) Any operator shall receive professional training before use, and be highly concentrated during use. The 

operator of the unit shall be sound in body and mind; otherwise, personal injury or property loss may occur. 

5) As the unit involves potential hazard of microwave radiation when working at a high power, please take 

corresponding radiation prevention measures. 

6) Never use the unit when its power line is damaged. Please check on a regular basis if the power line is 

normal. Take appropriate safety protection measures and place the power line in such a proper way that it 

will not be damaged and anybody will not be stumbled or electrocuted by the power line. 

7) Never use the unit outdoors in bad weather like thunderstorm, so as to prevent unit damage or personal 

injury. 

8) Neither insert any objects from the opening on the housing of unit nor pour fluids on or into the unit; 



 

 

otherwise, short circuit may occur inside the unit and/or cause electrical shock, fire hazard or personal injury. 

9) Like other industrial products, the use of allergic materials (allergens including aluminum) is inevitable. In 

case of any anaphylactic reaction (for instance, rash, repeated sneezes, eye irritation or breath with difficulty), 

please seek medical advice immediately to find out the causes. Please note that, the unit, once catching fire, 

may emit toxic gases or fluids that are harmful to human health. In this case, please take reasonable 

fire-fighting measures or evacuate from the operation station. 

10) This product, though in compliance with the EMC-related specifications, still has some electromagnetic 

radiation. Considering this, the user shall confirm if there are any personnel vulnerable to such radiation in 

the working environment, and when necessary, take corresponding preventive measures. 

11) This product can be opened only by the authorized personnel. Before opening the unit or performing other 

operations to it, cut off the power supply first. Only the technician of the manufacturer can perform such 

operations as instrument adjustment, part replacement, maintenance or repair, and when a safety-related parts 

needs replacement, always use the original part. 

II. Environment protection 

1. Disposal of packing container 

We are committed that the package of this product contains no harmful materials. Please keep well the packaging 

box and linings for transport purpose in the future; or, dispose the packages according to the local environment 

regulations. 

2. Treatment of scrapped articles 

Parts replaced during maintenance and upgrade of this instrument are to be recovered by CETI; when the 

instrument comes to the end of its service life, never throw or dispose it at will, and instead, please inform CETI 

or other qualified recycling unit for recycle. 

Unless otherwise specified, please follow Regulation on the Administration of the Recovery and Disposal of 

Waste Electrical and Electronic Products and local environment regulations. 
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Chapter I Overview 

For the purpose of this manual, the following safety symbols apply, and please be familiar with them and their 

meanings before operating this instrument! 

 

A “WARNING” sign indicates for an existing danger. It reminds the user to pay 

attention to a certain operation process, operation method or the similar. Any 

violation against the indicated rules or incorrect operation may lead to personal 

injury. It is not allowed to proceed until the warning conditions are fully 

comprehended and satisfied. 

 

 

A “CAUTION” sign provides prompt on important information but not dangerous 

situations. It reminds the user to pay attention to a certain operation process, operation 

method or the similar. Any violation against the indicated rules or incorrect operation 

may lead to instrument damage or loss of important data. It is not allowed to proceed 

until the cautioning conditions are fully comprehended and satisfied. 

CAUTION 

WARNING 

! 

! 
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Section 1 Product Overview 

1.1.1 Introduction 

The 4041 series spectrum analyzer is adopted with the compact portable box structure, which has advantages of 

small size, light weight, low power consumption and convenient carrying. The broadband millimeter-wave 

receiver miniaturization integrated design technology, whole phase locking technology based on the broadband 

VCO, full digital intermediate frequency design technology, and microwave composite multilayer circuit board 

design technology are adopted for this product, thus realizing high performance specifications and ensuring the 

economical efficiency of the product. The 4041 spectrum analyzer series currently consists of four types of 

products. The frequency measurement range covers 9kHz~20GHz, 9kHz~26.5GHz, 9kHz~32GHz and 

9kHz~44GHz respectively. The full spectrum of the product is equipped with a preamplifier, so that it has very 

high receiving sensitivity at any frequency point. In addition, with the 12.1-inch high brightness LCD and 

integrated design of capacitive touch screen, large button and virtual button combination design, its operation 

convenience is improved. For its performance specifications, it has excellent average noise level and phase noise 

indicator as well as the high scanning speed. For its measurement function, it has the option modes including the 

Interference Analyzer, channel scanner, AM/FM/PM analyzer, and USB Power meter, as well as a variety of 

measurement functions including the channel power, occupied bandwidth, adjacent channel power, audio 

demodulation, emission mask and carrier-to-noise ratio. This product can be used for the test and maintenance of 

the aviation, spaceflight, wireless communications and radar signals and devices, and it can also be used for the 

research, development and production of electronic products and the teaching experiment of scientific research 

institutes. For its outline, see Fig 1-1 below. 

 

Fig 1-1 4041 Series Spectrum Analyzer 

1.1.2 Characteristics 

The 4041 series spectrum analyzer is designed on the concept of highly integration, modularization and 

standardization and boasts excellent performance. Its main characteristics are described below: 
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 A portable case characterized by thin thickness and light weight, which can be conveniently placed and 

carried; 

 Wide frequency range covering 9kHz~20GHz/26.5GHz/32GHz/44GHz; with the full frequency preamplifier 

as standard; 

 High sensitivity, and a Min. DANL of -163 dBm@1 Hz RBW (with preamplifier on); 

 Phase noise indicator (1 GHz carrier): -106 dBc/Hz@100 kHz frequency offset; 

 Resolution bandwidth: 1 Hz~10 MHz; 

 Extremely high sweep speed: Minimum sweep time@ 1 GHz span <20 ms; 

 Various measurement functions, such as the channel power, occupied bandwidth, adjacent channel power, 

audio demodulation, carrier-to-noise ratio, and emission mask.; 

 Abundant test function mode options: Interference Analyzer (spectrogram, RSSI), AM/FM/PM analyzer 

(AM/FM/PM), Channel scanner, and high-precision USB Power meter, etc.; 

 Easy to operate, equipped with 12.1-inch high brightness LCD screen featuring large font display and loose 

button layout, and supporting the capacitive touch screen operation and touch screen marker dragging. 

1.1.3 Functions 

The 4041 series spectrum analyzer is featured with abundant measurement functions, mainly including: 

 Spectrum Analyzer function, which allows basic Spectrum Analyzer to the signals, including field strength 

measurement, channel power, occupied bandwidth, adjacent channel power, emission mask, carrier-to-noise 

ratio, audio demodulation, IQ capture, tracking generation and other intelligent measurement functions; 

 List sweep function (option), which allows the continuous scanning measurement of multiple frequency 

bands; 

 Interference analyzer function (option), which provides functions including the spectrogram and RSSI 

measurement; 

 AM/FM/PM analyzer function (option), which allows the modulation characteristics analysis of the 

AM/FM/PM signals; 

 Power meter function (option), which allows high-precision USB Power meter; 

 Channel scanner function (option), which allows signal Power meter of multiple channels or frequencies; 

 Field strength measurement function (option), which allows dot frequency measurement, frequency scanning 

measurement and list scanning measurement; 

 GPS positioning function (option), which realizes GPS positioning through an external GPS antenna; 

 Zero span intermediate frequency output function (option), which realizes output of third/fourth-intermediate 

frequency at zero span through the intermediate frequency output interface. 

1.1.4 Typical Applications 

■ Test of Components and Parts 

It can be used for the test of parameters and specifications including the gain, frequency response, frequency 

conversion loss and insertion loss of the components and modules including the amplifier, filter, mixer, attenuator, 

cable and directional coupler. 
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■ Test and Diagnosis of the Transmitter and Receiver 

The 4041 spectrum analyzer has a number of measurement function modes including the Spectrum Analyzer, 

Interference Analyzer, AM/FM/PM analyzer, USB Power meter, and Channel scanner, and it also has a number of 

measurement functions including the channel power, occupied bandwidth, adjacent channel power, 

carrier-to-noise ratio, field strength, and emission mask; therefore, it can provide the comprehensive Spectrum 

Analyzer and diagnosis service for the test of the transmitter and receiver. 
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Section 2 Main Technical Specifications 

The 4041 series spectrum analyzer has been subject to strict test of technical specifications before delivery, and 

the user can choose to prove the technical specifications given in this manual by test. For the main technical 

specifications of the 4141 series spectrum analyzer, see the Table 1-1 below. 

 The 4041 series spectrum analyzer, after being stored at ambient temperature 2h and 

then preheated for 30 min, meet all the technical specifications within the given 

working temperature range. 

Additional features expressed by typical values are for reference only, and does not 

constitute subject of proof. 

Table 1-1 Technical Specifications of 4041 Series Spectrum Analyzer 

Test Item Technical Specifications 

Model 4041D/E/F/G 

Frequency range 

4041D: 9 kHz~20 GHz    4041E: 9 kHz~26.5 GHz 

4041F: 9 kHz~32 GHz    4041G: 9 kHz~44 GHz 

Tuning resolution: 1 Hz 

Frequency reference 

Nominal frequency: 10 MHz 

Frequency reference error: (Time to last calibration date × Aging rate + 

Temperature stability + Calibration accuracy) 

Aging rate: 510
-7

/year  

Temperature stability: 110
-7

 (0°C  50°C, relative to 25 5°C) 

Initial calibration accuracy: 310
-7

 

Note: The time to last calibration date is 1 year by default 

Frequency readout accuracy 
(frequency reading × frequency reference error +2% × span +10% × 

resolution bandwidth) 

Frequency span 

Range: 100 Hz~The upper limit of the frequency of the corresponding model; 

0 Hz (zero span) 

Tuning resolution: 1 Hz 

Accuracy: ±2.0% 

Sweep Time 
Range: 10 μs~600 s (zero span) 

Accuracy: ±2.00% (zero span) 

Resolution Bandwidth 

Range: 1 Hz~10 MHz (1-3 times step) 

Accuracy (3.0 dB): ±10%       1 kHz~3 MHz 

                ±20%       10 MHz 

Resolution bandwidth change 

uncertainty 
1.00 dB    1 Hz~10 MHz (reference: 100 kHz RBW) 

CAUTION 
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Video Bandwidth 1 Hz~10 MHz (1-3 times step) 

SSB phase noise 

(Carrier 1 GHz,  20℃~30℃) 

≤-102 dBc/Hz@10 kHz frequency offset 

≤-106 dBc/Hz@100 kHz frequency offset 

≤-111 dBc/Hz@1MHz frequency offset 

≤-123 dBc/Hz@10MHz frequency offset 

Displayed average noise level 

(Tracking Generator off, 50 Ω 

input end load, 0 dB input 

attenuation, average detection, 

video type logarithm, RBW 

normalized to 1 Hz, 20℃30℃) 

Preamplifier off 

≤-135 dBm (2 MHz~10 MHz)    ≤-138 dBm (10 MHz~20 GHz) 

≤-135 dBm (20 GHz~32 GHz)    ≤-127 dBm (32 GHz~40 GHz) 

≤-120 dBm (40 GHz~44 GHz) 

Preamplifier on 

≤-150 dBm (2 MHz~10 MHz)    ≤-157 dBm (10 MHz~20 GHz) 

≤-154 dBm (20 GHz~32 GHz)    ≤-148 dBm (32 GHz~40 GHz) 

≤-140 dBm (40 GHz~44 GHz)   

Second harmonic distortion 

(0 dB attenuation, -30 dBm input 

signal) 

<-60 dBc  

Third-order intermodulation 

distortion 

(-15 dBm double tone signal, 100 

kHz interval, 0 dB attenuation, 

preamplifier off) 

≥+7 dBm              50 MHz~4 GHz 

≥+6 dBm              4 GHz~13 GHz 

≥+6 dBm              13 GHz~44 GHz 

1 dB gain compression 

(Dual-tone method test, signal 

interval 10 MHz) 

≥-2 dBm               50 MHz~4 GHz 

≥-3 dBm                4 GHz~13 GHz 

≥-3 dBm               13 GHz~44 GHz 

Image, multiple and out-of-band 

response 

(-10 dBm mixer level) 

≤-65 dBc               10 MHz~20 GHz 

≤-60 dBc               20 GHz~44 GHz 

Residual response 

(RF input matching, 0 dB 

attenuation, Tracking Generator 

off) 

Exceptional frequency point 3,200 MHz 

Preamplifier on: 

≤-100 dBm             10 MHz~20 GHz 

≤-95 dBm              20 GHz~44 GHz 

Preamplifier off: 

≤-90 dBm              10 MHz~13 GHz 

≤-85 dBm              13 GHz~20 GHz 

≤-80 dBm              20 GHz~44 GHz 

Scale fidelity ±1.00 dB 

Total level uncertainty ±1.8 dB (10 MHz~13 GHz) 
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(after 30 minute warm-up,input 

signal 0 dBm ~-50 dBm, all set as 

auto coupling,20℃~30℃) 

±2.3 dB (13 GHz ~40 GHz) 

Input attenuator 
Attenuation range: 0 dB~50 dB, 10 dB step 

Switching uncertainty: ±1.20 dB 

Maximum safe input level 

（CW input） 

+30dBm, typical value (≥10dB attenuation,  preamplifier off ) 

+23dBm, typical value (<10dB attenuation,  preamplifier off ) 

+13dBm, typical value (preamplifier on) 

Reference Level 

Logarithmic scale: -120 dBm~+30 dBm, 1 dB step 

Linear scale: 22.36 uV~7.07 V, 0.1% step 

Switching uncertainty: ±1.20 dB (reference level: 0 dBm~-60 dBm) 

Video Bandwidth 1 Hz~10 MHz (1-3 times step) 

Input voltage standing-wave ratio 

(>10 dB input attenuation) 

≤ 1.80:1  50 MHz~20 GHz 

≤ 2.20:1  20 GHz~44 GHz 
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Chapter II User Guide 

Section 1 Self-inspection after Unpacking 

2.1.1 Model confirmation 

The following items are in the package box after unpacking: 

a) 4041 series spectrum analyzer 1 set 

b) Three-core power line 1 piece 

c) Product quick start guide 1 copy 

d) USB cable 1 piece 

e) Certificate of conformity 1 piece 

f) Options Several 

g) Packing list 1 copy 

Please check the above items carefully according to order contract and packing list. In the case of any problem, 

please contact our Business Center by the contact means in the foreword, and we will solve it as soon as possible. 

  
The instrument is a valuable item, so it shall be handled with care. 

2.1.2 Appearance inspection 

Carefully check whether the instrument is damaged due to the handling, and if it has obvious damage, do not 

power it on! Please contact our Business Center by the contact means in the foreword. We will promptly repair or 

replace it as appropriate. 

Section 2 Safety Instructions 

The safety of the 4041 series spectrum analyzer complies with the requirements in GJB3947A-2009. There are no 

user-operated parts inside the instrument. Do not open the instrument housing without authorization, otherwise it 

may cause personal injury. In order to ensure your safety and proper use of the instrument, please read the 

following safety precautions carefully before use. 

2.2.1 Environmental requirements 

To ensure long service life and effective and accurate measurement of the 4041 series instrument, test it under the 

following environmental conditions: 

 Temperature range: 

Storage temperature range: -40℃～+70℃ 

Working temperature range: 0℃～+50℃ 

 Low atmospheric pressure: 

Low atmospheric pressure (altitude): 0～4,600 m 

CAUTION 
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2.2.2 Selection of power line 

The 4041 series spectrum analyzer uses three-core power line complying with international safety standards. 

When the power line is used, insert it into a suitable power outlet with protection ground so that the power line 

can ground the instrument housing. It is recommended to use the attached power line of the instrument. When 

replacing the power line, it is recommended to use the same type of 250 V/10 A power line. 

2.2.3 Power requirements 

 AC power 

In the case of AC power, the attached power line or the same type, with AC power of 100 V~120 V or 200 V~240 

V and frequency of 47 Hz~440 Hz, must be used. The allowable range of steady-state voltage is 10% of the rated 

value, and of steady-state frequency is 5% of the rated value. 

2.2.4 Electrostatic discharge (ESD) protection 

Electrostatic discharge is extremely destructive to electronic components and equipment, so the powered 

instrument must be operated on a workbench with ESD protection. So please pay attention to ensuring ESD 

protection when using the instrument. The following ESD protection measures can be taken if conditions are met: 

a) Ensure that all instruments are properly grounded to prevent ESD. 

b) Operator must wear wrist straps with ESD protection before touching connectors and core wires or 

assembling any part. 

c) Before connecting the cable to the instrument for testing, be sure to ground the center conductor of the cable 

first. The following steps can be used: Connect a short-circuiter at one end of the cable to short the center 

conductor and outer conductor of the cable. Wearing wrist straps with ESD protection, grasp the cable 

connector housing, connect the other end of the cable, and then remove the short-circuiter. 

2.2.5 Input/output port protection 

The standard impedance of RF ports for the 4041 series spectrum analyzer is 50 Ω, so add test signals or connect 

appropriate load impedance in strict accordance with the port requirements to prevent damaging power amplifying 

circuit. 

2.2.6 Cleaning of instrument front display panel 

After using for a period of time, if you want to clean the instrument display panel, follow the steps below: 

a) Turn off the instrument and unplug the power line. 

b) Clean the display panel gently with a piece of clean and soft cotton cloth dipped with cleaning agent. 

c) Then dry the display panel with a piece of clean and soft cotton cloth. 

d) Do not connect the power line until the cleaning agent dries out. 

 

The RF input port of the spectrum analyzer has the allowable maximum input level, 

so it is forbidden to add signals beyond the limit, otherwise the instrument will be 

damaged. 

WARNING 

! 
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There is a layer of ESD protection coating on the surface of the display, so never use 

any cleaning agent containing fluoride, acid or alkali. Do not spray the cleaning agent 

directly onto the display panel, otherwise the cleaning agent may leak into the internal 

of the instrument, causing damages. 

CAUTION 
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Section 3 User Checks 

2.3.1 Power-on of spectrum analyzer 

Connect the 4041 series spectrum analyzer to the external power supply, press and hold the white power key [ ] 

on the front panel for more than 3 s, then the backlight of the display comes on to show that the startup process 

takes about 30 s, displaying the normal startup status interface. After warming up for 10 minutes, there should be 

no alarm indications on the display interface. 

2.3.2 Power-off of spectrum analyzer 

Press and hold the white power key [ ] in the lower left corner of the front panel on the spectrum analyzer for 

about 3 s, and then the spectrum analyzer will automatically exit the measurement application and turn off the 

power. 
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Chapter III Basic Operations 

Section 1 Introduction to Front Panel 

The front panel of the 4041 series spectrum analyzer is as shown in Fig 3-1. 

Logo 
display 
area

Logo 
display 
area

Touch 

screen 

display 

area

Touch 

screen 

display 

area

Power 

key and 

indicator

Power 

key and 

indicator

SpeakerSpeaker USBUSB

RF input 

port

RF input 

port

Key 

zone

Key 

zone

Bottom 

support

Bottom 

support

HandleHandle

Tracking 

generator output 

port (option)

Tracking 

generator output 

port (option)

 

Fig 3-1 Front panel 

 In this manual, the keys on the front panel are indicated in the form of 

【XXX】, and XXX is the name of the key; the bottom keys on the touch 

screen are indicated in the form of 【XXX】, and XXX is the name of the key; 

the menu buttons on the right are indicated in the form of [XXX], and XXX is 

the menu name. 

3.1.1 Display area 

The 4041 series spectrum analyzer is designed with a 12.1-inch color touch screen for realizing parameter setting 

and information displaying of the instrument, eliminating the need for complicated hard and soft key menu setting 

steps, and greatly simplifying the user's operation. 

The display area can display the followings when the instrument performs different functions: display multiple 

instrument windows, and display various settings and measurement data information of the instrument in the 

windows; display the working status information of the instrument; display the current input data when such 

parameters as input frequency are needed; display the current working time of the system; display the menu 

information corresponding to the currently active instrument window; the details are as shown in Fig 3-2:  

CAUTION 
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Fig 3-2 Display area 

The screen display area of the 4041 series spectrum analyzer displays information on various settings and 

instrument status of the current measurement in the information display area. According to the positions of the 

information on the screen, it can be divided into 7 zones, that is, top information display area, display area of 

marker, signal standard and title, left information display area, measurement data display area, software menu 

display area, bottom information display area, and bottom function key zone. 

1) Top information display area 

The top information display area is on the top of the screen, displaying the information such as system date, time, 

GPS status, etc. from left to right. 

Setting and modification of system date and time: via 【System】→ [Date Time]. 

Modification of date format: via 【System】→ [Date Format]. 

2) Display area of marker, signal standard and title 

The set title information is displayed via 【System】→ [Title Off On]; 

The currently selected signal standard name is displayed via 【Freq】→[Signal Std]; 

The frequency and amplitude of the currently active marker is displayed via 【Marker】 or 【Peak】. 

3) Measurement trace display area 

The measurement data is displayed in this zone. And different information can be displayed in different 

measurement modes. 

4) Left information display area 
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This zone is located in the upper left part of the screen. It displays reference level, attenuator settings, displayed 

scale, RBW, VBW, sweep time and other information of the current measurement, each of which can be set by the 

corresponding function keys. The corresponding key operations are listed in the table below: 

Table 3-1 Functions of left information display area in Spectrum Analyzer mode of 4041 series spectrum analyzer 

No. Description Function key 

1 
Ref Level 

0.0 dBm 
【Ampt】→[Ref Level] 

2 
Atten 

10 dB 
【Ampt】→[Atten Auto Man] 

3 
Scale/Div 

10.0 dB 
【Ampt】→[Scale/Div] 

4 
Res BW 

3 MHz 
【BW】→[Res BW Auto Man] 

5 
Video BW 

3 MHz 
【BW】→[Video BW Auto Man] 

6 
Sweep Time 

441.000 ms 
【Sweep】→ [Sweep time Auto Man] 

7 
Average 

Off 
【BW】→[Average Off On] 

8 
Detector 

Normal 
【BW】→[Detector] 

5) Bottom information display area 

This zone is located at the bottom of the screen and mainly displays two kinds of information: 

 Local: Display the current working status of the spectrum analyzer, either local or remote control. 

 The current center frequency and span are displayed at the lowermost position of the screen. When the 

spectrum analyzer is set to zero span mode, such bottom information as start time, center frequency and end 

time will be displayed. 

6) Software menu display area 

In order to improve the operation flexibility of the 4041 series spectrum analyzer and give full play to the 

advantages of the touch screen, the 4041 series resident software is designed with 8 blue touch keys on the right. 

The corresponding functions of these 8 keys are directly displayed on the corresponding key zones. 

7) Bottom function key zone 

The bottom function key zone is designed with 6 function keys, which can achieve the same functions as the hard 

keys. Different menu names can be displayed in different measurement modes for ease of the user measurement. 
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3.1.2 Digital input area 

This zone contains arrow keys, knob, numeric keys, backspace key, cancel key and confirmation key. All inputs 

can be changed by the keys and knob in the input zone. The keys in the input zone are described as follows. 

 Arrow keys: That is, up/down/left/right keys. The step values of the up and down keys correspond to the 

step value of each parameter. The left and right keys are mainly used for dialog editing. 

 Knob: For increasing or decreasing the value. Turn the knob clockwise to increase the value, and 

counterclockwise to decrease the value. The knob can be used together with the up/down keys to change the 

value. The step value of the knob is the same as those of the up/down keys. 

 Numeric keys: For inputting numbers (including minus sign). 

 Backspace key: The last input data can be revoked bit by bit according to the data status. 

 Cancel key: For canceling the currently inactive input data. 

 Enter key: For confirming the current parameter settings. 

3.1.3 Function key zone 

The function key zone is located at the bottom of the screen for changing the parameter settings of the 

measurement, including 10 keys: 

 【Freq】: For setting the center frequency, start and stop frequencies, span, frequency step and other 

parameters of the measurement; 

 【Ampt】: For setting the reference level, attenuator settings, displayed scale, unit and preamplifier control, 

etc.; 

 【Marker】: For setting the specific parameters of the measurement marker; 

 【Sweep】: For setting the sweep time, sweep type, sweep points, trigger, etc. 

 【Span】: For setting the span and IF output, etc. 

 【BW】: For setting the RBW, VBW, detection type, average and other parameters of the measurement; 

 【Peak】: For getting the peak parameters; 

 【Trace】: For setting the trace display status parameters; 

 【File】: For saving or reading data files and status files, and for setting the storage locations; 

 【Mode】: For setting the measurement modes, including Spectrum Analyzer, Interference Analyzer, 

AM/FM/PM analyzer, Power meter, channel scanner, and field strength measurement.  

3.1.4 Preset key 

For turning off the instrument and re-power it on. 

3.1.5 Power key 

For turning off or on the spectrum analyzer. When the instrument is in "standby" state, pressing and holding the 
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power key for more than 3 s can turn on the spectrum analyzer. When the instrument is in the working state, 

pressing and holding the power key for more than 3 s can turn off the spectrum analyzer. 
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Section 2 Introduction to Interfaces 

The peripheral interfaces of the 4041 series spectrum analyzer are mainly located on the rear panel as shown in 

Fig 3-3, and they are divided into power interfaces, test ports and digital interfaces. 

 

Fig 3-3 Diagram of interfaces 

3.2.1 Power interface 

The power outlet and switch is the power interface of the instrument, and it can be used to supply the spectrum 

analyzer directly by using external AC power. For the external power interface, the inner conductor is positive, 

and the outer conductor is grounded. 

3.2.2 Test ports 

1) RF input port: for the input of the measured signals. The 4041 series test signal input port is 50 Ω. 4041D/E 

model uses N-type female port, and 4041F/G model uses 2.4 mm male port. 

2) Tracking generator output port (option): for the output of the tracking generator signal. The range of the 

output signal power is -5 dBm ~ -35 dBm. 4041 series tracking generator output interface uses N-type female 

port. 

3) 10 MHz input/output port: for connecting 10 MHz signal of the external equipment as a reference signal of 

the spectrum analyzer; or for the output of the internal 10 MHz reference signal from the spectrum analyzer 

for use by the external equipment. 

4) IF output port: in the case of zero span, the third or fourth IF signal output can be provided via software 

configuration for use by the external equipment. 

5) Trigger input port: the 4041 series can be set to external trigger mode. The external trigger source is 

connected to the trigger input port of the spectrum analyzer. The output range of the source must be 

-5V~+5V. This can be set by the software to use either rising edge trigger or falling edge trigger. 

6) GPS antenna port: for connecting the GPS antenna so as to locate the current position of the spectrum 

analyzer. 

Zero span intermediate 
frequency output 

Trigger 

Reference input/output 

Network port 

 USB programmable 
interface 

Power outlet and 
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Fixing hole 
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In order to protect the spectrum analyzer, the instrument test ports are provided 

with some signs. To use the spectrum analyzer, be sure to read these signs to 

avoid permanent damage to the instrument. 

For details of the instrument signs, see section 3.2.4. 

3.2.3 Digital interfaces 

1) B-type USB interface: For connecting to the external PC. The PC uses the programmable commands or 

programmable function library to achieve 4041 series program control or data transmission. 

 

The first time you connect the spectrum analyzer to your PC via USB, you need to 

install a device driver. 

2) A-type USB interface: For connecting to the USB peripherals, such as USB storage devices, USB power 

probes, etc. 

3) LAN (network) port: This is a network port of 10/100 Mbps for connecting to the computer (PC) via network 

cable. The PC uses the programmable commands or programmable function library to achieve 4041 series 

program control or data transmission. 

4) VGA interface: For connecting to the extern display device. 

3.2.4 Instrument signs 

The instrument signs (warning signs) indicate that the maximum input power of the test port is +30 dBm and the 

maximum input DC level is 16 VDC. So the user must not connect signals beyond this range to the ports. Inputs 

exceeding the above range may destroy the instrument! 

  WARNING 

 ! 

! 

CAUTION 
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Chapter IV Spectrum Analyzer Mode 

This chapter mainly introduces relevant information of the Spectrum Analyzer mode of 4024 series spectrum 

analyzer, including some typical measurement functions and methods, so that the user that operates this 

instrument for the first time can have a general knowledge on some typical applications and test operations of the 

Spectrum Analyzer mode after reading this section and get familiar with the operation of this mode. 

 

All the operations in this chapter are based on the condition that the Spectrum 

Analyzer mode has been selected and will no longer be described separately 

hereinafter. 

Since the 4041 series Spectrum Analyzer mode has many measurement functions, it contains various complex 

parameters, such as frequency parameter, amplitude parameter, average bandwidth parameter, trace parameter, 

scan parameter and marker parameter and other the most basic function parameters. In addition, it contains many 

other special function parameters, including signal tracking, noise marker, peak tracking, counter, List sweep, 

trigger, limit line, field strength measurement, channel power, occupied bandwidth, adjacent channel power, 

carrier-to-noise ratio, emission mask, IQ capture, tune&listen, etc. 

 Signal track 

If the measured signal is a drift signal, the signal tracking function of spectrum analyzer is enabled and the 

activated marker is placed on the signal peak the marker peak will always be displayed at the center frequency of 

spectrum analyzer, which is convenient for measurement. 

 Noise marker 

The noise marker displays the noise power that normalizes the noise to 1 Hz bandwidth near the activated marker. 

With the noise marker enabled and the detector set to sampling detection mode, if the amplitude adopts 

logarithmic scale, the unit of marker reading will switch to dBm (1 Hz) or dB/Hz automatically, and if the 

amplitude adopts linear scale, the unit of marker reading will switch to V (1 Hz) or % automatically. 

 Peak track 

When the peak tracking function is enabled, the marker will perform peak search once at the end of each scan. 

 Counter 

When the frequency counter function is enabled, it will make the marker reading more accurate, which is 

beneficial to improve the accuracy of frequency measurement. The measurement accuracy can reach Hz level, 

with an error of ±10 Hz. 

 List sweep 

The List sweep function enables the user to edit the scan frequency band, and the spectrum analyzer scans by the 

set frequency range and other parameters based on the edited list. 

 Trigger 

Select the trigger mode of scan or measurement, which includes [Free Run], [Video], [External], [Slope] and 

[Delay]. The user can select proper mode according to different requirements. A new scan or measurement will be 

initiated if the trigger mode is set to free trigger after last continuous scan or single scan. Set the trigger mode to 

CAUTION 
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video trigger. The scan will be triggered as long as the positive ramp portion of the input trigger signal passes the 

video trigger level set by the [Slope Rising Falling] command. When the trigger mode is set to external trigger, 

the scan and measurement will be synchronized with the next voltage cycle. 

 Limit 

The limit function is intended to monitor the signals in a certain frequency band. Since the spectrum analyzer is 

designed with upper and lower limit lines and allows the user to set the limit by himself, it will give an audible 

alarm signal in case the amplitude of any signal in a certain frequency band goes above the set upper limit line or 

below the set lower limit line. 

 Field strength measurement 

The spectrum analyzer has the field strength measurement function and relevant soft menus, such as [Field 

Strength Off On], [Recall Antenna], [Edit Antenna] and [Save Antenna], which can be used to perform field 

strength test quickly with the cooperation of corresponding test antenna. 

 Carrier-to-noise ratio 

The carrier-to-noise ratio function is intended to measure the ratio of carrier power to noise power, and contains 

carrier bandwidth, noise bandwidth, offset frequency, span, carrier power, noise power, carrier-to-noise ratio and 

other parameters. 

 Emission mask 

The emission mask function is intended to recall the limit line as a mask to measure whether the signal power is 

limited by the mask. The mask parameter is a limit line, and is assigned by recalling the limit line. The mask can 

move up and down and side to side according to the center frequency and reference power. The mask always 

moves the center point of limit line side to side to the center frequency, and moves the center point up and down to 

the reference power according to the calculated reference power. The reference power is divided into peak power 

and channel power, and which power is to be selected is determined by the type of reference power. 

 IQ capture 

The IQ capture function is intended to capture IQ data and store it in the instrument according to capture time, 

sample rate, capture mode and other parameters set by the user. 

 Tune & Listen 

The spectrum analyzer has the audio demodulation function and can be used to monitor the stations. The effects of 

the demodulated sound can be improved by adjusting the resolution bandwidth and will be the best when the 

resolution bandwidth is set between 300~30 kHz in demodulation mode. 
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Section 1 Introduction to Typical Measurement 

The 4041 series Spectrum Analyzer mode is the basic working mode of the product and some typical 

measurement methods of this working mode, including measurement method of basic signal, the method to 

improve the accuracy of frequency measurement, measurement method of small signals, the method to distinguish 

signals of similar frequency and other basic measurement methods, have been introduced in "Quick Start Guide of 

4041 Series Spectrum Analyzer”. In addition, this section introduces some advanced typical measurement 

functions and methods for 4041 series Spectrum Analyzer mode, mainly including the followings: 

a) Channel Power meter. 

b) Occupied bandwidth measurement. 

c) Adjacent channel Power meter. 

c) Third-order intermodulation distortion measurement. 

e) Drift signal measurement. 

f) Noise signal measurement. 

g) Distortion measurement. 

h) Pulse radio frequency signal measurement. 

 

If 【Preset】 key on the front panel is pressed, the spectrum analyzer will reset. Unless 

otherwise specified, all the following examples are started from pressing 【Preset】 

key. 

4.1.1 Channel Power measurement 

In this section, the channel Power measurement of FM signal is taken as an example to demonstrate the method to 

measure the channel power of signals with the channel Power measurement function of 4041 series spectrum 

analyzer. 

1) Definition of channel power 

The channel Power measurement is one of the most common measurements of the radio frequency transmission 

system, and the channel power refers to the power transmitted by the signals within the certain frequency range 

over a specific interval. In the power amplifier and filter circuit test, the system is faulty if no specific power can 

be measured. The channel Power measurement may be used to evaluate the communication transmitter and to 

determine the quality of radio frequency transmission by comparing it with the specific communication protocol. 

The 4041 series spectrum analyzer may be used to measure the channel power of FM signal. Since the FM signal 

and the CW signal differ in many respects, accurate setting will make the measured FM signal more accurate. 

2) Measurement procedure 

The procedure for measuring the channel power of FM signal with the 4041 series spectrum analyzer is as 

follows: 

a) Set the signal generator to output FM signal; 

CAUTION 
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b) Set the frequency to 1 GHz, the power to -10 dBm, the frequency modulation frequency offset to 500 kHz, 

the modulation rate to 10 kHz, and then connect the output of signal generator to the RF input of spectrum 

analyzer with the cable, as shown in Fig 4-1, in order to generate a FM signal with the signal generator. Turn 

on the modulation output switch and the RF switch.  

 

Fig 4-1 Connection diagram of signal generator and spectrum analyzer 

c) Preset the spectrum analyzer to default state: 

Press 【Preset】. 

d) Enable the channel Power measurement function: 

Press 【Measure】, [Channel Power] and [Channel Pwr Off On] successively to enable the channel Power function. 

e) Set the center frequency: 

Press 【Measure】, [Channel Power] and [Center Freq] successively, and then set the center frequency of spectrum 

analyzer to the frequency of the measured signal (i.e., 1 GHz) with the numeric key. 

f) Set the channel power bandwidth: 

Press 【Measure】, [Channel Power] and [Channel BW] successively, and then set the channel power bandwidth to 

1 MHz with the numeric key. 

g) Set the channel power span: 

Press 【Measure】, [Channel Power] and [Span] successively, and then set the channel power span to 2 MHz with 

the numeric key. 

h) Set the resolution bandwidth and video bandwidth of the spectrum analyzer: 

Press 【BW】 and [Res BW Auto Man] successively, and then set the resolution bandwidth to 30 kHz; 

Press 【BW】 and [Video BW Auto Man] successively, and then set the video bandwidth to 30 kHz or less. 

 

The channel power bandwidth represents the frequency width in which the spectrum 

analyzer displays power, while the channel power span is the frequency range in which 

the spectrum analyzer scans. The set value of channel power span should not be less 

than the channel power bandwidth; otherwise, the spectrum analyzer will set the 

channel power span to the channel power bandwidth automatically. The channel power 

Synthesized 
signal generator 

Spectrum Analyzer 

Adapter 

2.4 mm cable 
Adapter 

CAUTION 
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span is proportional to the channel power bandwidth (ratio range: 1~10). This ratio will 

remain unchanged when the channel power bandwidth is changed. Changing the 

channel power span may change this ratio. For example, when the channel power 

bandwidth is doubled, the spectrum analyzer will also double the channel power span. 

i) Enable the average function: 

Press 【BW】 and [Average Off On] successively, set the average number of times to 16, and then enable the 

average function. 

After the channel Power meter function is enabled, the detector mode will be switched to the RMS mode if the 

spectrum analyzer is in auto detector mode. The two vertical white lines displayed on the screen indicate the 

bandwidth of channel power and the results are displayed at the bottom of the screen. The channel Power 

measurement is as shown in Fig 4-2. 

 

Fig 4-2 Channel Power meter of FM signal 

4.1.2 Occupied bandwidth measurement 

In this section, the occupied bandwidth measurement of FM signal is taken as an example to demonstrate the 

method to measure the occupied bandwidth of signals with the occupied bandwidth measurement function of 4041 

series spectrum analyzer. 

1) Definition of occupied bandwidth 

Occupied bandwidth refers to the frequency bandwidth containing a certain percentage of the total transmitted 

power and is centered on the center frequency of designated channel. The occupied bandwidth measurement 

function of 4041 series spectrum analyzer can give measurements quickly, clearly and accurately. There are two 

calculation methods for occupied bandwidth according to the modulation mode. 

a) Power percentage method: 

Calculate the bandwidth of those frequencies containing a certain percentage of the total power of transmission 
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signal to obtain the occupied bandwidth of the signal. The percentage of power mentioned above may be set by 

the user. 

b) dBc down method: 

This calculation method defines the occupied bandwidth as the distance between the two frequency points when 

the signal power on both sides of the frequency point where the peak power of the signal is located is reduced by 

dBc. The power down dBc of the signal is to be set by the user. 

2) Measurement procedure 

The procedure for measuring the occupied bandwidth with the 4041 series spectrum analyzer is as follows: 

a) Set the signal generator so as to output FM signal: 

Set the frequency to 1 GHz, the power to -10 dBm, the frequency modulation frequency offset to 500 kHz, the 

modulation rate to 10 kHz, and then connect the output of signal generator to the RF input of spectrum analyzer 

with the cable, as shown in Fig 4-1, in order to generate a FM signal with the signal generator. Turn on the 

modulation output switch and the RF switch. 

b) Preset the spectrum analyzer to default state: 

Press 【Preset】. 

c) Set the center frequency: 

Press 【Freq】 and [Center Freq] successively, and then set the center frequency of spectrum analyzer to the 

frequency of the measured signal (i.e., 1 GHz) with the numeric key. 

d) Set the resolution bandwidth: 

Press 【BW】 and [Res BW Auto Man] successively, and then set the resolution bandwidth to an appropriate 

value. 

e) Set the video bandwidth: 

Press 【BW】 and [Video BW Auto Man] successively, and then set the video bandwidth to an appropriate value. 

To improve the accuracy of measurement, it is recommended that the ratio of RBW to VBW be greater than 10. 

The ratio of RBW to VBW can be changed by pressing [RBW/VBW]. 

f) Switch the spectrum analyzer to the occupied bandwidth measurement mode: 

Press 【Measure】, [OBW] and [OBW Off On] successively. 

After the occupied bandwidth measurement function is enabled, the spectrum analyzer switches to the occupied 

bandwidth measurement, with the results displayed at the bottom of the screen. The schematic diagram of 

occupied bandwidth measurement is as shown in Fig 4-3. The two vertical white lines on the screen visually 

indicate the frequency range of occupied bandwidth. When the occupied bandwidth measurement function is 

enabled, the detection mode will be switched to the RMS detection mode automatically if the spectrum analyzer is 

in automatic detection mode. The user can change the measurement method, occupied bandwidth span and other 

parameters through the corresponding menu and thus to obtain more accurate measurements. 
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g) Select the measurement method: 

Press 【Measure】, [OBW] and [Method % dBc] successively, and then select the measurement method of 

occupied bandwidth. The measurement method can be set to the power percentage method or the dBc down 

method. The underlined mode is the mode selected currently, and the percentage method is set as default. 

 

Fig 4-3 Occupied bandwidth measurement 

h) Change the percentage: 

If you decide to use the power percentage method, press 【Measure】, [OBW] and [%  99%] successively and 

then change the percentage with the numeric key, the Up or Down key or the knob. The set value of percentage 

ranges from 10% to 99.99% with a minimum step of 0.01%, and 99% is set as default. 

i) Change the value of dBc: 

If you decide to use the dBc down method, press 【Measure】, [OBW] and [dBc -3.00 dB] successively and then 

change the value of X dB with the numeric key, the UP or DOWN key or the knob. The set value of X dB ranges 

from -0.1 dB to -100 dB with a minimum step of 0.01 dB, and -3 dB is set as default. 

j) Change the occupied bandwidth span: 

Press 【Measure】, [OBW] and [Span] successively, enter the occupied bandwidth span with the numeric key, and 

then enter the unit with the soft key. The default is 3 MHz. 

k) Disable the occupied bandwidth measurement: 

Press 【Measure】, [OBW] and [OBW Off On] successively, and then select Off to exit occupied bandwidth 

measurement. After that, the analyzer will switch back to the spectrum measurement interface. 

4.1.3 Adjacent channel Power meter 

In this section, the adjacent channel power ratio measurement of FM signal is taken as an example to demonstrate 

the method to measure the adjacent channel power ratio with the 4041 series spectrum analyzer. 
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1) Definition of adjacent channel power ratio 

The adjacent channel power ratio (ACPR), also known as the adjacent channel leakage ratio (ACLR), refers to the 

ratio of the transmitted power of a channel to its radiated power at adjacent channels. It is typically represented by 

the ratio of the power in the specified bandwidth at different frequency offsets of adjacent channels to the total 

power of the channel. The size of adjacent channel power mainly depends on the extension of modulated sideband 

and the noise of transmitter. 

The measurement method for adjacent channel power ratio can replace the traditional measurement method for 

dual audio intermodulation distortion and be applied to the nonlinear system test, and the measurements of 

adjacent channel power ratio can be expressed as power ratio or power density. 

2) Measurement procedure 

In traditional measurement, for narrow-band signals, dual tone signal intermodulation measurement is commonly 

used to evaluate the distortion performance of the transmitter. However, the wideband modulation signals not only 

have very close spectrum components, but also have very high spike signals (referred to as crest factors), these 

intermodulation products of the signal spectrum components tend to fall around the spectrum. Since the 

intermodulation measurement of WBFM signal is quite complex and the adjacent channel power ratio (ACPR) is 

closely related to the intermodulation products caused by the nonlinear distortion, the adjacent channel power 

ratio (ACPR) is a better way to measure the nonlinear distortion of WBFM signals. 

The procedure for measuring the adjacent channel power ratio of WBFM signal with the adjacent channel power 

ratio measurement function of 4041 series spectrum analyzer is as follows: 

a) Set the signal generator so as to output WBFM signal: 

Set the frequency to 1 GHz, the power to -10 dBm, the frequency modulation frequency offset to 500 kHz, the 

modulation rate to 10 kHz, and then connect the output of signal generator to the RF input of spectrum analyzer 

with the cable, as shown in Fig 4-1, in order to generate a FM signal with the signal generator. Turn on the 

modulation output switch and the RF switch. 

b) Preset the spectrum analyzer to default state: 

Press 【Preset】. 

c) Set the reference level of the spectrum analyzer: 

Press 【Ampt】, [Ref Level] and -10 [dBm]; 

Press 【Ampt】 and [Scale/Div] successively, and then set the scale to 10 dB/division. 

d) Set the resolution bandwidth and video bandwidth: 

Press 【BW】 and [Res BW Auto Man] successively, and then set the resolution bandwidth to 30 kHz; 

Press 【BW】 and [Video BW Auto Man] successively, and then set the video bandwidth to 30 kHz or less. 

e) Switch to adjacent channel power ratio measurement: 

Press 【Measure】, [ACPR] and [ACPR Off On] successively, and then switch to the adjacent channel power ratio 



Chapter IV Spectrum Analyzer Mode 

30 

measurement interface. 

f) Set the center frequency of main channel: 

Press [Center Freq], and then set the center frequency of the main channel to 1 GHz with the numeric key. 

g) Set the main channel bandwidth: 

Press [Main Ch BW], and then set the bandwidth of main channel to 1 MHz with the numeric key. 

h) Set the adjacent channel bandwidth: 

Press [Adj Ch BW], and then set the adjacent channel bandwidth to 2 MHz with the numeric key. 

i) Set the channel offset: 

Press [Channel Spacing], and then set the channel offset to 1 MHz with the numeric key. 

j) Start the adjacent channel power ratio test: 

Press [ACPR Off On], after that the measurements are displayed at the bottom of the screen. Schematic diagram 

of adjacent channel power ratio measurement is as shown in Fig 4-4. 

 

Fig 4-4 Adjacent channel power ratio measurement 

k) Limit setting: 

The Limit test function is intended to facilitate the user to observe whether the adjacent channel power exceeds 

the set range. Press 【Measure】, [ACPR] and [More 1 of 2] successively to enter the setup menu of adjacent 

channel power ratio Limit test; 

Press [Upper Limit], and then enter the upper adjacent channel limit with the numeric key; 

Press [Lower Limit], and then enter the lower adjacent channel limit with the numeric key. 

l) Enable the limit test function: 



Chapter IV Spectrum Analyzer Mode 

31 

Press [Limit Test Off On] to enable the limit test function. If the adjacent channel power ratio goes above the set 

limit, its background on the screen will turn red. 

4.1.4 Third-order intermodulation distortion measurement 

1) Definition of third-order intermodulation distortion 

In the crowded working environment of communication system, mutual interference of devices is an ubiquitous 

problem. For example, second-order intermodulation distortion and third-order intermodulation distortion 

commonly occur in narrow-band systems. When there are two signals (F1 and F2) in one system, the two signals 

will be mixed with the generated second harmonic distortion signals (2F1 and 2F2), generating the third-order 

intermodulation products (2F2-F1 and 2F1-F2) fairly close to the original signal. High-order intermodulation 

distortion also occurs. Most of these distortion products are generated by devices such as amplifiers and mixers in 

the system. 

The following section introduces the measurement method of third-order intermodulation distortion. This section 

illustrates the way to display two signals on the screen of spectrum analyzer simultaneously and introduces the 

way to set the resolution bandwidth, mixer level and reference level, as well as the use of some marker functions. 

2) Measurement procedure 

a) Connect the instrument under test (as shown in Fig 4-5) to the spectrum analyzer: 

A 6 dB directional coupler and two signal generators set to 1 GHz and 1.001 GHz respectively are used in this 

example. Certainly, the frequency of signal generator may also be set to other values, but the frequency interval 

must be kept at 1 MHz approximately in this example. 

  

Spectrum Analyzer 

1GHz 

1.001GHz 

50 Ω RF input 

Directional 
coupler 

Signal generator 1 

Signal generator 2 

 

Fig 4-5 Connection of third-order intermodulation distortion measurement system 

Set the output frequency of one signal generator to 1 GHz and set the output frequency of the other signal 

generator to 1.001 GHz, such that the interval of two signal frequencies inputted to the spectrum analyzer is 1 

MHz. 

Set the output amplitudes of the two signal generators to the same value (-20 dBm in this example). 

b) Set the spectrum analyzer to allow the two signals to be displayed on the screen of spectrum analyzer 

simultaneously; 

Press 【Preset】. 

Press 【Freq】, [Center Freq] and 1.0005 [GHz] successively. 
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Press 【Span】and 5 [MHz]. 

As shown in Fig 4-6, the two signals are at the center of the screen. If the applied frequency interval is different 

from that in this example, a span three times greater than the frequency interval of signal generator should be 

used. 

c) Decrease the resolution bandwidth until the distortion product can be seen: 

Press 【BW】 and then 【↓】 step key to decrease the resolution bandwidth. 

d) Adjust the two signal generators to verify that the amplitudes of input signal are identical: 

Press 【Marker】, [Detla], 【Peak】 and [Next Pk]. Adjust the signal generator corresponding to the marker until 

the difference of the two amplitudes is 0. Decrease the video bandwidth if required. 

 

Fig 4-6 Signal at the center of spectrum analyzer display 

e) Set the reference level and place the signal peak at the reference level: 

Press 【Peak】 and [Peak Search] successively, and then read the peak power. 

Press 【Ampt】 and [Ref Level]. 

In order to obtain the optimal measurement accuracy, the signal peak of signal generator should be placed at the 

reference level, as shown in Fig 4-7. 
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Fig 4-7 Place the signal peak at the reference level 

f) Set the second marker and measure the distortion product: 

Once the marker is activated, the differential marker function can generate the second marker and display the 

difference of the two markers. It is convenient to perform relative measurement at this time. 

Press 【Peak】 to activate a marker. 

Press 【Marker】 and [Detla] to activate the second marker. 

Press 【Peak】 and [Next Pk Left] or [Next Pk Right] to set the second marker at the peak point of distortion 

product near the signal of signal generator. As shown in Fig 4-8, the frequency and amplitude differences of the 

two markers are displayed at the marker display area, and the amplitude difference of the markers is the 

measurement of third-order intermodulation distortion. 
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Fig 4-8 Relative measurement of internal modulation distortion 

g) Calculation method of third-order intercept point TOI: 

The ratio of the distortion component level to the signal level (in dB) does not specify the distortion of system 

significantly, unless the signal level is also specified. The concept of the intercept point may be used to specify 

and pre-estimate the distortion level of the system, and the difference between the third-order distortion 

component level and the fundamental wave signal level is twice the difference between the fundamental wave 

signal level and the third-order intercept point. Thus, the third-order intercept point TOI can be calculated as per 

the formula shown below: 

2

dB
LTOI 3im

in


  

Where: 

     inL : represents the two input signal levels, dBm. 

   
3im

dB : represents the difference between the third-order intermodulation product and the input signal 

level, dB. 

As shown in Fig 4-8, when the differential marker reading is -59.37 dB and the signal level is -20.0 dBm, the 

input third-order intercept point TOI is: 

TOI= -20- (-59.37/2)= 9.685(dBm) 

4.1.5 Measurement of drift signal 

1) Definition of drift signal 

If the signal to be detected is a drift signal, it can be observed only when the center frequency is changed 

continuously at different time when a spectrum analyzer is applied for measurement. If the signal tracking 

function of the spectrum analyzer is applied, the marker peak will be always at the center frequency of the 

spectrum analyzer, which is convenient for measurement. 

This section will introduce how to measure the drift signal. The signal tracking, marker function and maximum 
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hold function of the spectrum analyzer will be applied to observe the amplitude trace and occupied bandwidth of 

the drift signal. 

2) Measurement of frequency drift of signal generator 

The spectrum analyzer can measure the short-term and long-term stability of the signal generator. The spectrum 

analyzer with the trace maximum hold function can display the maximum peak amplitude and frequency drift of 

the input signal. If you want to measure the signal occupied bandwidth, the trace maximum hold function can be 

applied too. 

This instance will use the signal tracking function of the spectrum analyzer to keep the drift signal being displayed 

at the center position, and use the trace maximum hold function of the spectrum analyzer to capture the drift. 

a) Set the signal generator output signal: 

Set the signal generator output frequency at 300 MHz and signal amplitude at -20 dBm, connect the signal 

generator output to the input port of spectrum analyzer, as shown in Fig 4-1, and activate the RF output. 

b) Set the center frequency, span and reference level of the spectrum analyzer: 

Press 【Preset】. 

Press 【Freq】, [Center Freq], 300 [MHz]. 

Press [Span], [Span] and 10 [MHz]. 

Press 【Ampt】, [Ref Level], -10 [dBm]. 

c) Place the marker at the signal peak position, and activate the signal tracking function: 

Press 【Peak】, [Peak Track Off On]. 

Press 【Freq】, [Signal track Off On].  

d) Reduce the span: 

Press [Span], [Span], 500 [kHz]. You can see the signal is always kept at the center position. 

e) Deactivate the signal tracking function: 

Press 【Freq】, [Signal track Off On]. 

f) Use the maximum hold function to measure the signal drift: 

Press the 【Trace】, [Maximum hold]. 

When the signal changes, the maximum hold function will keep the maximum response to the input signal. 

g) Activate the trace 2, and set it to the continuous refresh mode: 

Press 【Trace】, [Trace 1 2 3], [Refresh Trace]. 

h) Change the output frequency of signal generator: 

Change the output frequency of signal generator gradually within ±50 kHz by steps of 1 kHz. The display of 
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spectrum analyzer is shown in Fig 4-9. 

 

Fig 4-9 Observing the drift signal by use of maximum hold function 

4.1.6 Measurement of noise signal 

1) Definition of noise signal 

In the communication system, the noise amplitude is often presented by the signal to noise ratio. The greater the 

noise level added in the system is, the poorer the signal to noise ratio is, and the more difficult it is to demodulate 

the modulation signal. In the communication system, the signal to noise ratio measurement often means the carrier 

to noise ratio measurement. 

The contents below describe how the marker function of the 4041 series spectrum analyzer is used to measure the 

signal to noise ratio, and noise. The instance describes the signal to noise ratio measurement of signal (carrier) of a 

single frequency point. If modulation signals are contained in the detected system, this test process should be 

modified to alter the level of modulation signal. 

2) Measurement of the signal to noise ratio 

a) Set the signal generator output signal: 

Set the signal generator frequency at 1 GHz and signal power at -10 dBm, connect the signal generator output to 

the input port of spectrum analyzer, as shown in Fig 4-1, and turn on the RF switch. 

b) Set the center frequency, span, reference level and attenuator. 

Press 【Preset】.  

Press【Freq】, [Center Freq] and 1 [GHz] successively. 

Press【Span】, [Span] and 5 [MHz]. 

Press【Ampt】, [Ref Level], -10 [dBm]. 

Press【Ampt】, [Atten Auto Man], 40 [dB]. 
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c) Place the marker at the signal peak position, and then place the detla marker at the noise position whose 

frequency offset is 200 kHz: 

Press 【Peak】, [Peak Search]. 

Press 【Marker】, [Delta], 200 [kHz]. 

d) Activate the noise marker function to observe the signal to noise ratio: 

Press 【Marker】, [Marker Noise Off On]. See Fig 4-10. 

The read signal to noise ratio is indicated in dB/Hz, because this noise vale is a noise bandwidth value normalized 

to 1 Hz. This value decreases by decrements of 10×log (BW). If noise values at different channel bandwidths are 

required, the measurement results will be corrected according to the current bandwidth. For example, if the data 

read by the spectrum analyzer is -85dB/Hz, and the current channel bandwidth is 30 kHz, the signal to noise ratio 

should be: 

S/N=85dB/Hz - 10×log (30 kHz)=40.2 dB/(30 kHz) 

At this time, if the differential marker is less than 1/4 of the distance from the signal peak to the edge of response, 

the noise measurement will have potential errors. 

 

Fig 4-10 Measurement of signal to noise ratio 

3) Noise measurement by using the noise marker function 

This instance will use the noise marker function to measure the noise of 1 Hz bandwidth by a 1 GHz external 

signal. 

a) Set the signal generator output signal: 

Set the signal generator frequency at 1 GHz and signal power at -10 dBm, connect the signal generator output to 

the input port of spectrum analyzer, and turn on the RF switch. 

b) Set the center frequency, span, reference level and attenuator. 
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Press 【Preset】. 

Press 【Freq】, [Center Freq], 999.98 [MHz]. 

Press 【Span】, [Span], 100 [kHz]. 

Press 【Ampt】, [Ref level], -10 [dBm]. 

Press 【Ampt】, [Atten Auto Man], 40 [dB]. 

c) Activate the noise marker. 

Press 【Marker】, [Marker Noise Off On]. 

It should be noted that the current detection mode will be automatically set as the sampling detection. If it is 

expected to obtain noise power values under different bandwidths, the value should be corrected by increments of 

10×log (BW) according to the current bandwidth. For example, if it is expected to obtain the noise power value 

within 1 kHz bandwidth, an increment of 10×log (1,000) or 30 dB should be added to the read data. 

d) Reduce the measurement error by increasing the measurement time. 

Press 【Sweep】, [Sweep Time Auto Man], 3 [s]. 

When the average detection is adopted, increasing the sweep time can average the trace data in longer intervals, so 

as to reduce the measurement error. 

e) Move the marker to 1 GHz. 

Press 【Marker】, and rotate the knob on the front panel to set the noise marker reading to 1 GHz. 

The noise marker value is obtained based on 5% of the whole scan trace point number. These points center around 

the marker position. The noise marker position will not be located at the peak point of signal. Since the signal 

peak position does not have enough trace points for calculation, the noise signal will average the trace points 

below the signal peaks in case of narrow resolution bandwidth, as shown in Fig 4-11. 

 

Fig 4-11 Noise measurement by using the noise marker function 

f) Set the spectrum analyzer to zero span by centering on the marker position. 

Press 【Peak】, [Marker   Center Frequency]. 

Press [Span], [Span], [Zero Span]. 
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Press 【Marker】. 

At this time, the amplitude readings of noise marker are correct, because the average values of all points are based 

on the same frequency, and will not be affected by the resolution bandwidth filter shape. The noise marker is 

obtained based on the average calculation of interested frequency points. When it is required to measure the power 

of discrete frequency points, the spectrum analyzer should be tuned to the interested frequency points first, and 

then be measured at the zero span. 

4.1.7 Distortion measurement 

In the crowded working environment of communication system, mutual interference of devices is an ubiquitous 

problem. For example, second-order intermodulation distortion and third-order intermodulation distortion 

commonly occur in narrow-band systems. When a system has two signals (F1 and F2), they mix with the generated 

second harmonic distortion signals (2F1 and 2F2) to generate the third-order intermodulation products, 2F2-F1 and 

2F1-F2, which are close to the original signals. High-order intermodulation distortion also occurs. Most of these 

distortion products are generated by devices such as amplifiers and mixers in the system. Most transmitting sets 

and signal generators have harmonic waves, whose components should be measured usually. 

1) Recognition of distortion generated by the spectrum analyzer 

When a large signal is input in the spectrum analyzer, the spectrum analyzer will distort, affecting the distortion 

measurement results of the true signal. Through the attenuator settings, you can determine which signal is the 

distorted signal generated inside the spectrum analyzer. This instance will use the input signal generated by the 

signal generator to explain if the spectrum analyzer generates the harmonic distortion. 

a) Set the signal generator output signal: 

Set the signal generator frequency at 200 MHz and signal power at 0 dBm, connect the signal generator output to 

the input port of spectrum analyzer, as shown in Fig 4-1, and turn on the RF switch. 

b) Set the center frequency and span of the spectrum analyzer: 

Press 【Preset】. 

Press 【Freq】, [Center Freq], 400 [MHz]. 

Press [Span], [Span] and 500 [MHz]. 

As known from traces on the spectrum analyzer, the harmonic distortion generated by the signal has a 200 MHz 

frequency offset from the original 200 MHz signal, as shown in Fig 4-11. 

c) Set the center frequency of the spectrum analyzer to the position of the first harmonic distortion. 

Press 【Peak】, [Next Pk]. 

Press 【Peak】, [Marker→Center Frequency]. 

d) Set the span to 50 MHz, and reset the center frequency. 

Press [Span], [Span] and 50 [MHz]. 

Press [Marker→], [Marker→ Center Frequency]. 
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e) Set the attenuator to 0 dB. 

Press 【Ampt】, [Atten Auto Man], 0 [dB]. 

Press 【Peak】, [Peak Track Off On]. 

Press 【Marker】, [Detla]. 

 

Fig 4-12 Observation of harmonic distortion 

f) Increase the attenuator setting to 10 dB; 

Press 【Ampt】, [Atten Auto Man], 10 [dB]. 

Note to observe the reading of differential marker, as shown in Fig 4-13. This reading is the distortion difference 

generated by the attenuator set at 0 dB and 10 dB. When the attenuator setting is changed, if the difference 

frequency marker reading is 1 dB or greater, it means the spectrum analyzer has a certain degree of distortion. 

When the differential marker reading is not obvious, the attenuation can be increased. 
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Fig 4-13 Attenuator set at 10 dB 

The amplitude reading of differential marker has two sources: first, increasing the RF attenuation will cause the 

signal to noise ratio decreased, making this reading inclined to be positive; second, reduction of harmonic 

distortion generated by the spectrum analyzer circuit will cause this reading inclined to be negative. The greater 

the reading is, the greater the measurement error is. The absolute amplitude of marker reading of this differential 

marker reading can be decreased by changing the attenuator setting. 

2) Quick measurement method of harmonic wave 

This instance measures the harmonic wave components of signal with frequency of 1 GHz and power of -10 dBm 

generated by the signal generator. 

a) Set the signal generator output signal: 

Set the signal generator frequency at 1 GHz and signal power at -10 dBm, connect the signal generator output to 

the input port of spectrum analyzer, as shown in Fig 4-1, and turn on the RF switch. 

b) Set the starting frequency and ending frequency of the spectrum analyzer. 

Press 【Preset】 key. 

Press 【Freq】, [Start Freq], 800 [MHz], [Stop Freq] and 2.5 [GHz]. 

As shown in Fig 4-14, the fundamental wave and second harmonic wave are displayed on the screen. 
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Fig 4-14 Input signal and harmonic wave 

c) Set the video bandwidth to smooth the noise in order to increase the resolution. 

Press 【BW】, [Video BW Auto Man] to activate the manual function. 

Reduce the video bandwidth by the key 【↓】 to decrease the video bandwidth. 

d) In order to improve the measurement precision, set the fundamental wave peak level to the reference level. 

Press 【Peak】, [Peak Search], and read the power of peak. 

Press 【Ampt】, [Ref Level], and set it to the power of peak, as shown in Fig 4-15. 

 

Fig 4-15 Setting the signal peak to the reference level to obtain maximum precision 
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e) Activate the second marker. 

Press 【Marker】, [Detla], 【Peak】, [Next Pk]. 

At this time, the fixed marker marks the fundamental wave, and the movable marker is at the peak point of the 

second harmonic wave, as shown in Fig 4-16. 

 

Fig 4-16 Measurement of second harmonic wave by using the marker difference 

f) Measure the harmonic distortion (method 1). 

The Fig shows that the amplitude difference between the fundamental wave and second harmonic wave is about 

-60 dB, or, 0.1% of harmonic distortion (refer to Fig 4-17). 
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Fig 4-17 Percentage conversion of harmonic distortion amplitude 

Measure the third harmonic wave, and then press [Next Pk Right] to read the amplitude ratio of other harmonic 

wave and fundamental wave which you want to measure. 

g) Measure the harmonic distortion (method 2). 

Press 【Ampt】, [Amplitude Unit], [Volt]. 
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At this time, the differential marker unit changes to Volt automatically. A simple method to determine the 

distortion percentage is to change the unit to volt. Move the decimal point of displayed ratio of differential marker 

rightward by two digits to obtain the distortion percentage. The minimum percentage that can be displayed is 0.01 

or 1%. 

3) Precision measurement method of harmonic wave 

This method involves more steps. However, each signal is measured under minor span and resolution bandwidth. 

Therefore, the signal to noise ratio is increased, and the measurement results are more accurate. The description 

below instructs how to measure the harmonic wave of 1 GHz signal. 

a) Set the signal generator output signal: 

Set the signal generator frequency at 1 GHz and signal power at -10 dBm, connect the signal generator output to 

the input port of spectrum analyzer, as shown in Fig 4-1, and turn on the RF switch. 

b) Set the starting frequency and ending frequency of the spectrum analyzer: 

Press 【Preset】 key. 

Press 【Freq】, [Start Freq], 800 [MHz], [Stop Freq] and 2.5 [GHz]. 

c) Set the video bandwidth to smooth the noise in order to increase the resolution: 

Press 【BW】, [Video BW Auto Man] to activate the manual function. 

Reduce the video bandwidth by the key 【↓】 to decrease the video bandwidth. 

d) Reduce the span by using the signal tracking function: 

Press 【Peak】 to activate the marker to search the signal peak. 

Press 【Freq】, [Signal track Off On]. 

Press 【Span】, 100 [kHz]. 

e) Deactivate the signal tracking. 

Press 【Freq】, [Signal track Off On]. 

f) Shift the signal peak to top cell of the gridline to obtain the optimal amplitude measurement precision. 

Press 【Peak】, [Peak Search], and read the power of peak. 

Press 【Ampt】, [Ref Level], and set it to the power of peak, as shown in Fig 4-18. 
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Fig 4-18 Input signal displayed at 100kHz span 

g) Set the center frequency step to the fundamental wave signal frequency. 

Press 【Freq】, [CF Step Auto Man], 1 [GHz]. 

h) Measure the second harmonic wave. 

Press 【Marker】, [Marker  ], [Marker→Center] and the step key 【↑】. Conduct the step operation to shift the 

center frequency of spectrum analyzer to the second harmonic wave. Press 【Peak】, [Peak Search], and read 

the power of peak. 

Press 【Ampt】, [Ref Level], and set it to the power of peak, Adjust the harmonic wave peak to the reference level. 

The second harmonic wave amplitude is shown in Fig 4-19. 
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Fig 4-19 Second harmonic wave amplitude 

I) Calculate the harmonic distortion. 

Convert the distortion percentage between the second harmonic wave and fundamental wave as per Fig 4-17. The 

unit can be converted to Volt for the convenience of reading the voltage ratio of two signals. 

j) Measure other harmonic waves. 

Repeat the steps (i) to (j) for other harmonic waves which you want to measure. Calculate the distortion 

percentage, %, of each harmonic wave. 

The total harmonic distortion percentage of the signal is also a parameter to be tested in general condition. In 

order to test this parameter, the amplitude of each harmonic wave must be tested in the linear unit (e.g., Volt), but 

not the relative unit, dBc. Press 【Ampt】, [Amplitude Unit], [Volt]. This amplitude unit will be Volt. The signal 

amplitude obtained from the measurement can be employed in the equation below for calculation of the total 

harmonic distortion: 

     
%

100
distortion harmonic Total

1

22

3

2

2

A

AAA n
  

Where, 

A1 —— Amplitude of fundamental wave, in Volt 

A2 —— Amplitude of second harmonic wave, in Volt 

A3 —— Amplitude of third harmonic wave, in Volt 

An —— Amplitude of n harmonic wave, in Volt 

If the signal amplitude can be measured carefully according to the foregoing examples, the harmonic distortion 

percentage obtained from this process will be very accurate. 
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4.1.8 Measurement of pulse RF signal 

1) Definition of pulse RF signal 

The pulse RF signal is a RF pulse string of the same repeated frequency, constant pulse width, constant shape and 

amplitude. This section introduces several measurement methods of the pulse RF signal parameter. These methods 

explain how to measure the center frequency, pulse width and pulse repetition frequency. In addition, topics such 

as measurement of peak pulse power are to be discussed. 

The resolution bandwidth has significant effects on the measurement of pulse RF signal. It is essential to 

understand the relation between the resolution bandwidth and pulse repetition frequency. When the resolution 

bandwidth is narrower than the pulse repetition frequency, the screen only shows specific frequency components 

forming the pulse RF signal. It is called the narrow band mode. When the resolution bandwidth is wider than the 

pulse repetition frequency, it is called the wide band mode. At this time, the display shows the spectral envelope 

depicted by the pulse bursts halved by the pulse repetition frequency. 

2) Measurement of center frequency, sidelobe ratio and pulse width of pulse RF signal 

a) Set the signal generator output signal: 

Set the signal generator frequency at 1 GHz and signal power at -20 dBm, and connect the signal generator output 

to the input port of spectrum analyzer, as shown in Fig 4-1. Set the pulse modulation to the repetition frequency of 

1 kHz, pulse width of 1 us. Switch on the pulse modulation and the RF output. 

b) Set the spectrum analyzer: 

The pulse RF signal is usually measured at the wide band mode. In order to ensure the video filter does not affect 

the measurement results, the video bandwidth is set to 3 MHz. 

Press 【Preset】 key. 

Press 【Freq】, [Center Freq] and 1 [GHz] successively. 

Press 【Span】, 10 [MHz], 【Sweep】, [Sweep Time Auto Man], 500 [ms]. 

Press 【BW】, [Res BW Auto Man], 100 [kHz], [Video BW Auto Man], 100 [kHz]. 

Press 【BW】, [Detector], [Peak] to activate the positive peak detection. 

Select the center frequency function, and adjust the span to display the center sidelobe and at least a pair of 

sidelobes on the screen, as shown in Fig 4-20. 
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Fig 4-20 Main lobe and side lobe 

Add the sweep time (to slow down the scanning) until the Fig is filled completely and becomes a solid line, as 

shown in Fig 4-21. If the spectral line can not fill, the analyzer is not at the wide band mode. In this case, the steps 

to measure the sidelobe ratio, pulse width and peak pulse power are all not applicable, and the resolution 

bandwidth should be set to more than 1 kHz. 

 

Fig 4-21 Trace display by solid lines 

c) Read the center frequency and main lobe amplitude of the pulse: 

Press 【Peak】. 

At this time, the marker reading is the center frequency and main lobe amplitude of the pulse. 

d) When the marker is at the center frequency of the main lobe, measure the sidelobe ratio: 
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Press 【Peak】, 【Marker】, [Detla], 【Peak】, [Next Pk]. 

The amplitude difference between the main lobe and sidelobe is the sidelobe ratio, as shown in Fig 4-22. 

 

Fig 4-22 Sidelobe ratio displayed beside the marker 

e) Measure the pulse width, which equals the reciprocal of frequency difference between the two sidelobe 

envelope peaks: 

Press 【Marker】, [Detla], 【Peak】, [Next Pk Right], [Next Pk Right]. 

At this time, the reciprocal of frequency difference of the read differential marker is the pulse width, as shown in 

Fig 4-23. In order to obtain the most accurate pulse width, adjust the marker position manually to measure the 

distance between zero crossing points of two adjacent sidelobes. If the resolution bandwidth is reduced to make 

the zero crossing point more sharp, the measurement precision will be higher. 
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Fig 4-23 Pulse width displayed by marker 

3) Measurement of pulse repetition frequency (PRF) 

The pulse repetition frequency (PRI) is the time interval between any two adjacent pulse responses. 

a) Set the signal generator output signal: 

Set the signal generator frequency at 1 GHz and signal power at -20 dBm, and connect the signal generator output 

to the input port of spectrum analyzer. Set the pulse modulation to the repetition frequency of 1 kHz, pulse width 

of 1 us, and activate the pulse modulation and RF output. 

b) Set the spectrum analyzer: 

Press 【Preset】 key. 

Press 【Freq】, 1 [GHz]. 

Press 【Span】, 10 [MHz], 【Sweep】, [Sweep Time Auto Man], 1.705 [s]. 

Press 【BW】, [Res BW Auto Man], 1 [kHz]. 

Press 【BW】, [Video BW Auto Man], 3 [MHz]. 

Press 【BW】, [Detector], [Peak] to activate the positive peak detection. 

Adjust the span to display the main lobe and at least a pair of sidelobes on the screen. 

Readjust the output amplitude of the signal generator to display it on the screen, and reduce the sweep time (i.e., 

quicken the scan speed) until the display is similar as that shown in Fig 4-24. 

c) Measure the pulse repetition interval. 

Press 【Sweep】, [Sweep Type Cont Single]. 

Press 【Peak】, 【Marker】, [Detla], 【Peak】, [Next Pk]. The difference of the two displayed markers equals the 
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pulse repetition interval (PRI), and its reciprocal is the pulse repetition frequency (PRF). 

 

Fig 4-24 Measurement of pulse repetition frequency 

4) Measurement of peak pulse power 

As so far, we have known the main lobe amplitude and pulse width, and it is easy to know the resolution 

bandwidth of the spectrum analyzer. We can obtain the peak pulse power according to these parameters. 

When the spectrum analyzer is under the wide band measurement mode: 

Peak pulse power = (main lobe amplitude) - (20 log Teff×BWi) 

Where: 

Teff  ——Pulse width, unit: s 

BWi——Impact bandwidth, unit: Hz (1.5resolution bandwidth used to measure the pulse width) 

When the spectrum analyzer is under the narrow band measurement mode: 

Peak pulse power = (main lobe amplitude) - (20 log Teff×T) 

Where: 

Teff ——Pulse width, unit: s 

T ——Pulse repetition frequency 

It is called the pulse desensitization when the peak pulse power does not equal the main lobe amplitude. The pulse 

signal does not reduce the sensitiveness of spectrum analyzer. To be exact, the desensitization is due to that the 

power of continuous wave (CW) carrier of pulse modulation is distributed to numerous spectrum components (i.e., 

carrier and sideband). Therefore, each spectrum component only contains a part of the total power. 
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4.1.9 Signal generator measurement (option) 

The signal generation measurement mode fails into the independent source output mode and tracking source 

output mode. The former is a dot frequency source mode, which can realize the output of signals with a single 

frequency point and fixed frequency. The later is required to match the Spectrum Analyzer function, and in the 

tracking source mode, the signal generator and frequency under the Spectrum Analyzer are swept synchronously. 

1) Measurement of independent source 

In the independent source measurement mode, the output of signal with fixed frequency can be realized by the 

following steps: 

a) Press【Measure】→[Generator]→[Generator Off On]. In the default state, select the dot frequency source 

output when the tracking generator is switched on; 

b) Press【Measure】→[Generator]→[Power 0 dBm] to set the power of output signal. 

c) Press【Measure】→[Generator]→[CW Freq 1 GHz] to set the power of output signal. 

 

Fig 4-25 Test screen of tracking generator dot frequency source 

2) Measurement of tracking generator 

In the tracking mode, the amplitude-frequency characteristic of tested object can be measured through the 

synchronous frequency sweep process of the signal generator and Spectrum Analyzer. For details, refer to the 

following setting steps: 

 

While measuring the main lobe amplitude, change the spectrum analyzer attenuator, and 

verify that the main lobe amplitude will not vary accordingly. If the variation exceeds 1 

dB, the spectrum analyzer is at the gain compression state, and the attenuation of 

attenuator must be increased. 

CAUTION 
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a) Press 【Freq】→[Start Freq], and set the start frequency to 100 MHz; 

b) Press 【Freq】→[Stop Freq], and set the start frequency to 4 GHz; 

c) Press 【Measure】→[Generator]→[Generator Off On] to turn on the generator switch; 

d) Press 【Measure】→[Generator]→[Power -20 dBm] to set the power of output signal. 

e) Press 【Measure】→[Generator]→[Mode CW Track] to switch the signal generator mode to the tracking mode. 

The test result is shown in Fig 4-26 below: 

 

Fig 4-26 Test screen of tracking generator  

3） Normalization measurement of tracking generator 

Normalization measurement reduces the cable loss during the measurement process. It can reflect the 

amplitude-frequency characteristic of tested object in a more accurate way. For example of testing the 

amplitude-frequency characteristic of 2.3 GHz~2.4 GHz band-pass filter, refer to the following steps: 

a) Press 【Freq】→[Start Freq], and set the start frequency to 2.1 GHz; 

b) Press 【Freq】→[Stop Freq], and set the start frequency to 2.5 GHz; 

c) Press 【Measure】→[Generator]→[Generator Off On] to turn on the generator switch; 

d) Press 【Measure】→[Generator]→[Mode CW Track] to switch the signal generator mode to the tracking mode; 

e) Press 【Measure】→[Generator] →[Trans Meas] →[Normalize Off On] at the cable connection signal generator 

RF output end and spectrum RF input end to turn on the normalization switch; 
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f) Wait until the sweep finishes. The filter of tested object will be added for direct observation of 

amplitude-frequency characteristic of tested object. 

The screen of amplitude-frequency characteristic of 2.3 GHz~2.4 GHz band-pass filter is shown in Fig 4-27 

below: 

 

Fig 4-27 Amplitude-frequency characteristic of 2.3 GHz~2.4 GHz filter 



Chapter IV Spectrum Analyzer Mode 

55 

Section 2 Spectrum Analyzer Menu Structure 
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Fig 4-27 Block Diagram of Spectrum Analyzer Whole Menu 
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Fig 4-28 Block Diagram of Spectrum Analyzer Whole Menu (Continued) 
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Fig 4-29 Block Diagram of Spectrum Analyzer Whole Menu (Continued) 
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Fig 4-30 Block Diagram of Spectrum Analyzer Whole Menu (Continued) 
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Fig 4-31 Block Diagram of Spectrum Analyzer Whole Menu (Continued) 
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Section 3 Description of Spectrum Analyzer Menu 

4.3.1 Frequency menu 

中心频率

频率

起始频率

终止频率

步进频率

自动 手动
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>
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·[Center Freq]: Press 【Freq】→[Center Freq], use the numeric keys on the front panel, 

and then select [GHz], [MHz], [kHz] and [Hz] in the frequency unit menu or 【↑】, 【↓】 

and the knob to set the center frequency. 

·[Start Freq]: Press 【Freq】→[Start Freq], use the numeric keys on the front panel, 

and then select [GHz], [MHz], [kHz] and [Hz] in the frequency unit menu or 【↑】, 【↓】 

and the knob to set the start frequency. 

·[Stop Freq]: Press 【Freq】→[Stop Freq], use the numeric keys on the front panel, and 

then select [GHz], [MHz], [kHz] and [Hz] in the frequency unit menu or 【↑】, 【↓】 

and the knob to set the stop frequency. 

·[CF Step]: Press 【Freq】→[CF Step], use the numeric keys on the front panel, and 

then select [GHz], [MHz], [kHz] and [Hz] in the frequency unit menu or 【↑】, 【↓】 

and the knob to set the step frequency. 

·[Signal Std]: Press this menu to pop up the signal standard menu including [Header], 

[Footer], [Page Up], [Page Down], [Recall] and other soft menus, and then select the 

required signal standard file by clicking [Recall]. 

·[Channel No.]: Press this menu to display the content and number of the selected 

signal standard. 

·[Special Attention]: The channel number shall be set on the premise of loading 

the signal standard; otherwise, a prompt of “It cannot be set” will pop up. 

·[Signal track Off On]: Press this menu to select whether to perform the signal 

tracking or not. The signal tracking function will place the activated marker on the 

peak point of signal after each scan, and set this peak frequency as the center 

frequency. The enabling of [Signal track On Off] will automatically keep the slowly 

drifted signal at the central location of display screen. 

·[Signal Search]: Press this menu to search for the signal in the current span range and 

place the activated marker on the peak point of signal. If there is no signal in the 

current range, a prompt of search failure will be given. 

·[Special Attention]: The channel number shall be set on the premise of loading 

the signal standard; otherwise, a prompt of “It cannot be set” will pop up. 
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4.3.2 Span menu 

Span

Span

Full Span

Zero Span

Last Span

Zero Span

IF Out
 

·[Span]: Press 【Span】→[Span], use the numeric keys on the front panel, and then 

select [GHz], [MHz], [kHz] and [Hz] in the frequency unit menu or 【↑】, 【↓】 and 

the knob to set the span in the current state. The stepping of span shall be done as per 1, 

2 and 5. 

·[Full Span]: Press 【Span】→[Span]→[Full Span], and set the span in the current 

measuring state as the Max. span. The full span is related to the model of selected 

spectrum analyzer, and the span of 4041G series spectrum analyzer is set as 44.1 GHz 

under the full span. 

·[Zero Span]: Press 【Span】→[Span]→[Zero Span], and set the span in the current 

measuring state as the Min. span. The span is set as 0 Hz under the zero span. 

·[Last Span]: Press 【Span】→[Span]→[Last Span], and set the span in the current 

measuring state as the last set span. 

·[IF Output]: Press 【Span】→[Span]→[IF Output], and activate the intermediate 

frequency output submenu. 

·[Special Attention]: The full span and zero span functions are invalid when 

certain measurement functions are enabled. 

·[Special Attention]: As a function option, the intermediate frequency output 

menu can only be used in the zero span mode. 

4.3.3 IF output menu 

As a function option, the zero span intermediate frequency output function allows the output of third or fourth 

intermediate frequency signal in the zero span mode via the intermediate frequency output interface, so as to meet 

the measurement requirements of users.  

IF Out

Off On

IF Out

IF Select

3IF 4IF

<   Back

>

 

·[Special Attention]: As a function option, the intermediate frequency output 

menu can only be used in the zero span mode. 

·[IF Output Off On]: Press 【Span】→[IF Output]→[IF Output Off On], and enable or 

disable the intermediate frequency output function with the buttons. 

·[IF Selection 3IF 4IF]: Press 【Span】→[IF Output]→[IF Selection 3IF  4IF], and 

select the 3IF output or 4IF output with the buttons. 

·[Back]: Press 【Span】→[IF Output]→[Back] to return to the span menu directory. 

·[Special Attention]: The intermediate frequency output function is a function 

option of the zero span intermediate frequency output. If 3IF or 4IFis selected, the 

intermediate frequency output interface will output the third intermediate 

frequency (140.25MHz) or the fourth intermediate frequency (31.25MHz) 

respectively. 
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4.3.4 Amplitude menu 

Ref Level
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·[Ref Level]: Press 【Ampt】→[Ref Level], use the numeric keys on the front panel, 

and then select [dBm], [-dBm], [mV] and [μV] in the frequency unit menu or 【↑】, 

【↓】 and the knob to set the reference level. 

·[Ref Position]: Press 【Ampt】→[Ref Position], and select the position of reference 

line in the rectangular graph by clicking the corresponding numeric keys. 

·[Atten Auto Man]: Press 【Ampt】→[Atten Auto Man] to adjust the input attenuation 

of spectrum analyzer. The input attenuator is associated with the reference level in the 

automatic mode. The numeric keys, step key or knob can be used to adjust the 

attenuation of attenuator in the manual mode. The range of attenuation is 0 dB - 50 dB. 

·[Scale/Div]: Press 【Ampt】→[Scale/Div] to adjust the size of screen ordinate gridline; 

use the numeric keys on the front panel, and then select the frequency unit or 【↑】, 【↓】 

and the knob for setting. The value between 0.1 dB/division and 20 dB/division can be 

selected. The default value is 10 dB/division. 

·[Scale Type Log Lin]: Press 【Ampt】→[Scale Type Log Lin] to select the type of 

ordinate axis scale, namely logarithmic or linear scale. The default units of logarithmic 

and linear scales are dBm and mV respectively. 

·[Units]: Press 【Ampt】→[Units] to select the unit of ordinate axis, including [dBm], 

[dBmV], [dBuV], [Volt], [Watt], [A], [dBW], [dBV], [dBA], [dBmA] and [dBuA]. 

·[Pre Amp Off On]: This function is used to control the on-off state of preamplifier 

and can be activated only when the reference level is less than -40 dBm. 

·[Special Attention]: When the preamplifier is on, be careful not to input a signal 

more than +13 dBm; otherwise, the preamplifier will be damaged. 
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4.3.5 Bandwidth menu 
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>
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·[Res BW Auto Man]: Press 【BW】→[Res BW Auto Man] to adjust the resolution 

bandwidth, which is within 1 Hz - 10 MHz. The numeric keys, step key or knob can be 

used to change the resolution bandwidth by 1, 3 and 10 steps in the manual mode. The 

resolution bandwidth varies with the span as per SPAN/RBW ratio in the automatic 

mode. 

·[Video BW Auto Man]: Press 【BW】→[Video BW Auto Man] to adjust and display 

the video bandwidth in the active function area. The video bandwidth is within 1 Hz - 

10 MHz. The numeric keys, step key or knob can be used to change the video 

bandwidth in the manual mode; in this case, the step key and knob are operated 

according to 1, 3 and 10 steps. The video bandwidth varies with the resolution 

bandwidth as per RBW/VBW ratio in the automatic mode. 

·[Average Off On]: Press 【BW】→[Average Off On] to select the average function. 

This function sets the detector as sampling mode and continuously average the traces 

simultaneously, thus reaching the effect of smooth trace. 

·[SPAN/RBW]: Press 【BW】→[SPAN/RBW] to set the ratio of current span to 

resolution bandwidth and display the ratio in the input area. The default value is 100. 

This ratio is used in the associated mode of resolution bandwidth. 

·[RBW/VBW]: Press 【BW】→[RBW/VBW] to set the ratio of current video 

bandwidth to resolution bandwidth. The default value is 1. When the resolution 

bandwidth is changed, the video bandwidth in the automatic mode will be 

automatically changed to satisfy this ratio. The ratio will be displayed in the input area 

and used in the associated mode of these two bandwidths. When a new ratio is selected, 

the video bandwidth will be changed to satisfy the new ratio while the resolution 

bandwidth keeps unchanged. 

·[Detector]: Press 【BW】→[Detector] to pop up the soft menu of setting the detection 

mode. For details, see the instructions of [Detector] menu. 
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4.3.6 Detection menu 

Auto

Detector
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Peak

Neg Peak

Sample

<   Back
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·[Auto]: The mode will be standard automatically by default after the detection menu is 

entered. 

·[Normal]: In this mode, the measuring results of positive peak and negative peak will 

be displayed to realize the display effect similar to the analog instrument when noise is 

detected, and only positive peak will be displayed when a signal is detected. This is the 

most commonly used detection mode, in which the signal and noise floor can be seen 

simultaneously without loss of any signal. 

·[Peak]: It is used to select the positive peak detection mode. The enabling of this 

mode can ensure that no peak signal is missed, which helps to measure the signal very 

close to the noise floor. The positive peak detector is selected in case of [Max Hold]. 

·[Neg Peak]: It is used to select the negative peak detection mode. The enabling of this 

mode allows the trace to display the negative peak level. This mode is used in the self 

test of broadband millimeter-wave spectrum analyzer in most cases, while seldom in 

measurement. It can reproduce the modulation envelope of AM signal well. The 

negative peak detector is selected in case of [Min Hold]. 

·[Sample]: It is used to set the detector as the sampling detection mode. This mode 

helps to measure the noise signal, and it allows better measurement of noise compared 

with the normal detection mode. It is commonly used for the video average and noise 

frequency standard functions. 

·[Average]: It is used to set the detector as the average detection mode, in which the 

average of sampling data of traces will be displayed in each sampling interval. 

·[RMS]: It is used to set the detector as the root mean square detection mode, in which 

the root mean square of sampling data of traces will be displayed in each sampling 

interval. 

·[Back]: It is used to return to the previous menu. 
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4.3.7 Marker menu 
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·[Marker 1 2 3 4 5 6]: Press 【Marker】→[Marker 1 2 3 4 5 6] to select different 

frequency standards, activate a single frequency standard, place the frequency standard 

at the central location of trace, and display these values in the frequency standard 

display area in the upper right corner of screen. 

·[Normal]: Press 【Marker】→[Normal] to display the frequency and amplitude of 

frequency standard. The knob, step key or numeric key can be used to move the active 

frequency standard. The default unit of the displayed amplitude is dB. 

·[Detla]: Press 【Marker】→[Detla] to display the amplitude difference and frequency 

difference between two frequency standards (time difference in case of the span of 0). 

The knob, step key or numeric key can be used to move the active frequency standard. 

The default unit of the displayed amplitude difference is dB. 

·[Marker Noise Off On]: Press 【Marker】→[Marker Noise Off On] to select the 

on-off state of noise marker. When "On" is selected, the noise marker will be activated. 

Then, the noise power of normalizing the noise to 1 Hz bandwidth near the activated 

marker will be read; in this case, the detector will be in the sampling detection mode 

when automatic. 

·[Counter Mrk Off On]: Press 【Marker】→[Counter Mrk Off On] to enable or disable 

the frequency standard count function. If there is no activated frequency standard 

currently, an active frequency standard will be activated in the middle of the screen 

when the frequency standard count function is enabled. 

·【Marker】: Press 【Marker】→[Marker→] to pop up the soft menus related to the 

marker functions. These menus are relevant to the mode (normal or differential 

frequency standard mode) of frequency, span and frequency standard of spectrum 

analyzer. These marker functions allow the user to change the setting of spectrum 

analyzer by taking the marker as reference. 

·[Off]: Press 【Marker】→[Off] to deactivate the currently selected marker and related 

functions, e.g. [Marker Noise]. 

·[All Off]: Press 【Marker】→[All Off] to deactivate all the markers and related 

functions, e.g. [Marker Noise]. 
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·[Marker→Center]: Press 【Marker】→[Marker→]→[Marker→Center] to move the 

marker to the position of center frequency and display the reading at this position on 

the screen. 

·[Marker→Step]: Press 【Marker】→[Marker→]→[Marker→Step] to set the step size 

of center frequency. In this case, the step size is equal to the marker frequency. When 

the differential marker function is activated, the step size is equal to the frequency of 

the differential marker. 

·[Marker→Start]: Press 【Marker】→[Marker→]→[Marker→Start] to set the start 

frequency equal to the marker frequency. 

·[Marker→Stop]: Press 【Marker】→[Marker→]→[Marker→Stop] to set the stop 

frequency equal to the marker frequency. 

·[Back]: It is used to return to the previous menu. 

 

4.3.8 Peak menu 
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·[Peak Search]: Press 【Peak】→[Peak Search] to place a frequency standard at the 

maximum peak point of trace and display the frequency and amplitude of this 

frequency standard in the upper right corner of screen. 

·[Next Pk]: Press 【Peak】→[Next Pk] to move the active frequency standard to the 

next maximum peak point associated with the current location of the frequency 

standard on the trace. A lower peak point can be quickly found after this key is clicked 

repeatedly. 

·[Next Pk Left]: Press 【Peak】→[Next Pk Left] to find the next peak on the left of the 

current location of the frequency standard. 

·[Next Pk Right]: Press 【Peak】→[Next Pk Right] to find the next peak on the right of 

the current location of the frequency standard. 

·[Max Search]: Press 【Peak】→[Max Search] to place a marker at the highest point of 

trace and display the frequency and amplitude of this marker in the upper right corner 

of screen. 

·[Min Search]: Press 【Peak】→[Min Search] to place a marker at the lowest point of 

trace and display the frequency and amplitude of this marker in the upper right corner 

of screen. 

·[Peak Track Off On]: Press 【Peak】→[Peak Track Off On], and the marker will 

perform a peak search operation currently after each scan when the peak tracking 

function is enabled. It will not perform any operation when the peak tracking function 

is disabled. 

·[Marker→]: Press 【Peak】→[Marker→] to set the marker frequency equal to the 

center frequency. This function can move the signal to the screen center quickly. 
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4.3.9 Mode menu 

The default function mode in the mode menu is the Spectrum Analyzer mode, which, according to user 

requirements, allows the addition of following function options: Interference Analyzer, AM/FM/PM analyzer, 

Power meter, Channel scanner and field strength measurement. 
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·[Spectrum Analyzer]: Press [Mode]→[Spectrum Analyzer] to select the Spectrum 

Analyzer mode. 

·[Interference Analyzer]: Press [Mode]→[Interference Analyzer] to select the 

Interference Analyzer mode. For detailed introduction, see Chapter 5 Interference 

Analyzer Measurement Mode. 

·[AM/FM/PM analyzer]: Press [Mode]→[AM/FM/PM analyzer] to select the 

AM/FM/PM analyzer mode. For detailed introduction, see Chapter 7 AM/FM/PM 

analyzer Measurement Mode. 

·[Power meter]: Press [Mode]→[Power meter] to select the Power meter mode. For 

detailed introduction, see Chapter 6 Power meter Mode. 

·[Channel Scanner]: Press [Mode]→[Channel Scanner] to select the Channel scanner 

mode. For detailed introduction, see Chapter 8 Channel scanner Measurement Mode. 

·[Field Strength Measurement]: Press [Mode]→[Field Strength] to select the field 

strength measurement mode. For detailed introduction, see Chapter 9 Field Strength 

Measurement Mode. 

4.3.10 Sweep menu 

The sweep time specifies the time the spectrum analyzer takes with the local oscillator turned to sweep across a 

selected frequency band. The sweep time directly affects the time cost to complete a test. It varies with the span, 

RBW and VBW, In ‘Auto” mode, the analyzer maintains the fastest sweep time possible with the selected 

measurement settings. The “Manual” mode can be used to increase the sweep time to satisfy some specific 

measurements.  

The default sweep mode is linear sweep. The list sweep function is optional, which activates a continuous sweep 

that consists of multiple frequency segments. It supports to edit, save and recall the list. 
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·[Sweep Time Auto Man]: Press 【Sweep】 →[Sweep Time] to set the sweep time of 

the spectrum analyzer. Use the numeric keys, step button or knob to adjust time setting. 

When “Manual” is underlined, the sweep time can be set manually. When 

“Automatic”is underlined, the sweep time is automatically coupled to the RBW, 

frequency bandwidth and VBW. 

·[Sweep Type Cont Single]: Press 【Sweep】 →[Sweep Type] to set continuous sweep 

or single sweep. 

·[Sweep Once]: Press 【Sweep】 →[Sweep Once] to repeat the sweep. 

·[Triggering]: Press 【Sweep】 →[Triggering] to select the trigger type, including 

[Free Run], [Video] and [External]. Refer to the trigger menu for details. 

·[Sweep Mode Linear List]: Press 【Sweep】 →[Sweep Mode] to select linear sweep 

or list sweep. Linear sweep means that the frequency is swept in linear steps over the 

frequency range and the steps between adjacent measurement points are equal. The list 

sweep mode is optional. In list sweep mode, the frequency is swept according to the 

defined frequency ranges listed and other corresponding parameters. 

·[Edit List]: This is an optional function of list sweep.  Press 【Sweep】 →[Edit 

List].When the Edit List menu is displayed, use softkeys, such as [Add Segment], 

[Delete Segment] and [Delete All Segments], to manage and edit the sweep list. The 

selected sweep segment is highlighted in green. After editing the sweep segment(s), 

press the softkey [Complete] to return to the submenu of 【Sweep】. 

·[Save List]: This is an optional function of the list sweep. Press 【Sweep】 →[Save 

List] to save the edited list in the spectrum analyzer for recalling. 

·[Recall List]: This is an optional function of the list sweep. Press 【Sweep】 →[Recall 

List]. A dialog box will be popped up for you to recall or delete the required sweep list. 

4.3.11 Trigger menu 

The trigger menu is used to select a trigger type for the sweep or measurement. The trigger type can be Free, 

Video, External, Polarity and Delay. You can select the desired trigger mode according to your specific 

requirements. 
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·[Free Run]: After a continuous sweep or single sweep is completed, start a new 

sweep when the free trigger is set. 

·[Video]: Set the trigger mode to the video trigger. When the voltage of an input video 

signal exceed the specified video trigger level, a sweep is triggered. You can use the 

numeric keys, step button or knob to set the trigger level. The green line on the screen 

indicates the trigger level selected. 

·[External]: Set the trigger mode to the external trigger. Set the trigger l level, and 

select the sweep and measurement to synchronize with the next voltage cycle. 

·[Slope]: Set the trigger edge to the rising (Pos.) or falling (Neg.) edge of the pulse. 

·[Delay]: Allowable time delay to the specified trigger level; the spectrum analyzer 

will wait for this time interval after receiving an external trigger signal and then 

perform the sweep. 

4.3.12 Trace menu 

The trace menu is used to set the display of the trace according to the trace type selected, such as Clear Write, 

Max. Hold, and Min. Hold. For example, when measuring a drift signal, use the max. hold function to display the 

max. amplitude and the frequency drift. 
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·[Trace 1 2 3]: Press 【Trace】 →[Trace 1 2, 3] to select the trace. The spectrum 

analyzer can provide trace 1, 2 and 3. The number of the selected trace and its status 

menu will be underlined. 

·[Clear Write]: Press 【Trace】 →[Clear Write] to erase the previously stored data and 

display that of the signal received  by the spectrum analyzer in the real-time sweep. 

·[Max. Hold]: Press 【Trace】 → [Max Hold] to retain the maximum level for each 

trace point of the selected trace and update the data if a new maximum level is detected 

in successive sweeps. If it is in the automatic detection mode, the mode will be 

switched to the positive peak detection. 

·[Min Hold]: Press 【Trace】 →[Min Hold] to retain the minimum level for each trace 

point of the selected trace and update the data if a new minimum level is detected in 

successive sweeps. If it is in the automatic detection mode, the mode will be switched 

to the negative peak detection. 

·[View]: Press 【Trace】 →[View] to hold and display the amplitude data of the 

selected trace. The trace data is not updated as the analyzer sweeps. 

·[Blank]: Press 【Trace】 →[Blank] to disable the trace display and process the signal 

in the background. 

·[Special Attention]: When both the Max. hold and the Min. hold are activated, 

the detection in the automatic mode will be switched to the sample detection. 
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4.3.13 Limit menu 
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·[Limit Upper Lower]: Press [Limit] →[Limit Upper Lower] to select the desired 

limit line (upper or lower). 

·[Limit Off On]: Press [Limit] →[Limit Off On] to enable or disable the limit 

function. 

·[Test Off On]: Press [Limit] →[Test Off On] to enable or disable the limit test 

function. 

·[Edit Limit]: Press [Limit] →[Edit Limit]. It contains several soft menus, such as 

[Frequency], [Amplitude], [Add Point], [Delete Point], [Left Point], [Right Point], and 

[Default Limit], for viewing the frequency and amplitude of the limit point and adding 

or deleting a limit point. 

·[Margin]: Press [Limit] →[Margin] to set the offset margin. 

·[Alarm Off On]: Press [Limit]→[Alarm Off On] to enable or disable the audible 

warning function. When the audible alarm is On, it is valid only if the upper or lower 

limit test is On. When the upper or lower limit line sweep complete the current screen, 

and if there is any occasion beyond the limit, the buzzer will send a short sound. 

·[Save Limit]: Press [Limit] →[Save Limit] to save the limit. 

·[Recall Limit]: Press [Limit] →[Recall Limit]. It contains several soft menus, such as 

[Header], [Footer], [Page Up], [Page Down], [Recall], [Delete] and [Cancel], for 

recalling or deleting the saved limit. 

4.3.14 Measurement menu 
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·[Field Strength]: Press 【Measure】 →[Field Strength Measurement] to select the 

field strength measurement function and recall the related menu. Refer to [Field 

Strength Measurement] menu for details. 

·[Channel Power]: Press 【Measure】 →[Channel Power] to select the channel power 

function and recall the related menu. Refer to [Channel Power] menu for details. 

·[OBW]: Press 【Measure】 →[OBW] to select the occupied bandwidth function and 

recall the related menu. Refer to [OBW] menu for details. 

·[ACPR]: Press 【Measure】 →[ACPR] to select the adjacent channel power function 

and recall the related menu. Refer to [ACPR] menu for details. 

·[Emission Mask]: Press 【Measure】 →[Emission Mask] to select the emission mask 

function and recall the related menu. Refer to [Emission Mask] menu for details. 

·[C/N]: Press 【Measure】 →[C/N] to select the carrier-to-noise ratio function and 

recall the related menu. Refer to [C/N] menu for details. 

·[All Meas Off]: Press 【Measure】 →[All Meas Off] to disable the measurement. 
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·[Tune & Listen]: Press 【Measure】, [More 1 of 2] →[Tune & Listen] to enable the 

audio demodulation function. Refer to [Audio Demodulation] menu for details. 

·[IQ Capture]: Press 【Measure】, [More 1 of 2] →[IQ Capture] to enable the IQ 

capture function. Refer to [IQ Capture] menu for details. 

·[Generator]: Press 【Measure】, [More 1 of 2] →[Generator] to enable the tracking 

generator function. Refer to [Generator] menu for details. 

The spectrum analyzer has the field strength measurement function and relevant soft menus, such as [Field 

Strength Off On], [Recall Antenna], [Edit Antenna] and [Save Antenna], which can be used to perform field 

strength test quickly with the cooperation of corresponding test antenna. 
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·[Field Strength Off On]: Press 【Measure】→[Field Strength] →[Field Strength Off 

On] to enable or disable the field strength function. 

·[Recall Antenna]: Press 【Measure】→[Field Strength] →[Recall Antenna] to pop up 

soft menus, such as [Header], [Footer], [Page Up], [Page Down], [Recall], and 

[Delete], and to select and recall the antenna factor document stored in the spectrum 

analyzer. 

·[Edit Antenna]: Press 【Measure】→[Field Strength] →[Edit Antenna] to pop up soft 

menus, such as [Add Point], [Delete Point], [Delete All], [Complete] and [Cancel] for 

antenna factor editing, 

·[Store Antenna]: Press 【Measure】→ [Field Strength] →[Store Antenna] to store the 

antenna factor. 

·[Back]: Press 【Measure】→[Field Strength] →[Back] to exit the field strength menu 

and return to the measurement menu. 
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The spectrum analyzer provides the function of channel Power meter. Set the parameters in the menu and select 

appropriate RBW and span to measure the channel power. Please refer to “Channel Power meter” in the first 

section of this chapter. 
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·[Channel Power Off On]: Press 【Measure】→[Channel Power]→[Channel Pwr Off 

On] to enable or disable the channel Power meter. 

·[Center Freq]: Press 【Measure】→[Channel Power]→[Center Freq], and use numeric 

keys to set the center frequency. 

·[Channel BW]: Press 【Measure】→[Channel Power]→[Channel BW]，and use 

numeric keys to set the channel width. 

·[Span]: Press 【Measure】→[Channel Power]→[Span]，and use numeric keys to set 

the channel span. 

·[Special Attention]: The channel power bandwidth is the frequency width within 

which the spectrum analyzer displays the power. The channel power span is the 

frequency range of the sweep. If the channel power span should be set larger than 

or equal to that of the channel power bandwidth. If it is not, the spectrum 

analyzer will automatically set the channel power bandwidth equal to the channel 

power span. The ratio of the channel power span to the channel power bandwidth 

remains constant. When the channel power span changes, this ratio remains the 

same. This ratio can be changed by modifying the channel power bandwidth. For 

example, when the channel power span doubles, the spectrum analyzer will 

increase the channel power bandwidth by the same factor. 

The spectrum analyzer is able to quickly provide clear and accurate measurement result of occupied bandwidth. 

Based on modulation types, there are two different methods to calculate the occupied bandwidth: power 

percentage and XdB down method. You can select the appropriate method to measure the occupied bandwidth 

according to your specific requirements. Please refer to “Occupied bandwidth measurement” in the first section of 

this chapter. 
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·[OBW Off On]: Press 【Measure】→[OBW]→[OBW Off On] to enable or disable the 

occupied bandwidth measurement. 

·[Method]: Press 【Measure】→[OBW]→[Method % dBc] to select corresponding 

measurement method, power percentage or dBc down method. The percentage method 

is used to obtain the occupied bandwidth of the signal by calculating the bandwidth of 

the portion of the frequency that contains a certain percentage of the power of the 

entire transmission signal. The percentage of the power may be set by the user. The 

dBc down method defines the occupied bandwidth as the distance between the two 

frequency points when the signal power drops dBc at both sides of the frequency point 

where the peak power of the signal exists. The power down dBc of the signal is to be 

set by the user. 

·[%]: Press 【Measure】→[OBW]→[%] to set the percentage of the power when the 

power percentage method is selected. 

·[dBc]: Press 【Measure】→[OBW]→[dBc] to set the dBc down value of the signal. 

·[Span]: Press 【Measure】→[OBW]→[Span] to set the span for occupied bandwidth 

measurement. 
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The spectrum analyzer provides the function of ACPR measurement. You can set the parameters of the channel to 

acquire the measurement result of ACPR. You can activate the threshold test function and set the adjacent channel 

threshold to observe whether the adjacent channel power exceeds the specified range. Please refer to “ACPR 

measurement” in the first section of this chapter. 
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·[ACPR Off On]: Press 【Measure】→[ACPR]→[ACPR Off On] to enable or disable 

the adjacent channel Power meter. 

·[Center Freq]: Press 【Measure】→[ACPR]→[Center Freq], and use numeric keys to 

set the center frequency. 

·[Main Ch BW]: Press 【Measure】→[ACPR]→[Main Ch BW]，and use numeric 

keys to set the main channel width. 

·[Adj Ch BW]: Press 【Measure】→[ACPR]→[Adj Ch BW]，and use numeric keys to 

set the adjacent channel width. 

·[Channel Spacing]: Press 【Measure】→[ACPR]→[Channel Spacing]. Use the 

numeric keys to set the channel offset. 
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·[Limit Test Off On]: Press 【Measure】→[ACPR]→[Limit Test Off On] to enable or 

disable the threshold test to the upper or lower adjacent channel power. 

·[Upper Limit]: Press 【Measure】→[ACPR]→[Upper Limit] to set the threshold for 

the upper channel power testing. 

·[Lower Limit]: Press 【Measure】→[ACPR]→[Lower Limit] to set the threshold for 

the lower channel power testing. 

·[Special Attention]: When threshold test is activated and if the adjacent channel 

power exceed the set threshold, it will be marked and displayed on the screen in 

red background. 
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The spectrum analyzer provides the function of carrier-to-noise ratio measurement to measure the ratio of carrier 

power to noise power. 
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·[C/N Off On]: Press 【Measure】→[C/N]→[C/N Off On] to enable or disable the 

carrier-to-noise ratio function. 

·[Center Freq]: Press 【Measure】→[C/N] →[Center Freq]. Use the numeric keys to 

set the center frequency for measurement. 

·[Carrier BW]: Press 【Measure】→[C/N]→[Carrier BW]. Use the numeric keys to set 

the carrier bandwidth, and the default value is 3 MHz. 

·[Noise BW]: Press 【Measure】→[C/N]→[Noise BW]. Use the numeric keys to set the 

carrier bandwidth, and the default value is 3 MHz. 

·[Offset]: Press 【Measure】→[C/N]→[Offset]. Use the numeric keys to set the carrier 

bandwidth, and the default value is 3 MHz. 

The emission mask function is to recall the limit line as a mask to measure whether the signal power passes 

through the mask. The mask can move up and down and side to side according to the center frequency and 

reference power. The mask always moves the center point of limit line side to side to the center frequency, and 

moves the center point up and down to the reference power according to the calculated reference power. 
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·[Emission Mask Off On]: Press 【Measure】→[Emission Mask]→[Emission Mask 

Off On] to enable or disable the emission mask. 

·[Reference Channel Bandwidth]: Press 【Measure】→[Emission Mask]→[Channel 

BW]，and use the numeric keys to set the reference channel width. 

·[Recall Limit]: Press 【Measure】→[Emission Mask]→[Recall Limit]. Corresponding 

soft menus will be popped up, such as [Header], [Footer], [Page Up], [Page Down], 

[Recall] and [Delete], for you to select the desired limit document to be recalled. 

·[Ref Power]: Press 【Measure】→[Emission Mask]→[Ref Power] to set the reference 

mode, including peak power and channel power taken as reference. 

·[Peak Markers Off On]: Press 【Measure】→[Emission Mask]→[Peak Markers Off 

On] to enable or disable the peak marker. 

·[Page Up]: Press 【Measure】→[Emission Mask]→[Page Up] to view the information 

in the previous page. 

·[Page Down]: Press 【Measure】→[Emission Mask]→[Page Down] to view the 

information in the next page. 

 

You can set the parameters related to IQ capture, such as capture time, sample rate and capture mode, to acquire 

original IQ data , and store the data for analysis. 
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·[IQ Capture Off On]: Press 【Measure】→[More 1 of 2]→[IQ Capture]→[IQ 

Capture Off On] to enable or disable the IQ capture function. 

·[Start Capture]: Press 【Measure】→[More 1 of 2]→[IQ Capture]→[Start Capture] to 

start to acquire IQ data. 

·[Capture Time]: Press 【Measure】→[More 1 of 2]→[IQ Capture]→[Capture Time] 

to set the IQ capture time. 

·[Capture Mode]: Press 【Measure】→[More 1 of 2]→[IQ Capture]→[Capture Mode] 

to set the IQ capture mode as single or continuous capture. When the single capture 

mode is selected, the analyzer acquires IQ data once and stops. When the continuous 

capture mode is selected, the analyzer keeps acquiring IQ data after each sweep until 

you or your setting stop it. 

·[Sample Rate]: Press 【Measure】→[More 1 of 2]→[IQ Capture]→[Sample Rate] to 

set the sample rate for IQ capture. 

·[Triggering]: Press 【Measure】→[More 1 of 2]→[IQ Capture]→[Triggering]. The 

trigger types include [Free Run] and [External Trigger]. When the external trigger is 

selected, [Slope] and [Delay] can be set. 

·[Save]: Press 【Measure】→[More 1 of 2]→[IQ Capture]→[Save] to save the data 

acquired. 
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·[Tune&Listen Off On]: Press 【 Measure 】 →[More 1 of 

2]→[Tune&Listen]→[Tune&Listen Off On] to enable or disable the audio 

demodulation function. 

·[Demod Type]: Press 【Measure】→[More 1 of 2]→[Tune&Listen]→[Demod Type] 

to select the type of demodulation. [FM], [AM], [USB] and [LSB] demodulation are 

available. 

·[Demod Time]: Press 【Measure】→[More 1 of 2]]→[Tune&Listen]→[Demod Time] 

to set the demodulation time. 

·[Demod Mode]: Press 【Measure】→[More 1 of 2]]→[Tune&Listen]→[Demod 

Mode] to select the demodulation mode. The default mode is intermittent 

demodulation. In the intermittent demodulation mode, after one sweep completes the 

demodulation begins and keeps for the set demodulation time; When the demodulation 

finishes, another sweep begins and completes, and the demodulation starts again. The 

process cycles in this way. In the continuous demodulation mode, the demodulation 

keeps after one sweep finishes, and the sweep does not start again. 

·[Volume]: Press 【Measure】→[Tune&Listen]→[Volume] to set the volume of the 

speaker in demodulation mode. 

You can enable or disable the tracking mode to switch from dot frequency generation to sweep frequency 

generation or reversely.  The tracking generator function can be used to measure the frequency response of the 

device under test. 
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·[Generator Off On]: Press 【Measure】→[More 1 of 2]]→[Generator]→[Generator 

Off On] to enable or disable the tracking generator. 

·[Mode Off On]: Press 【Measure】→[More 1 of 2]→[Generator]→[Mode CW Track] 

to enable or disable the frequency sweep mode of tracking generator. 

·[Power 0.0 dBm]: Press 【Measure】→[More 1 of 2]→[Generator]→[Power 0.0 

dBm]; level range -40 dBm~0 dBm, default level 0 dBm, and 1 dB step; set the fixed or 

sweep output power of the signal of tracking generator. 

·[CW Freq 1.000 GHz]: Press 【Measure】→[More 1 of 2]→[Generator]→[CW Freq 

1.000 GHz]; frequency range 100 kHz~20 GHz, default frequency 1GHz, and 1, 2 or 5 

step; valid when the tracking mode is Off. It is the output frequency of the independent 

dot frequency generator. 

·[Trans Meas]: Press 【Measure】→[More 1 of 2]→[Generator]→[Trans Meas] to open 

the submenu of [Trans Meas] . Refer to the description of “Transmission Measurement” 

menu for details. 

·[Power Offset 0.0 dB]: Press 【Measure】→[More 1 of 2]→[Generator]→[Power 

Offset 0.0 dB]; range-200 dB~200 dB, default 0 dB, and 1 dB step; valid when tracking 

mode is On. Assign a certain offset to the output power of the tracking generator when 

gains or losses occur between the generator output and the external device in order to 

display the actual power value. This parameter only changes the power readout of the 

tracking generator, rather than the actual output of the generator. 

·[Frequency Offset 0.000Hz]: Press 【 Measure 】 →[More 1 of 

2]→[Generator]→[Frequency Offset 0.000 Hz]; range -300 MHz~300 MHz, default 0 

Hz and step invalid; valid when tracking mode is enabled; set the frequency deviation 

of the output signal of the tracking generator from the current sweep frequency; the 

frequency of the tracking generator must be within 100 kHz~20 GHz. 
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·[Normalize Off On]: Press 【Measure】→[More 1 of 2]→[Generator]→[Trans 

Meas]→[Normalize Off On]; range on or off; valid when the tracking mode is enabled 

When normalization is enabled, the reference trace will be saved automatically after the 

current sweep completes if no reference trace is saved before. In the saving process, a 

corresponding message will be prompted on the screen. When normalization is enabled, 

the corresponding value of the reference trace will be subtracted from the trace data 

after every sweep. 

·[Relative Ref 0.0 dB]: 【 Measure 】 →[More 1 of 2]→[Generator]→[Trans 

Meas]→[Relative Ref 0.0 dB]; range -200 dB~200 dB, default 0 dB, and 1 dB step; 

valid when both the tracking mode and the normalization are enabled. Adjust the 

vertical position of the trace on the screen by adjusting the reference level when 

normalization is enabled. Different from the reference level in the Amplitude/Scale 

menu in the analysis mode, modification of this parameter will not affect the reference 

level of the spectrum analyzer. 

·[Ref Position 0]: 【Measure】→[More 1 of 2]→[Generator]→[Trans Meas]→[Ref 

Position 0]; range 0~10, default 5 and 1 step; valid when both the tracking mode and 

the normalization are enabled. Adjust the vertical position of the normalization 

reference level on the screen by adjusting the reference position when normalization is 

enabled. When it is set to 0, the reference position is at the top; when it is set to 10, the 

reference potions is at the bottom; when it is set to 5, the reference position is in the 

middle. 

·[Scale/Div 10.0 dB]: 【 Measure 】 →[More 1 of 2]→[Generator]→[Trans 

Meas]→[Scale/Div 10.0 dB]; range 0.1~20 dB, default 10 dB, 0.1 dB step when less 
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than 1, and 1 dB step when more than 1; valid when both the tracking mode and the 

normalization are enabled. Adjust the precision of the trace on the Y-axis of the screen 

by adjusting the scale/division value when normalization is enabled. 

·[Store Mem Trace]: Press 【Measure】→[More 1 of 2]→[Generator]→[Trans 

Meas]→[Store Mem Trace]; When normalization is enabled, the reference trace will be 

saved automatically after the current sweep completes if no reference trace is saved 

before. In the saving process, a corresponding message will be prompted on the screen. 

When normalization is enabled, the corresponding value of the reference trace will be 

subtracted from the trace data after every sweep. 

·[Mem Trace Off On]: Press 【Measure】→[More 1 of 2]→[Generator]→[Trans 

Meas]→[Mem Trace Off On] to set whether to display the reference trace or not. When 

“On” is selected, the saved reference trace will be displayed. 

4.3.15 File menu 
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Default State

File 

Manager

Location

[Internal]
 

·[Store State]: Press [File] → [Store State] to store the current sweep status parameter. 

·[Recall State]: Press [File]→[Recall State] to pop up status file list, and read the 

stored status files by pressing [Head], [Tail], [Page Up], [Page Down], [Donw], 

[Delete] and other related soft menus, so as to recall the appropriate status parameters 

for the current sweep. 

·[Save Data]: Press [File]→[Save Data] to save the trace data. 

·[Recall Data]: Press [File]→[Recall Data] to pop up data file list, and read the stored 

data files by pressing [Header], [Footer], [Page Up], [Page Down], [Recall], [Delete] 

and other related soft menus, so as to recall the appropriate data for the current sweep. 

·[Save Pic]: Press [File]→[Save Pic] to capture the current screen picture. 

·[Default State]: Press [File]→[Default State] to restore factory settings. 

·[File Manager]: Press [File]→[File Manager] to pop up file management menu, 

including [Src File], [Dst File], [Copy], [Delete] and other related soft menus, so as to 

copy and delete the files. 

·[Location]: Press [File]→[Location] to select the storage location, including internal 

memory of the instrument and other optional positions such as USB interface memory 

and SD card. When the option with security feature is used, the internal memory 

cannot be selected. 
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4.3.16 System menu 

The System Menu lists the system-related settings of the 4041 series spectrum analyzer. In addition to date and 

time, date format, system language, network settings, frequency reference, etc., there are special menus such as 

zero frequency calibration and GPS function (option). 

The 4041 series spectrum analyzer is featured with zero frequency calibration function, allowing users to perform 

zero frequency calibration when needed. When the accurate measurement frequency amplitude of the signal is 

lower than 5 MHz, pay attention to the zero frequency signal value. When the zero frequency signal is above -20 

dBm, the zero frequency calibration is required to avoid gain compression caused by excessive zero frequency 

signal. 

The GPS function is an option of the 4041 series. It can be realized through an external GPS antenna. Users can 

view the current number of satellites, latitude and longitude, and altitude information. 

AliLO Nulling

System

Date 

 Time

Display

GPS

LAN

>

Freq Ref

Int Ext

More

 1 of 2
>

>

>

>

Ref Out

Off On

 

·[AliLO Nulling]: Press 【System】→[AliLO Nulling] to select zero frequency 

calibration when needed by the user, and the calibration result will be saved in the 

internal memory of the instrument. 

·[Date&Time]: Press 【System】→[Date&Time] to set the date and time. 

·[Display]: Press 【System】→[Display] to set the display modes, including [Default 

Mode], [Black&White], [Night Vision] and other related settings. 

·[GPS]: Press 【System】→[GPS] to pop up GPS-related soft menus, including [GPS 

Off On], [GPS Info] and [Reset], so as to set GPS on or off, view GPS details and reset 

GPS. 

·[Special Attention]: The GPS function is an option. 

·[LAN]: Press 【System】→[LAN] to select the network settings of the spectrum 

analyzer, including [Prev], [Next], [IP], [Mask], [Gateway] and other soft menus. 

·[Freq Ref Int Ext]: Press 【System】→[Freq Ref Int Ext] to select the internal or 

external frequency reference as needed by the user. 

·[Ref Out Off On]: Press 【System】→[Ref Out Off On], and when the frequency 

reference is in the internal reference status, choose whether to enable the internal 

reference function as needed by the user. 

·[Special Attention]: The external reference frequency must be 10 MHz±100 Hz 

within the amplitude of 0 dBm (limit range: -2 dBm~+10 dBm). The external 

reference frequency must be input from "10 MHz reference input/output" port. 



Chapter IV Spectrum Analyzer Mode 

81 

Language

System

System

 Info

Error Log

Title 

Off        On

>

>

Admin

More

 2 of 2
>

Date 

Format
>

 

·[Language]: Press 【System】→[Language] to select the languages, including [简体

中文] and [English]. 

·[System Info]: Press 【System】→[System Info] to view the system related 

information, including application software version, image customization version, and 

other related information. 

·[Date Format]: Press 【System】→[Date Format] to set the date format. 

·[Error Log]: Press 【System】→[Error Log] to pop up the related soft menus, 

including [Head], [Tail], [Page Up], [Page Down] and [Delete All], to view the related 

error information. 

·[Title Off On]: Press 【System】→[Title Off On] to name the current title. 

·[Special Attention]: The length of the title is limited to 10 characters. 

·[Admin]: Press 【System】→[Admin] to enter administrator password, so as to 

perform the system-related management and settings. 

·[Special Attention]: The system management function is limited to the use by 

factory commissioning personnel or technical support personnel when needed. 

Users must not use it, otherwise it may cause damage to the instrument. 
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Chapter V Interference Analyzer Measurement Mode (Option) 

Section 1 Introduction to Typical Measurement 
The interference analyzer mode is an extension of the spectrum analyzer mode. In 4041 series spectrum analyzer, 

the interference analyzer mode is divided into the following three modes: 

Spectrum measurement (refer to the relevant chapter of Spectrum Analyzer requirements for specific operations, 

not repeated here); 

Spectrogram measurement; 

Received signal strength indicator (RSSI) measurement. 

 

All operations in this chapter are based on the interference analyzer mode, which will 

not be described separately below. 

5.1.1 Spectrogram measurement 

The cyclic or intermittent signal can be easily observed in the 3D spectrogram display, i.e. frequency, amplitude 

and time. The time signal amplitudes are reflected by various colors in the spectrogram display. 

In order to better observe the measured signal, the following steps can be taken: 

a) Press【Span】→[Full Span] and 【Peak】 to obtain the maximum value of the current signal. Then press 

[Marker→Center] and set the current peak as the center frequency. In this case, the maximum value will be 

displayed at the center of the trace zone. 

b) Press【BW】→[Res BW Auto Man] and set the appropriate resolution bandwidth with the number keys, 【↑】, 

【↓】 or knob. Similarly, set the appropriate video bandwidth. 

c) Press【Ampt】→[Ref Level] and set the current maximum point close to the top of the display zone. Press 

[Scale/Div] and set the appropriate scale/division to facilitate viewing 

d) Press【Record】→[Sweep Interval Auto] and set the sweep interval. 

 

If the sweep interval is more than 0, the trace will be in the maximum holding state, so 

as to ensure that the maximum value of the signal in each sweeping will be displayed 

on the screen. 

e) Press [Sweep Time] and set the record time. Then press [Auto Save Off On] to enable the auto saving mode. 

In this case, the data will be saved automatically after sweeping of one screen. 

f) Press 【Record】→[Time Cursor] and move the horizontal line with the number keys, 【↑】, 【↓】 or knob 

in the vertical direction of the spectrogram. The following spectrogram will display the trace information on 

the line. 

 

If the time marker value is more than 0, the trace and spectrogram will not be 

refreshed. 

g) The interference analyzer mode of 4041 series spectrum analyzer involves six independent markers, which 

are used for reading the amplitude and frequency corresponding of the marker. Specific operations are as 

follows: [Maker]→[Marker 1 2 3 4 5 6]. 

h) Press [File]→[Save Pic] to save the current spectrogram information in the picture form. 

The spectrogram test structure is in Fig. 5-1 (the displayed contents vary from parameter settings, and Fig. 5-1 

CAUTION 

CAUTION 

CAUTION 
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only show an example). 

 

Fig. 5-1 Interference Analyzer Spectrogram 

5.1.2 RSSI measurement 

RSSI measurement is mainly applied to measure the strength changes of one CW signal within a certain period. 

In order to better observe the measured signal, the following steps can be taken: 

a) Press [Record]→[Sweep Interval] to set the sweep interval, which represents the sweep time between two 

adjacent points in each sweeping. 

b) Press [Record]→[Sweep Time] to set the span record time. After reaching the set span time, the display 

interface will not be refreshed. 

Press [Record]→[Auto Save Off On] to enable the auto saving function. The data will be automatically saved into 

the file after sweeping of each screen. 

 

If the span time is set, only the latest data points on the screen will be recorded, instead 

of all data points within the whole span. 

The RSSI test structure is shown in Fig. 5-2 (the displayed contents vary from parameter settings and Fig. 5-2 

only show an example). 

CAUTION 
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Fig. 5-2 RSSI Test Diagram of Interference Analyzer 
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Section 2 Interference Analyzer Menu Structure 

Signal Std

--

Center Freq

Frequency

Start Freq

Stop Freq

CF Step

Auto Man

Channel

--

Span

Full Span

Zero Span

Last Span

< Back

Ref       Level

0.0dBm

Amplitude

Ref Position

Atten

Auto Man

Scale/Div

20.0dB

Units

dBm

Pre Amp

Off On
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Auto Manual

BW

VBW

Auto Manual

Average

Off On

SPAN/RBW

100

RBW/VBW

1

Detector    

Auto

Auto

Detector

Normal

Peak

Neg Peak

Sample

Average

RMS

< Back

Marker

1 2 3 4 5 6

Marker

Normal

Delta

Noise Marker 

Off On

Marker >

Off

All Off

Marker->

Center

Marker->

Marker->

CF Step

Marker->

Start

光标->

终止频率

Marker->

Stop

< Back

Peak Search

Peak

Next Peak

Next Pk Left

Next Pk Right

Max Search

Min Search

Marker->

Center

Sweep Time

Auto Man

Sweep

Sweep

Cont Single

Sweep Once

>

>

Header

Signal Std

Tail

Page up

Page down

Done

Cancel

>

Signal Track

Off On

Signal Search

Span

  

Fig. 5-3 Overall Block Diagram of Interference Analyzer Menu 
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Src File
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Dst File
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0
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>

>

>
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Fig. 5-4 Overall Block Diagram of Interference Analyzer Menu (continued) 
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Section 3 Description of Interference Analyzer Menu 

5.3.1 Frequency menu 

Signal Std

--

Center Freq

Frequency

Start Freq

Stop Freq

CF Step

Auto Man

Channel

--

>

Signal Track

Off On

Signal Search

 

·[Center Freq]: Press 【Freq】→[Center Freq], and select [GHz], [MHz], [kHz] or [Hz] 

in the frequency unit menu by using the numeric keys on the front panel, or 【↑】 【↓】 

keys and the knob. 

·[Special Attention]: The frequency step value is the same as the [CF Step] setting 

value when using 【↑】 【↓】 keys and the knob. The step frequency value can be 

set by using the numeric keys or 【↑】 【↓】 keys and the knob after switching to 

[CF Step Auto Man] from [CF Step Auto Man]. 

·[Start Freq]: Press 【Freq】→[Start Freq] to select a frequency unit via the numeric 

keys on the front panel, or set it by using 【↑】 【↓】 keys and the knob. 

·[Stop Freq]: Press 【Freq】→[Stop Freq] to select a frequency unit via the numeric 

keys on the front panel, or set it by using 【↑】 【↓】 keys and the knob. 

·[CF Step Auto Man]: Press 【Freq】→[CF Step Auto Man] to select step freq to 

manual or auto,and alse set a frequency unit via the numeric keys on the front panel, or 

set it by using 【↑】 【↓】 keys and the knob. 

·[Signal Std]: Press 【Freq】→[Signal Standard] to select a signal standard by using 

【↑】 【↓】 keys and the knob, and call it by using [Recall] or [Enter] key in the dialog 

menu. Refer to the dialog menu for details. 

·[Special Attention]: After the signal standard is loaded, the center frequency and 

the span are set to those defined in the signal standard. 

·[Channel]: Press 【Freq】→[Channel.] and pop up the channel No. setting dialog, and 

then set the channel No. via the numeric keys or 【↑】 【↓】 keys and the knob. 

·[Special Attention]: The channel No. shall be set after the signal standard is 

loaded, otherwise a prompt showing setting not available is given. 

·[Signal Track Off On]: Press 【Freq】→[Signal Track Off On] set signal track on or 

off.. 

·[Signal Search]: Press 【Freq】→[Signal Search], push this key can search the signal 

quickly. 
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5.3.2 Span menu 

Span

Full Span

Zero Span

Last Span

< Back

Span

 

·[Span]: Press 【Span】→[Span] to activate the span submenu. You can change it by 

using the numeric keys and selecting a frequency unit, or by using 【↑】 【↓】 keys and 

the knob. Refer to the description of [Span] menu for specific introduction. 

·[Special Attention]: Change the span by using 【↑】 【↓】 keys and the knob based 

on the steps of 1-2-5. 

·[Full Span]: Press【Span】→[Span]→[Full Span] to set the current span to 44.1 GHz. 

·[Span]: Press【Span】→[Span]→[Zero Span] to set the current span to 0 Hz. 

·[Last Span]: Press 【Span】→[Span]→[Zero Span] to restore the span to that last set. 

·[Back]: Press【Span】→[Span]→[Back] to return to the 【Freq】 menu. 

·[Special Attention]: It can only be zero span under the RSSI mode. 

 

5.3.3 Amplitude menu 

Ref       Level

0.0dBm

Amplitude

Ref Position

Atten

Auto Man

Scale/Div

20.0dB

Units

dBm

Pre Amp

Off On

 

·[Ref Level]: Press 【Ampt】→[Ref Level] and select [dBm], [-dBm], [mV] or [uV] in 

the frequency unit menu by using the numeric keys on the front panel, or 【↑】 【↓】 

keys and the knob. 

·[Special Attention]: The step is 10 dB when the 【↑】 【↓】 keys and the knob are 

used. 

·[Ref Position]: Press 【Ampt】→[Ref Position] and change it by using the numeric 

keys or by using 【↑】 【↓】 keys and the knob. 

·[Atten Auto Man]: Press 【Ampt】→[Atten Auto Man] and switch the attenuator auto 

or manual mode in the menu by using the numeric keys or by using 【↑】 【↓】 keys 

and the knob. 

·[Special Attention]: The setting range of the attenuation value is between 0 dB 

and 60 dB, and the step is 10 dB. 

·[Scale/Div]: Press 【Ampt】→[Scale/Div] and set it between 0.1 dB and 20 dB by 

using the numeric keys or by using 【↑】 【↓】 keys and the knob. 

·[Units]: The amplitude in the Interference Analyzer mode is in dBm. 

·[Pre Amp Off On]: Press 【Ampt】→[Preamplifier Off On] to turn the preamplifier on 

or off. 
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5.3.4 Bandwidth menu 

RBW

Auto Manual

BW

VBW

Auto Manual

Average

Off On

SPAN/RBW

100

RBW/VBW

1

Detector    

Auto
>

 

·[Res BW Auto Man]: Press 【BW】→[Res BW Auto Man] to set by using the numeric 

keys on the front panel or by using 【↑】 【↓】 keys and the knob. 

·[Special Attention]: The resolution bandwidth is determined by the bandwidth of 

intermediate frequency filter, and the shape of the trace depends on the 

intermediate frequency bandwidth filter. This instrument supports setting of 

variable resolution bandwidth ranging from 1 Hz to 10 MHz with the step of 

1-3-10. 

·[Video BW Auto Man]: Press [Bandwidth ]→[Video BW Auto Man] and switch it by 

using the numeric keys or by using 【↑】 【↓】 keys and the knob. 

·[Special Attention]: Video bandwidth filters are used for smooth traces to 

improve the ability to detect weak signals among noise signals. This instrument 

supports setting of variable resolution bandwidth ranging from 1 Hz to 10 MHz 

with the step of 1-3-10. 

·[Average Off On]: Press 【BW】→[Average Off On] and change it by using the 

numeric keys or by using 【↑】 【↓】 keys and the knob. The average function can be 

used for smoothing display traces without changing the video bandwidth filter. 

·[SPAN/RBW]: Press 【BW】→[SPAN/RBW] to set the ratio of span to resolution 

bandwidth. In the auto mode, the resolution bandwidth will change automatically with 

the change of span. It can be changed by using the numeric keys or by using 【↑】 【↓】 

keys and the knob. 

·[RBW/VBW]: Press 【BW】→[RBW/VBW]. In the auto mode, the video bandwidth 

will change with the change of resolution bandwidth. It can be changed by using the 

numeric keys or by using 【↑】 【↓】 keys and the knob. 

·[Detectior]: Press 【BW】→[Detector] to open the submenu of the detection function. 

Refer to the [Detector] menu for details. 
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Auto

Detector

Normal

Peak

Neg Peak
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< Back

 

·[Auto]: Press 【BW】→[Detector]→[Auto] for detection and Spectrum Analyzer 

mode. 

·[Normal]: Press 【BW】→[Detector]→[Normal]. It is the most commonly used 

detection method that can detect both signal and noise floors at the same time without 

losing any signal. 

·【Peak】: Press 【BW】→[Detector]→【Peak】, which can ensure that no peak signal 

is missing and can be used to measure signals that are very close to noise floors. 

·[Neg Peak]: Press 【BW】→[Detector]→[Neg Peak], which is mainly used for 

self-inspection of bandwidth millimeter wave integrated testers and rarely used for 

tests, and can reproduce modulation envelopes of AM signals well. 

·[Sample]: Press 【BW】→[Detector]→[Sample], which is beneficial to measure noise 

signals and, compared with standard detection, can better measure noises. 

·[Average]: Press 【BW】→[Detector]→[Average] for average operation of the data 

within the sampling interval. 

·[RMS]: Press 【BW】→[Detector]→[RMS] for root mean square average operation of 

the data within the sampling interval. 

 

5.3.5 Marker menu 

Marker

1 2 3 4 5 6

Marker

Normal

Delta

Noise Marker 

Off On

Marker >

Off

All Off

 

·[Marker 1 2 3 4 5 6]: Press 【Marker】→[Marker 1 2 3 4 5 6] to switch display of 

different markers. The selected marker is underlined. 

·[Normal]: Press 【Marker】→[Normal] to set the marker display mode currently 

selected as the normal mode. 

·[Delta]: Press 【Marker】→[Delta] to set the marker display mode currently selected 

as the differential mode. The differential mode shows the differences of frequencies 

and amplitudes between difference and reference markers (it is time difference in zero 

span mode), and the amplitude value displayed is in dB. 

·[Marker Noise Off On]: Press 【Marker】→[Marker Noise Off On]. The noise marker 

shows the noise power that the noise near the activated marker is normalized to 1 Hz 

bandwidth, and at this time the detector is set to the sampling detection mode. When 

the noise marker is on, the unit of the marker reading automatically switches to dB/Hz. 

·[Marker→]: Press 【Marker】→[Marker→] to open the marker function submenu. 

These marker functions allow the user to change the instrument display with the 

marker as a reference. Refer to the [Marker→] function menu for details. 

·[Marker Off]: Press 【Marker】→[Marker Off] to turn off the currently active marker. 

·[All Off]: Press 【Marker】→[All Off] to turn off all markers that have been turned on. 

·[Special Attention]: There is no marker function in the RSSI measurement mode. 
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Marker->
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Marker->
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·[Marker→Center]: Press 【Marker】→[Marker→]→[Marker→Center] so that the 

marker moves to the center frequency and the reading at the center frequency is 

displayed on the screen. 

·[Marker→CF Step]: Press 【Marker】→[Marker→]→[Marker→CF Step] to set the 

step of the center frequency, that is, the value of the frequency step is equal to the 

frequency of the marker. When the difference marker function is activated, the value of 

the frequency step is equal to the frequency of the difference marker. 

·[Marker→Start]: Press 【Marker】→[Marker→]→[Marker→Start] and set the start 

frequency equal to the marker frequency. 

·[Marker→Stop]: Press 【Marker】→[Marker→]→[Marker→Stop] and set the stop 

frequency equal to the marker frequency. 

·[Back]: Return to the previous menu. 

(Not available in the RSSI measurement mode) 

5.3.6 Peak menu 

Peak Search

Peak

Next Peak

Next Pk Left

Next Pk Right

Max Search

Min Search

Marker->

Center

 

·[Peak Search]: Press 【Peak】→[Peak Search] to set the current active marker to the 

maximum peak point of the measurement trace and display the frequency and 

amplitude of such marker at the upper middle position of the screen. 

·[Next Pk]: Press 【Peak】→[Next Pk] to move the active marker to the next highest 

point related to the current marker position on the trace. 

·[Next Pk Left]: Press 【Peak】→[Next Pk Left] to find the next peak at the left of the 

current marker position. 

·[Next Pk Right]: Press 【Peak】→[Next Pk Right] to find the next peak at the right of 

the current marker position. 

·[Max Search]: Place a marker at the highest point of the trace and display the 

frequency and amplitude of this marker at the upper right corner of the screen. Pressing 

this key does not change the activated functions. 

·[Min Search]: Press 【Peak】→[Min Search] to place a marker at the lowest point of 

the trace and display the frequency and amplitude of this marker at the upper right 

corner of the screen. Pressing this key does not change the activated functions. 

·[Marker→Center]: Press 【Peak】→[Marker→Center] and set the center frequency 

equal to the marker frequency; this function can quickly move the signal to the center 

position of the screen. 

(Not available in the RSSI measurement mode) 
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5.3.7 Sweep menu 

Sweep Time

Auto Man

Sweep

Sweep

Cont Single

Sweep Once

 

·[Sweep Time Auto Man]: Press 【Sweep】→[Sweep Time Auto Man] and switch 

between auto and manual sweep time. The current status is underlined. In the case of 

auto sweep time, the integrated tester automatically sets the fastest sweep time based 

on the state of the current instrument, and what displayed on the screen is the fastest 

sweep time under the current setting. In the case of manual sweep time, the sweep time 

value can be input at this time: enter the sweep time value with the numeric keys, and 

press the corresponding soft key to select the time unit to complete the setting. In the 

case of auto sweep time, the sweep speed changes with any change of RBW and VBW. 

The larger the values of RBW and VBW, the faster the sweep speed; the smaller the 

values of RBW and VBW, the slower the sweep speed. The sweep time of the 4041 

series spectrum analyzer, if meeting the requirement for minimum sweep time, can be 

maximally set to 800 seconds in the nonzero span mode and 600 seconds in the zero 

span mode. 

·[Sweep Type Continuous Single]: Press 【Sweep】→[Sweep Type Continuous 

Single]. The sweep type setting determines how the integrated tester sweeps and when 

to stop sweep and be in hold mode. There are two types of sweep in the Interference 

Analyzer mode: continuous and single sweep. 

·[Scan Again]: Press 【Sweep】→[Scan Again] to restart the sweep. 

5.3.8 Record menu 

Sweep Interval

Auto

Record

Sweep Span

Auto

Record

Off On

Time Cursor

0

Restart 

>

 

·[Sweep Interval]: Press 【Record】→[Sweep Interval Auto] to set the sweep interval. 

After the sweep time is set, the trace will switch to the maximum hold state by default 

to ensure that all the signals measured within the sweep interval can be recorded. 

·[Time Span]: Press 【Record】→[Time Span Auto]. The sweep time is the time of the 

entire sweep. The recording will stop when the span time ends during the sweep. 

·[Auto Save Off On]: Press 【Record】→[Auto Save Off On], and press the menu to 

switch autosave on or off. 

·[Special Attention]: The autosave function can be turned on after the span time is 

set. 

·[Time Cursor]: Press 【Record】→[Time Cursor] to view the history data. 

·[Special Attention]: It can only be used in the spectrogram measurement mode. 

·[Restart]: Press [Autosave]→[Restart] to start the sweep again. 

·[Special Attention]: This menu cannot be used for spectrum measurement. 

 The RSSI cannot use the time cursor menu function. 
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5.3.9 Measurement menu 

Spectrum

Measure

Spectrogram

RSSI

 

·[Spectrum]: Press 【Measure】→[Spectrum] to switch the measurement mode to 

spectrum measurement. 

·[Spectrogram]: Press 【Measure】→[Spectrogram] to switch the measurement mode 

to the Spectrogram. 

·[RSSI]: Press 【Measure】→[RSSI] to switch the measurement mode to RSSI. 

5.3.10 File menu 

Refer to the description of the Spectrum Analyzer measurement mode for file menu. 
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Chapter VI Power Meter Mode (Option) 

Section 1 Introduction to Typical Measurement 

The Power meter of the 4041 series spectrum analyzer is carried out by using a USB power probe externally 

connected to a USB interface through a USB cable. 8723XUSB power probe provided by CETI can test radio 

frequency/microwave signals up to 40 GHz and carry out real average Power meter within a high dynamic range 

of -60 dBm to + 20 dBm. The measurement reading is displayed on the display interface of the 4041 series USB 

Power meter mode. The test block diagram is shown in Fig 6-1, and the attenuator is added as needed. 

 

All operations in this section are based on the condition that the Power meter mode has 

been selected, and will no longer be described separately hereinafter. The selection 

method is as follows: [Mode]→[Power meter]. 

8723X DUT

Attenuator 

(option)

 

Fig 6-1 Power meter Structure Diagram 

The power meter interface is shown in Fig. 6-2 (an example). 

 

Fig 6-2 Power meter Interface Diagram 

 

It is recommended that the 4041 series products use high performance microwave power probes with USB 

CAUTION 

Spectrum 
Analyzer 
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interfaces developed by CETI. There are mainly some types in the following and you can purchase them based on 

your test needs: 

 

Observe the maximum input power range identified on USB power probes and ensure 

that the input is within the specified range to avoid damage to such probes due to 

excessive power. 

Table 6-1 8723XUSB Power Probes 

Model Frequency range Input power range Input connector mode 

87230 9 kHz to 6 GHz -50 dBm to + 20 dBm N (m) 

87231 10 MHz to 18 GHz -60 dBm to + 20 dBm N (m) 

87232 50 MHz to 26.5 GHz -60 dBm to + 20 dBm 3.5 mm (m) 

87233 50 MHz to 40 GHz -60 dBm to + 20 dBm 2.4 mm (m) 

Connection of power probe 

a) Connect the small end of the USB cable to 8723X USB power probe. 

b) Connect the large end of the USB cable to the USB interface of the spectrum analyzer. The green indicator of 

the power probe will be ON a moment later. 

c) The USB power probe can be shut down after the USB cable is removed. In this case, the green LED 

indicator will be OFF. 

 

8723X USB power probe is provided with a USB cable. You can use your own USB 

cable conforming to international safety standards. 

CAUTION 

CAUTION 
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Section 2 Power Meter Menu Structure 

Frequency

Frequency

Resolution

0 1 2 3

Auto Scale

Amplitude

Max Value

Min Value
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Offset
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Max Hold

Off On

Average
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Limit
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Upper Limit

Lower Limit

Alarm

Off On

Zero

Calibrate

Save State

File
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Default State

File

 Manager

Location

Internal

Header

Page up

Page down

Done

Delete

Delete All

Cancel

Src File
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USBTail >

>

>

 

Fig 6-3 Overall Block Diagram of Power meter Menu 
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Section 3 Description of Power meter Menu 

6.3.1 Frequency menu 

Frequency

Frequency

Resolution

0 1 2 3

 

·【Freq】: Press 【Freq】→[Frequency]. You can use the numeric keys to select the 

corresponding frequency menu, or change the frequency by using 【↑】 【↓】 or the 

knob, and the step of frequency change is 10 MHz. 

·[Special Attention]: The frequency setting range is related to the selected USB 

power probe, and the specific range is shown in Table 6-1. 

·[Resolution 0 1 2 3]: Press 【Freq】→[Resolution 0 1 2 3]. This menu is used to 

switch the display accuracy of measurement data. 0 means only integers are displayed, 

1 means 1 decimal place is remained, 2 means 2 decimal places are remained, and 3 

means 3 decimal places are remained. 

6.3.2 Amplitude menu 

Auto Scale

Amplitude

Max Value

Min Value

Relative 

Off On

Offset

Off On

Max Hold

Off On

 

·[Auto Scale]: Press 【Ampt】→[Auto Scale] to display the measurement signal in the 

range of 10 dB. 

·[Max Value]: Press 【Ampt】→[Max Value]. It is the maximum value of the current 

display signal and can be changed by using the numeric keys, or by using 【↑】 【↓】 

or the knob, and the default step of change is 1 dB. 

·[Min Value]: Press 【Ampt】→[Min Value]. It is the minimum value of the current 

display signal and can be changed by using the numeric keys, or by using 【↑】 【↓】 

or the knob, and the default step of change is 1 dB. 

·[Relative Off On]: Press 【Ampt】→[Relative Off On]. The relative measurement 

function reflects the power change that the reference signal has been set. The readings 

of the changes of power values are expressed in dB and %. When the relative 

measurement is on, the instrument will measure and save the current power level while 

the Power meter will display a power level relative to the saved value. 

·[Offset Off On]: Press 【Ampt】→[Offset Off On]. When the power of the measured 

piece is greater than the maximum power to be measured by the instrument, the 

measured power can be reduced to the normal measuring range by connecting an 

attenuator. The power offset function can set the offset value to offset the attenuation 

value of the added attenuator or losses of connecting cables. It may also set the power 

offset to increase the gain of the amplifier. Positive values compensate for losses, and 

negative values compensate for gains. 

·[Max Hold Off On]: Press 【Ampt】→[Max Hold Off On] and turn on the maximum 

hold signal to display the maximum value of the measurement. 
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6.3.3 Average menu 

Average

Off On

Average

 

·[Average Off On]: Press 【BW】→[Average Off On]. You can change it by using the 

numeric keys, or by using 【↑】 【↓】 or the knob. The step of the average change is 

1. 

·[Special Attention]: When measuring low-power signals or signals close to the 

noise power, the average function is generally used to smoothen the trace, reduce 

the influence of random noise on the measurement, and improve the measurement 

accuracy, but it will reduce the measurement speed. The average number of times 

determines the number of times of the averages to be read. The noise is reduced 

significantly if the average number of times is high. 

6.3.4 Zero calibration menu 

Zero

Calibrate

 

·[Zero]: press [Zero]→[Zero]. 

•[Special Attention]: In order to improve the measurement accuracy of the 

instrument, it is necessary to make zero calibration on the instrument before 

using the 8723X series USB power probe for small signal Power meter. Zero 

calibration means measuring and saving noise in the entire measurement channel. 

During the measurement, it is necessary to deduct the zero calibration value from 

the actual measurement value, i.e., the noise in the channel is deducted, and the 

reading at this time is the real channel input signal level. The zero calibration of 

the USB power probe is the same as that of general power probe. The zero 

calibration here refers to the internal zero calibration of the USB power probe. 

The internal zero calibration refers to testing, measuring and saving of noise in 

the channel by adding a switch at the front of the channel so that the user does not 

need to disconnect the sensor from the measured piece. During the internal zero 

calibration, the RF signal is always applied to the power probe, which can reduce 

the wear of the probe connector and shorten the test time. 

6.3.5 Limit menu 

Limit

Off On

Limit

Upper Limit

Lower Limit

Alarm

Off On

 

·[Limit Off On]: Press [Limit]→[Limit Off On] to turn the limit on. 

·[Upper Limit]: Press [Limit]→[Upper Limit]. You can change it by using the numeric 

keys, or by using 【↑】 【↓】 or the knob. The step of the limit change is 1 dB. 

·[Lower Limit]: Press [Limit]→[Lower Limit]. You can change it by using the 

numeric keys, or by using 【↑】 【↓】 or the knob. The step of the limit change is 1 dB. 

·[Alarm Off On]: Press [Limit]→[Alarm Off On]. When the limit alarm is turned on, 

the instrument will give an alarm if the measurement data exceeds the set limit value. 

6.3.6 File menu 

Refer to the description of the file menu in the Spectrum Analyzer mode. 
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The functions of saving and recalling the data file are not available in the power meter 

mode! 
CAUTION 
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Chapter VII AM-FM-PM Analyzer Mode (optional) 

Section 1 Introduction to Typical Measurement 
The AM-FM-PM analyzer mode is used for displaying the spectrum of AM, FM and PM signals and analyzing 

relevant parameters. The main spectrum and relevant parameters are shown below: 

RF spectrum: Similar to the spectrum analyzer mode, the frequency spectrum of the modulation signal will be 

displayed, and the occupied bandwidth can be measured. 

Audio spectrum: Display the frequency spectrum of the demodulated audio signal. 

Audio waveform: Display the waveform of the demodulated audio signal within the time domain. 

Parameter analysis: Measure and analyze the carrier power, modulation rate, carrier offset, modulation depth 

(AM), modulation frequency offset (FM), modulation phase deviation (PM), S/N, modulation distortion and total 

harmonic distortion of the modulated signal. 

 

All operations in this chapter are based on the AM-FM-PM analyzer mode, which will 

not be separately described below. 

Three spectrograms can be displayed at the same time or respectively in the AM-FM-PM analyzer mode. Press 

【Measure】 and select [RF Spectrum], [Audio Spectrum], [Audio Waveform] and [Summary] to display one or 

all spectrum(s). 

In order to better observe the measured signal, the following steps can be taken: 

1) Press 【Measure】→[Demod Type AM FM PM] to select the type of the analog signal to be demodulated. 

2) Press 【Freq】→ [Center Freq] and set the center frequency of the measured signal.  

3) Press 【BW】→[IFBW], and set the appropriate IF bandwidth with the number keys or 【↑】 or 【↓】 key 

or knob. 

4) Press 【Ampt】→[Ref Level] and set the reference level of the RF spectrum. Press [Scale/Div] and set the 

appropriate scale/division to facilitate the viewing of RF spectrum. 

5) Press 【Audio Spectrum】→ [Span] and set the appropriate span. Press [Scale/Div] and set the appropriate 

scale/division to facilitate the viewing of the frequency spectrum of the audio signal. 

6) Press 【Audio Waveform】→ [Sweep Time], and set the display time of the audio signal waveform. Press 

[Scale/Div] and set the appropriate scale/division to facilitate the viewing of the frequency spectrum of the 

audio signal. 

 

Set the appropriate IF bandwidth. The IF bandwidth should be more than the width of 

the modulation signal, so as to accurately demodulate the signal. You can observe the 

bandwidth in the RF spectrum. At the same time, noise may be produced in the case of 

too large IF bandwidth, which will affect the accuracy of parameter measurement. 

Taking the FM signal measurement for example, the AM-FM-PM analyzer mode is introduced as follows. At first, 

input the FM signal generated by one signal source to the RF input end of the instrument. Set the signal frequency 

as 6GHz, amplitude as -27dBm, modulation rate as 3kHz and modulation offset as 30kHz. Measurement 

procedures are as follows: 

1) Press 【Measure】→ [Demod Type AM FM PM] and select FM. 

CAUTION 

CAUTION 
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2) Press 【Freq】→ [Center Freq] and set the center frequency of the measured signal as 6GHz.  

3) Press 【BW】→ [IFBW] and set the IF bandwidth as 100kHz.  

4) Press [Audio Spectrum]→ [Span], and set the span as 100kHz.  

5) Press [ [Audio Waveform] → [Sweep Time] and set the sweep time as 2ms. 

Measurement results are shown in Fig. 7-1. 

 

Fig 7-1 Diagram of FM AM/FM/PM analyzer Results 
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Section 2 AM/FM/PM analyzer Menu Structure 
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Fig. 7-2 AM-FM-PM Analyzer Menu 
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Fig. 7-3 AM-FM-PM Analyzer Menu (continued) 
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Section 3 Description of AM/FM/PM analyzer Menu 

7.3.1 Frequency menu 

Signal Std

--

Center Freq

Frequency

Start Freq

Stop Freq

CF Step

Auto Man

Channel

--

>

Signal Track

Off On

Signal Search

 

·[Center Freq]: Press 【Freq】→[Center Freq], and select [GHz], [MHz], [kHz] or [Hz] 

in the frequency unit menu by using the numeric keys on the front panel, or set the 

center frequency by using 【↑】 【↓】 keys and the knob. 

·[Special Attention]: The frequency step value is the same as the [Step Frequency] 

setting value when using 【↑】 【↓】 keys and the knob. The step frequency value 

can be set by using the numeric keys or 【↑】 【↓】 keys and the knob after 

switching to [Step Frequency Auto Man] from [Step Frequency Auto Man]. 

·[Special Attention]: Change the span by using 【↑】 【↓】 keys and the knob based 

on the steps of 1-2-5. 

·[Start Freq]: Press 【Freq】→[Start Freq] to select the corresponding frequency unit 

via the numeric keys on the front panel, or set it by using 【↑】 【↓】 keys and the knob. 

·[Stop Freq]: Press 【Freq】→[Stop Freq] to select the corresponding frequency unit 

via the numeric keys on the front panel, or set it by using 【↑】 【↓】 keys and the knob. 

·[CF Step Auto Man]: Press 【Freq】→[CF Step Auto Man] to select step freq to 

manual or auto,and alse set a frequency unit via the numeric keys on the front panel, or 

set it by using 【↑】 【↓】 keys and the knob. 

·[Signal Std]: Press 【Freq】→[Signal Standard] to select a signal standard by using 

【↑】 【↓】 keys and the knob, and call it by using [Recall] or [Enter] key in the dialog 

menu. Refer to the dialog menu for details. 

·[Special Attention]: After the signal standard is loaded, the center frequency and 

the span are set to those defined in the signal standard. 

·[Channel]: Press 【Freq】→[Channel.] and pop up the channel No. setting dialog, and 

then set the channel No. via the numeric keys or 【↑】 【↓】 keys and the knob. 

·[Special Attention]: The channel No. shall be set after the signal standard is 

loaded, otherwise a prompt showing setting not available is given. 

·[Signal Track Off On]: Press 【Freq】→[Signal Track Off On] set signal track on or 

off.. 

·[Signal Search]: Press 【Freq】→[Signal Search], push this key can search the signal 

quickly. 
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7.3.2 Span menu 

Span

Span

Last span

< Back

 

·[Span]: Press【Span】→[Span] to activate the span submenu. You can change it by 

using the numeric keys and selecting a frequency unit, or by using 【↑】 【↓】 keys and 

the knob. 

·[Special Attention]: Change the span by using 【↑】 【↓】 keys and the knob based 

on the steps of 1-2-5. 

·[Last Span]: Press【Span】→[Last Span] to restore the span to that last set. 

·[Back]: Press【Span】→[Back] to return to the 【Freq】 menu. 

7.3.3 Amplitude menu 

Ref level

0.0dBm

Amplitude

Ref Position

Atten

Auto Man

Scale/Div

10.0dB

Pre Amp

Off             On

 

·[Ref Level]: Press 【Ampt】→[Ref Level] and select [dBm], [-dBm], [mV] or [uV] in 

the frequency unit menu by using the numeric keys on the front panel, or 【↑】 【↓】 

keys and the knob. 

·[Special Attention]: The step is 10 dB when the 【↑】 【↓】 keys and the knob are 

used. 

·[Ref Position]: Press 【Ampt】→[Ref Position] and change it by using the numeric 

keys or by using 【↑】 【↓】 keys and the knob. 

·[Atten Auto Man]: Press 【Ampt】→[Atten Auto Man] and switch the attenuator auto 

or manual mode in the menu by using the numeric keys or by using 【↑】 【↓】 keys 

and the knob. 

·[Special Attention]: The setting range of the attenuation value is between 0 dB 

and +60 dB, and the step is 10 dB. 

·[Scale/Div]: Press 【Ampt】→[Scale/Div] and set it between 0.1 dB and 20 dB by 

using the numeric keys or by using 【↑】 【↓】 keys and the knob. 

·[Pre Amp Off On]: Press 【Ampt】 to control on or off state of the preamplifier. This 

function is activated when the reference level is less than -40 dBm. 

7.3.4 Bandwidth menu 

IFBW

BW

Average

Off On

 

·[IFBW]: Press 【BW】→[IFBW] to select the corresponding frequency unit [GHz], 

[MHz], [kHz] or [Hz] via the numeric keys on the front panel, or set it by using 【↑】 

【↓】 keys and the knob. 

·[Special Attention]: The intermediate frequency bandwidth shall be larger than 

the width of the modulated signal so that the signal can be accurately 

demodulated, and the bandwidth of the modulated signal can be observed in the 

radio frequency spectrum. In addition, excessive intermediate frequency 

bandwidth will introduce noise and influence the accuracy of parameter 

measurement. The intermediate frequency bandwidth is between 10 kHz and 300 

kHz with the step change of 1-3-10. 
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·[Average Off On]: Press 【BW】→[Average Off On]. The average function can 

smoothen the displayed traces. When such function is turned on, you can select the 

number of average by using the numeric keys or change it by using 【↑】 【↓】 keys 

and the knob. 

7.3.5 Marker menu 

Marker

1 2 3 4 5 6

Marker

Normal

Delta

Select 

Trace

Off

All Off

>

>

 

·[Marker 1 2 3 4 5 6]: Press 【Marker】→[Marker 1 2 3 4 5 6] to switch display of 

different markers. The selected marker is underlined. 

·[Normal]: Press 【Marker】→[Normal] to set the marker display mode currently 

selected as the normal mode. 

·[Delta]: Press 【Marker】→[Delta] to set the marker display mode currently selected 

as the differential mode. The differential mode shows the differences of frequencies 

and amplitudes between difference and reference markers (it is time difference in zero 

span mode), and the amplitude value displayed is in dB. 

·[Select Trace]: Press 【Marker】→[Select Trace] and pop up the trace-related soft 

menu, including[Radio Frequency Spectrum], [Audio Spectrum] and [Audio 

Waveform]. Refer to the [Select Trace] menu for details. 

·[Off]: Press 【Marker】→[Off] to turn off the currently active marker. 

·[All Off]: Press 【Marker】→[All Off] to turn off all markers that have been turned on. 

 

RF Spectrum

Select Trace

Audio 

Spectrum

Audio 

Waveform

<   Back

>

 

·[RF Spectrum]: Press 【Marker】→[Select Trace]→[RF Spectrum], and select the 

current trace as a trace in the radio frequency spectrum so that the marker operates 

only on this trace. 

·[Audio Spectrum]: Press 【Marker】→[Select Trace]→[Audio Spectrum], and select 

the current trace as a trace in the audio spectrum so that the marker operates only on 

this trace. 

·[Audio Waveform]: Press 【Marker】→[Select Trace]→[Audio Waveform], and 

select the current trace as a trace in the audio waveform so that the marker operates 

only on this trace. 
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7.3.6 Peak menu 

Peak Search
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·[Peak Search]: Press 【Peak】→[Peak Search] to set the current active marker to the 

maximum peak point of the measurement trace and display the frequency and 

amplitude of such marker at the upper middle position of the screen. 

·[Next Pk]: Press 【Peak】→[Next Pk] to move the active marker to the next highest 

point related to the current marker position on the trace. 

·[Next Pk Left]: Press 【Peak】→[Next Pk Left] to find the next peak at the left of the 

current marker position. 

·[Next Pk Right]: Press 【Peak】→[Next Pk Right] to find the next peak at the right of 

the current marker position. 

·[Max Search]: Place a marker at the highest point of the trace and display the 

frequency and amplitude of this marker at the upper right corner of the screen. 

Pressing this key does not change the activated functions. 

·[Min Search]: Press 【Peak】→[Min Search] to place a marker at the lowest point of 

the trace and display the frequency and amplitude of this marker at the upper right 

corner of the screen. Pressing this key does not change the activated functions. 

·[Marker→Center]: Press 【Peak】→[Marker→Center] and set the center frequency 

equal to the marker frequency; this function can quickly move the signal to the center 

position of the screen, and this operation is only valid for the radio frequency 

spectrum. 

·[Special Attention]: Each peak and maximum and minimum values are searched 

on the selected trace. See the [Select Trace] menu for details. 

7.3.7 RF spectrum menu 
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RF Spectrum

Method
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·[Special Attention]: The occupied bandwidth measurement in the radio frequency 

spectrum is similar to that in the Spectrum Analyzer mode, but it only applies to 

the radio frequency spectrum in the AM/FM/PM analyzer measurement mode. 

·[OBW Off On]: Press 【RF Spectrum】→[OBW Off On] to turn the occupied 

bandwidth measurement on or off. 

·[Method % dBc]: Press 【RF Spectrum】→[Method % dBc] to select different 

measuring methods, including percentage or dBc down method. The percent method is 

used to obtain the occupied bandwidth of the signal by calculating the bandwidth of the 

portion of the frequency that contains a certain percentage of the power of the entire 

transmission signal. The percent of the power may be set by the user. The dBc down 

method defines the occupied bandwidth as the distance between the two frequency 

points when the signal power drops dBc at both sides of the frequency point where the 

peak power of the signal exists. The dBc of the signal power drop is set by the user. 

·[%]: Press 【RF Spectrum】→[%] to set the percent value. 

·[dBc]: Press 【RF Spectrum】→[dBc] to set the dBc value. 
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7.3.8 Audio spectrum menu 

Span

Audio Spectrum

Scale/Div

10.0dB

Ref Position

 

·[Span]: Press 【Audio Spectrum】→[Span] to set the span of the audio spectrum. The 

span set here shall be big enough to display the audio signal and related harmonics. 

You can change it by using the numeric keys and selecting a frequency unit, or by 

using 【↑】 【↓】 keys and the knob. 

·[Scale/Div]: Press 【Audio Spectrum】→[Scale/Div] to set the scale of the audio 

spectrum to facilitate the observation of the audio spectrum traces. You can change the 

scale unit by using the numeric keys and selecting the frequency unit [dB] or [-dB], or 

by using 【↑】 【↓】 keys and the knob. 

·[Ref Position]: Press 【Audio Spectrum】→[Ref Position] to set the reference position 

of the audio spectrum to facilitate the observation of the audio spectrum traces. You 

can change the reference position by using the numeric keys and clicking OK, or by 

using 【↑】 【↓】 keys and the knob. 

7.3.9 Audio waveform menu 

Sweep Time

Audio Waveform

Scale/Div

20.0%

 

·[Sweep Time]: Press 【Audio Waveform】→[Sweep Time] to set the sweep time of the 

audio waveform. The measurement results are more stable if the sweep time set here is 

longer and the sampling points are more. 

·[Scale/Div]: Press 【Audio Waveform】→[Scale/Div] to set the scale of the audio 

waveform to facilitate the observation of the audio spectrum traces. You can change the 

scale unit by using the numeric keys and then selecting [%] or clicking OK, or by using 

【↑】 【↓】 keys and the knob. 

·[Special Attention]: The scale unit changes with the change of types of 

demodulation signals. When the AM signal is measured, the scale unit is 

percentage (%). When the FM signal is measured, the scale unit is frequency unit 

(Hz, kHz or GHz). When the PM signal is measured, the scale unit is radian 

(Rad). 
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7.3.10 Measurement menu 
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·[Demod Type AM FM PM]: Press 【Measurement】→[Demod Type AM FM PM] to 

select the type of the signal to be demodulated. 

·[RF Spectrum]: Press 【Measurement】→[RF Spectrum] to select display of the radio 

frequency spectrum only. 

·[Audio Spectrum]: Press 【Measurement】→[Audio Spectrum] to select display of 

the audio spectrum only. 

·[Audio Waveform]: Press 【Measurement】→[Audio Waveform] to select display of 

the audio waveform only. 

·[Display All]: Press 【Measurement】→[Display All] to select simultaneous display of 

radio frequency spectrum, audio spectrum and audio waveform. 

·[Sweep Type Continuous Single]: Press 【Measurement】→[Sweep Type Continuous 

Single] to select continuous or single sweep. 

·[Scan Again]: Press 【Measurement】→[Scan Again] to trigger sweep again. 

Re-sweep makes sense only when the sweep type is set to single sweep. 

7.3.11 File menu 

Refer to the description of the file menu in the Spectrum Analyzer mode. 
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Chapter VIII Channel Scanner Mode (Option) 

Section 1 Introduction to Typical Measurement 
The channel scanner mode can be applied to measure the signal power of multiple channels. The signal power is 

displayed in the bar graph or list form. At most, the signal power of 20 channels can be displayed. This can be 

divided into three modes according to the channel setting: channel scanner, frequency scanner and List sweep. 

Channel scanner: Set the measured channel by setting the signal standard, starting channel and channel step. 

Frequency scanner: Set the measured channel by setting the starting frequency and frequency step. 

List sweep: Set the measured channel by setting the list. 

The bandwidth and number of measured channels can be set in the above three modes. 

 

All operations in this chapter are based on the channel scanner mode, which will not 

be separately described below. 

8.1.1 Channel Scanner 

Below is an example of the Channel Scanner mode, mainly involving the following procedures. 

1) Press 【Sweep】→ [Channel Scanner] → [Signal Std], and set the signal standard of measurement. 

2) Press 【Sweep】→[Channel Scanner]→[Start Channel] and set the starting channel of measurement. In this 

case, the starting channel should meet the requirements of the selected signal standard.  

3) Press 【Sweep】→[Channel Scanner] →[Number of Channels], and set the number of measured channels. At 

most 20 channels can be measured at the same time.  

4) Press 【Sweep】→[Channel Scanner] →[Channel Step] and set the channel step of measurement. A certain 

number of channels will be measured with the starting channel as the initial channel, based on the set channel 

step. 

5) Press 【Sweep】→ [Display Graph Table] and enable the graph display mode. 

6) Press 【Sweep】→[Power Display Curr Max] and enable the maximum option. Set the maximum power of 

each displayed channel. 

 

The power cannot be set as the maximum value until the maximum holding function is 

enabled. 
CAUTION 

CAUTION 
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Fig. 8-1 Schematic Diagram of Channel Scanner 

8.1.2 Frequency Scanner  

Below is an example of the Frequency Scanner mode, mainly involving the following procedures. 

1) Press 【Sweep】→ [FScan] → [Start Freq], and set the center frequency of the starting channel. 

2) Press 【Sweep】→ [FScan]→ [Step Freq], and set the frequency step of the measured channel.  

3) Press 【Sweep】→ [FScan] → [Bandwidth], and set the bandwidth of the measured channel.  

4) Press 【Sweep】→ [FScan] → [Number of Channels], and set the number of measured channels. At most 20 

channels can be measured at the same time. 

5) Press 【Measure】→ [Display Graph Table] and enable the graph display mode. 

6) Press 【Measure】→ [Power Display Curr Max], and enable the “Current” option. Set the current power of 

each channel. 

7) Press 【Measure】→ [Color Code Single Dual] and enable the dual color mode. 

8) Press 【Measure】→ [Orientation Vert Hori] and enable the horizontal mode. 
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Fig 8-2 Schematic Diagram of the Frequency Scanning 

8.1.3 List sweep 

Below is an example of the Frequency Scanner mode, mainly involving the following procedures. 

1) Press【Sweep】→[MScan] → [Edit List] and edit the channel list to be swept. The information of each 

channel can be set by setting the signal standard and channel number or setting the frequency and bandwidth 

in the list. 

2) Press【Sweep】→[MScan] →[Number of Channels], and set the number of measured channels. At most 20 

channels can be measured at the same time. 

3) Press【Sweep】→[Display Graph Table] and enable the graph display mode. 

4) Press【Sweep】→[Power Display Curr Max], and enable the “Current” option. Set the current power of each 

channel. 
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Fig. 8-3 Schematic Diagram of List sweep 
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Section 2 Structure of the Channel scanner Menu 

Refer level

0.0dBm

Amplitude

Scale/Div

10.0dB

Signal Std

--

Ch Scanner

Start Channel

--

Number of 

Channels

Channel Step

1
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200.000kHz

Channel 

Scanner >
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Freq 

Scanner >

List 

Scanner >

Display

Graph Table

Measure

Max Hold

Off On

Channel Unit
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Power Display

Curr Max

Color Code

Single Dual

Orientation

Vert Hori

Start Freq

890.000MHz

Freq Scanner

Step Freq

200.000kHz

Bandwidth

200.000kHz

Number of 

Channels

  Edit list >

List Scanner

Number of 

Channels

Signal

 Std

Edit list

Channel

Frequency

Bandwidth

Done

Cancel

>

Signal Std

Cancel

>

<  Back

>

<  Back

>

>

Done

Signal Std

Cancel

>

Done

>

 

Fig 8-1 Channel scanner Menu 
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Section 3 Description of Channel scanner Menu 

8.3.1 Scanner menu 

Channel 

Scanner >

Scanner

Freq 

Scanner >

List 

Scanner >

 

·[Channel Scanner]: Press【Scanner】→[Channel Scanner] to set the Channel scanner 

measurement mode and activate the[Channel Scanner] submenu in which the 

parameters of the channel to be scanned can be set. For details, see the [Channel 

Scanner] submenu. 

·[Freq Scanner]: Press【Scanner】→[Freq Scanner] to set the frequency scanning 

measurement mode and activate the [Scan Frequencies] submenu in which the 

parameters of the channel to be scanned can be set. For details, see the [Freq Scanner] 

submenu. 

·[List sweep]: Press【Scanner】→[List sweep] to set the list scanning measurement 

mode and activate the [Scan Custom List] submenu in which the parameters of the 

channel to be scanned can be set. For details, see the [List sweep] submenu. 

8.3.2 Channel Scanner Menu 

Signal Std

--

Ch Scanner

Start Channel

--

Number of 

Channels

Channel Step

1

Bandwidth

200.000kHz

>

<  Back

>

 

·[Signal Std]: Press【Scanner】→[Channel Scanner] →[Signal Standard] to make the 

existing signal standard list pop up, click [Recall] through relevant menus including 

[Header], [Footer], [Page Up] and [Page Down], and select the corresponding signal 

standard. 

·[Start Channel]: Press【Scanner】→[Channel Scanner] →[Start Channel] to set the 

number of the start channel, which is the channel where the measurement starts. This 

channel No. can be set only when the signal standard is selected. 

·[Number of Channels]: Press【Scanner】→[Channel Scanner] →[Number of 

Channels] to set the number of channels to be measured. At most, 20 channels can be 

measured. 

·[Channel Step]: Press【Scanner】→[Channel Scanner]→[Channel Step] to set the step 

between the channels to be measured. 

·[Channel BW]: Press【Scanner】→[Channel Scanner]→[BandWidth] to set the 

bandwidth of the channel to be measured. 
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8.3.3 Frequency Scanner Menu 

Start Freq

890.000MHz

Freq Scanner

Step Freq

200.000kHz

Bandwidth

200.000kHz

Number of 

Channels

<  Back

>

 

·[Start Freq]: Press 【Scanner】→[Freq Scanner]→[Start Freq] to set the center 

frequency of the start channel to be scanned. 

·[Step Freq]: Press 【Scanner】→[Freq Scanner]→[Step Freq] to set the frequency step 

between the channels. 

·[BandWidth]: Press 【Scanner】→[Freq Scanner]→[BandWidth]to set the bandwidth 

of the channel to be measured. 

·[Number of Channels]: Press 【Scanner】→[Freq Scanner] →[Number of Channels] 

to set the number of channels to be measured. At most, 20 channels can be measured. 

8.3.4 List sweep Menu 

  Edit list >

List Scanner

Number of 

Channels

 

·[Edit List]: Press 【Scanner】→[List sweep]→[Edit List] to make the corresponding 

list edit menu pop up. For details, see the [Edit List] menu. 

·[Number of Channels]: Press 【Scanner】→[List sweep] →[Number of Channels] to 

set the number of channels to be measured. At most, 20 channels can be measured. 

Signal

 Std

Edit list

Channel

Frequency

Bandwidth

Done

Cancel

>

 

·[Signal Std]: Press [Edit List]→[Signal Std] to make the signal standard list pop up, 

select the required signal standard through relevant menus including [Header], 

[Footer], [Page Up] and [Page Down], and click [Recall]. 

·[Channel]: Press [Edit List]→[Channel] to display such information as the selected 

signal standard and channel range. Users can also edit the channel No., and click 

[Done] to save the setting. 

·[Frequency]: Press [Edit List]→[Frequency] to edit the center frequency of the 

selected channel, and click [Done] to save the setting. 

·[BandWidth]: Press [Edit List]→[BandWidth] to edit the bandwidth of the selected 

channel, and click [Done] to save the setting. 

·[Done]: Press [Edit List]→[Done] to save the modified setting and return to the Scan 

Custom List menu. 

·[Cancel]: Press [Edit List]→[Cancel] to cancel the modified setting and return to the 

Scan Custom List menu。 
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8.3.5 Measurement menu 

Display

Graph Table

Measure

Max Hold

Off On

Channel Unit

Ch Freq

Power Display

Curr Max

Color Code

Single Dual

Orientation

Vert Hori

 

·[Display Graph Table]: Press 【Measurement】→[Display Graph Table] to select the 

graph display mode, and the two graphs are shown as Figs 8-7 and 8-8. 

·[Max Hold Off On]: Press 【Measurement】→[Max Hold Off On] to set the On or Off 

state of Max Hold. 

·[Channel Unit Ch Freq]: Press 【Measurement】→[Channel Unit Ch Freq] to set the 

channel No. or frequency display of the channel. 

·[Power Display Curr Max]: Press 【Measurement】→[Power Display Curr Max] to 

set the display of the real-time or maximum power. The power display can be set to be 

Max when and only when Max Hold is in the On state. 

·[Color Code Single Dual]: Press 【Measurement】→[Color Code Single Dual] to set 

the single-color or dual-color display of the channel. 

·[Orientation Vert Hori]: Press 【Measurement】→[Orientation Vert Hori] to set the 

vertical or parallel display of the channel graph. 

8.3.6 File menu 

Please refer to the description of the file menu in the Spectrum Analyzer mode. 
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Chapter IX Field Strength Measurement Mode (Option) 

Section 1 Introduction to Typical Measurement 
The field strength measurement is indispensable in radiation strength measurement of the tested equipment and 

can be divided into three modes: PScan, FScan and MScan. 

PScan: Observe the offset, amplitude and field strength of the current point by setting the point frequency. 

FScan: Observe the amplitude and field strength changes within a certain frequency range by setting the starting 

frequency, step frequency and number of points. 

MScan: Observe the amplitude and field strength of frequency points in the list by recalling the edited or saved 

list. 

 

All the operations in this chapter are based on the Field Strength mode, which will not 

be separately described below. 

9.1.1 PScan 

Main operation procedures of [PScan]: 

1)  Press 【Measure】→ [PScan] to enable the point frequency measurement mode. 

2)  Press 【Freq】→ [Pot Freq] and set the point frequency within the range of  [1MHz, 44.1GHz]. 

3)  Press 【BW】→ 【BW】 and set the bandwidth as 150Hz, 300Hz, 600Hz, 1.5kHz, 2.4kHz, 6kHz, 9kHz, 

15kHz, 30kHz, 50kHz, 120kHz or 150kHz. 

4)  Press 【Swp/Ant】→ [Recall Antenna], and select the antenna factor file. 

5)  Press [Demod] and set the demodulation type and volume. 

The schematic diagram of PScan mode is shown in the Fig below (example). 

 

Fig. 9-1 Schematic Diagram of PScan Mode 

9.1.2 FScan 

Main operation steps of FScan: 

CAUTION 
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1)  Press 【Measure】→ [FScan] to enable the frequency sweeping mode. 

2)  Press 【Freq】→ [Stt Freq] and set the starting frequency of sweeping. 

3)  Press 【Freq】→ [Step Freq] and set the step frequency of sweeping. 

4)  Press 【Freq】→ [Points] and set the number of sweeping points. 

5)  Press 【BW】→ 【BW】 and set the bandwidth as 150Hz, 300Hz, 600Hz, 1.5kHz, 2.4kHz, 6kHz, 9kHz, 

15kHz, 30kHz, 50kHz, 120kHz or 150kHz. 

6)  Press 【Swp/Ant】→ [Recall Antenna], and select the antenna factor file. 

7)  Press 【Swp/Ant】→ [Dwell Time +∞ Man], and set the dwell time. 

8)  Press 【Swp/Ant】→ [Dwell Time Off On] to enable or disable the dwell time. 

9)  Press 【Marker】→ [Marker Off On] to enable or disable the marker. 

10) Press 【Peak】 to directly set the marker at the maximum point 

 

The dwell time refers to the time of dwelling at the frequency point exceeding the set 

limit in the ON state. 

The schematic diagram of FScan mode is shown in the Fig below (example). 

 

Fig. 9-2 Schematic Diagram of FScan Mode 

9.1.3 MScan 

Main operation steps of MScan: 

1)  Press 【List Edit】→ [Edit List] and edit the current list. 

2)  Press 【Measure】→[MScan] to enable the MScan mode. 

3)  Press 【List Edit】→ [Edit List]→ 【Freq】 and set the step frequency of sweeping. 

4)  Press 【List Edit】→ [Edit List]→ [BandWidth] and set the bandwidth as 150Hz, 300Hz, 600Hz, 1.5kHz, 

2.4kHz, 6kHz, 9kHz, 15kHz, 30kHz, 50kHz, 120kHz or 150kHz. 

5)  Press 【Swp/Ant】→ [Recall Antenna], and select the antenna factor file. 

CAUTION 
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6)  Press 【Swp/Ant】→ [Dwell Time +∞ Man], and set the dwell time. 

7)  Press 【Swp/Ant】→ [Dwell Time Off On] to enable or disable the dwell time. 

8)  Press 【Marker】→ [Marker Off On] to enable or disable the marker. 

9)  Press 【Peak】 to directly set the marker at the maximum point. 

 
he MScan mode can be enabled only the list is not empty. 

The schematic diagram of MScan mode is shown in the Fig below (example). 

 

Fig. 9-3 Schematic Diagram of MScan Mode 

CAUTION 
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Section 2 Field Strength Measurement Menu Structure 

Pot Freq

500MHz

Frequency

Freq Step

Auto Man
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Peak

Detector

Average

Real Time

Back
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>

Max Search

Marker
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CW

Demod

FM
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USB
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Fig. 9-4 Overall Block Diagram of Field Strength Menu 
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Done
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Done

Cancel

>

Header

Tail

Page up

Page down

Done

Delete

Delete All

Cancel

 

Fig. 9-5 Overall Block Diagram of Field Strength Menu (continued) 
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Save State

File
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Save Data
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File
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Fig. 9-6 Overall Block Diagram of Field Strength Menu (continued) 
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Section 3 Description of the Field Strength Measurement Menu 

9.3.1 Frequency Menu (PScan Measurement Mode) 

Pot Freq

500MHz

Frequency

Freq Step

Auto Man

Freq Track

Off On

 

·[Pot Freq]: Press 【Freq】→[Pot Freq] to set the dot frequency by selecting [GHz], 

[MHz], [kHz] or [Hz] in the frequency unit menu through the numeric keys on the 

front panel or using 【↑】 or 【↓】 and knob. 

·[Special Attention]: The dot frequency shall be set within the range of 1 MHz ~ 

the top freq of the mode. 

·[Freq Step]: Press 【Freq】→[Freq Step Auto Man] to change the dot frequency step 

by setting 【↑】 or 【↓】 and knob . The frequency step is set to be 1 MHz 

automatically. 

·[Freq Track Off On]: Press 【Freq】→[Freq Track Off On] to set the On or Off state 

of the frequency track. When the frequency track is On, the instrument can 

automatically track the frequency at the peak point and display the tracked frequency in 

the frequency display area on the current screen. 

·[Special Attention]: The peak point at which the frequency is tracked is the one at 

which the amplitude signal is searched within the current bandwidth range. 
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9.3.2 Frequency Menu (FScan Measurement Mode) 

Stt Freq

500MHz

Frequency

Step Freq

10MHz

point

58

 

·[Stt Freq 500MHz]: Press 【Freq】→[Start Freq] to set the start frequency by selecting 

[GHz], [MHz], [kHz] or [Hz] in the frequency unit menu through the numeric keys on 

the front panel or using 【↑】 or 【↓】 and knob. 

·[Special Attention]: The start frequency shall be set within the range of 1 MHz ~ 

the top freq of the mode. 

·[Step Freq 10 MHz]: Press 【Freq】→[Step Frequency] to change the frequency 

scanning step by setting 【↑】 or 【↓】 and knob . 

·[Point 58]: Press 【Freq】→[Points 58] to set the points of the frequency scanning 

which shall be set within the range of 2 ~ 58. 

9.3.3 Amplitude menu 

Ref Level

107dBuV

Amplitude

Atten

Auto Man

Scale/Div

20.0dB

Limit

Off On

Alarm

Off On

Unit

dBuV
>

 

·[Ref Level 107 dBuV]: Press 【Ampt】→[Ref Level 107 dBuV] to set the reference 

value by selecting [dBuV], [-dBuV], [mV] or [uV] in the frequency unit menu through 

the numeric keys on the front panel or using 【↑】 or 【↓】 and knob. 

·The reference value shall be set within the range of - 43 dBuV ~ 147 dBuV. 

·[Atten Auto Man]: Press 【Ampt】→[Atten Auto Man]. The attenuator will 

automatically adjust the attenuation value based on the reference value when it is in the 

automatic state and will always use the set attenuation value when it is in the manual 

state. 

·[Scale/Div 20.0 dB]: Press 【Ampt】→[Scale/Div 20.0 dB] to set the reference value 

by selecting [dB] or [-dB] in the frequency unit menu through the numeric keys on the 

front panel or using 【↑】 or 【↓】 and knob. 

·[Limit Off On]: Press 【Ampt】→[Limit Off On] to turn on or off the limit value 

switch. 

·[Alarm Off On]: Press 【Ampt】→[Alarm Off On] to turn on or off the audible alarm 

switch. 

·[Units dBuV]: Press 【Ampt】→[Unit] to open the function menu of the units 

including [dBm], [dBmV], dBuV], [Volt], [Watt], [A], [dBW], [dBV], [dBA], [dBmA] 

and [dBuA]. 
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9.3.4 Bandwidth menu 

BW

30kHz

BW

Detector >

 

·[BW 30 kHz]: Press 【BW】→[BW 30 kHz] to set the reference value by selecting 

[GHz], [MHz], [kHz] or [Hz] in the frequency unit menu through the numeric keys on 

the front panel or using 【↑】 or 【↓】 and knob. 

·[Special Attention]: The bandwidth can only be 150 Hz, 300 Hz, 600 Hz, 1.5 kHz, 

2.4 kHz, 6 kHz, 9 kHz, 15 kHz, 30 kHz, 50 kHz, 120 kHz or 150 kHz. 

·[Detector]: Press 【BW】→[Detector] to open the Detection menu including Peak, 

Average and Real Time. 

9.3.5 Marker menu 

Max Search

Marker

Marker

Off On

 

·[Max Search]: Press 【Marker】→[Max Search] to display the Marker at the point of 

the maximum value. 

·[Marker Off On]: Press 【Marker】→[Marker Off On] to disable or enable the Marker 

display. 

·[Special Attention]: The Marker menu can be effective only in the frequency or 

list scanning mode. 

9.3.6 Peak menu 

Max Search

Peak

Marker

Off On

 

·[Max]: Press 【Peak】→[Max] to display the Marker at the point of the maximum 

value. 

·[Marker Off On]: Press 【Peak】→[Marker Off On] to disable or enable the Marker 

display. 

·[Special Attention]: The Peak menu can be effective only in the frequency or list 

scanning mode. 



Chapter IX Field Strength Measurement Mode (Option) 

126 

9.3.7 Sweep/Antenna Menu 

Sweep Type

Cont        Single

Swp/Ant

Sweep Once

Dwell Time

+∞ Man

Stay Time

Off On

Recall Antenna>

Edit Antenna >

Save Antenna

 

·[Sweep Type Cont Single]: Press 【Swp/Ant】→[Sweep Type Cont Single] to set the 

continuous or single scanning mode. 

·[Sweep Once]: Press 【Swp/Ant】→[Sweep Once] to scan again. 

·[Dwell Time +∞ Man]: Press 【Swp/Ant】→[Dwell Time +∞ Man] to set the dwell 

time which is the time for staying at the swept point at which the amplitude exceeds 

the limit value when the limit switch is turned on. The default is infinite. The dwell 

time can be manually set within the range of 1 ms ~ 40 s. 

·[Special Attention]: The dwell time can be effective only when the limit switch is 

turned on. When the dwell time is infinite, the value displayed on the main 

interface is the one set manually because the infinite time is specially set and can’t 

be displayed on the main interface. 

·[Stay Time Off On]: Press 【Swp/Ant】→[Stay Time Off On] to set the Stay Time 

which is the time for the scanning to wait at each point. The default is Off. The stay 

time can be manually set within the range of 1 ms ~ 40 s. 

·[Special Attention]: The stay and dwell time can be effective only in the 

frequency or list scanning mode. 

·[Recall Antenna]: Press 【Swp/Ant】→[Recall Antenna] to make the soft menus pop 

up, including [Header], [Footer], [Page Up], [Page Down], [Recall] and [Delete]. The 

saved antenna file can be selected and recalled. 

·[Edit Antenna]: Press 【Swp/Ant】→[Recall Antenna] to make the soft menus pop 

up, including [Add Point], [Delete Point], [Delete All], [Done] and [Cancel]. It is used 

to edit the antenna. 

·[Save Antenna]: Press 【Swp/Ant】→[Save Antenna] to open the dialog box of Save 

Antenna to save the antenna file. 
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9.3.8 Demodulation Menu 

CW

Demod

FM

AM

USB

LSB

Speaker

Off On

Volume

95

 

·[CW]: Press 【Demod】→[CW] to disable the demodulation mode. 

·[FM]: Press【Demod】→[FM] to switch the demodulation mode to FM. 

·[AM]: Press【Demod】→[AM] to switch the demodulation mode to AM. 

·[USB]: Press【Demod】→[USB] to switch the demodulation mode to USB. 

·[LSB]: Press【Demod】→[LSB] to switch the demodulation mode to LSB. 

·[LSB] won’t function after the speaker switch is turned on. 

·[Speaker Off On]: Press【Demod】→[Speaker Off On] to disable or enable the 

speaker function. 

·[Special Attention]: The demodulation modes including [FM], [AM], [USB] 

and·[Volume 95]: Press 【Demod】→[Volume 95] to set the required demodulation 

volume by using the numeric keys, 【↑】,【↓】 or knob. 

9.3.9 List Edit Menu 

Edit List

List Edit

Save List

Recall List

>

>

 

·[Edit List]: Press [List Edit]→[Edit List] to make the soft menus pop up, including 

[Add Point], [Delete Point], [Delete All], [Done] and [Cancel]. It is used to edit the list 

options. 

·[Save List]: Press [List Edit]→[Save List] to open the dialog box of Save List to save 

the list file. 

·[Recall List]: Press [List Edit]→[Recall List] to make the soft menus pop up, 

including [Header], [Footer], [Page Up], [Page Down], [Recall] and [Delete]. The 

saved list file can be selected and recalled. 

9.3.10 Measurement menu 

PScan

Measure

FScan

MScan

 

·[PScan]: Press 【Measure】→[PScan] to enable the MScan mode of field strength. 

·[FScan]: Press 【Measure】→[FScan] to enable the FScan mode of field strength. 

·[MScan]: Press 【Measure】→[MScan] to enable the MScan mode of field strength. 

[Special note]: Ensure that the list exists before enabling the MScan mode. You 

can view it by clicking [Edit List]- [Edit List]. 
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9.3.11 File menu 

Please refer to the description of the file menu in the Spectrum Analyzer mode. 
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Chapter X Working Principle 

Spectrum analyzer 4041 includes the products working on 9 kHz ~ 20 GHz, 9 kHz ~ 26.5 GHz, 9 kHz ~ 32 GHz, 

and 9 kHz ~ 44 GHz, with the spectrum measurement and analysis, field strength measurement, occupied 

bandwidth, channel power, adjacent channel power, audio demodulation, IQ data capture and other measurement 

functions, and provides the Interference Analyzer, AM/FM/PM analyzer of analog modulation signal, USB Power 

meter and other options. RF signal frequency, amplitude and other parameters may be measured. Functional block 

diagram of spectrum analyzer 4041 is as shown in Fig 10-1. 

 

Fig10-1 Block diagram of instrument functions 

System hardware mainly comprises of the microwave and millimeter wave frequency conversion module, 

frequency synthesizer board, IF channel plate, CPU board, display, keyboard, tracking generator (option), etc. 

Of which, microwave and millimeter wave frequency conversion module includes the 60 dB program-controlled 

step attenuator as well as the switching filter and frequency conversion. The attenuation value of the automatic 

program-controlled step attenuator may be set by the whole machine according to the reference level or by the 

user manually to provide the suitable mixer level. Switching filter and frequency conversion complete the 

sub-band filtering and frequency conversion processing of RF input signal, and output the IF signal to the IF 

channel plate. 

IF channel plate filters the IF signal from the frequency conversion module, performs the gain control for different 

bands to adjust the amplitude value of AD sampling signal, and finally outputs the differential digital signal to 
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FPGA after the AD conversion to complete the digital down-conversion, IF filtering. video filtering, etc. 

CPU board consists of the power conversion and management circuit, interface and display circuit, FPGA/CPLD 

control and digital signal processing circuit, and ARM core module to realize the AC/DC conversion of power 

supply, power supply management, digital signal processing, logic circuit control, etc., and outputs the test results 

to the liquid crystal display in the form of sweep curve, waterfall map, etc. 

Frequency synthesizer board can provide 10MHz reference input/output function externally, and the internal 

reference loop output signal serves as the frequency reference of the local oscillation and provides the 

high-stability clock signals for AD sampling and FPGA. Local oscillation generation circuit provides the local 

oscillation signal for the mixer in the microwave and millimeter wave frequency conversion module, which is 

related to the hardware sweep speed, phase noise, sideband stray and other specifications of the whole machine. 

Tracking generator board (option) can output the dot frequency signal with the fixed frequency and power and 

also the fixed power, and set the frequency sweep signal in the frequency band. 
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Chapter XI Performance Characteristics Test 

The test device and inspection facilities shall comply with the provisions in GB/T 6592-1996. The equipment and 

facilities necessary for the sufficient accuracy, quality, and quantity shall be provided and qualified by the 

measurement department. During the validity period of measurement, other instrument and equipment suitable for 

the inspection of this standard may be used. The instrument and equipment for the test are as shown in the table 

below. 

Table 11-1 Instrument and equipment recommended for spectrum analyzer 4041 

S/N Instrument name Main technical specifications 
Recommended 

model 

1 
Synthesized signal 

generator 

Frequency range: 250 kHz~50 GHz 

Power output: -100 dBm ~ +15 dBm 

Frequency accuracy: ±0.02% 

Power level may be calibrated and stored 

With internal and external AM mode and low frequency 

output 

1464C 

or E8257D 

2 Spectrum Analyzer Frequency range: 3 Hz~26.5 GHz, DANL: <-100 dBm 4041 or E4440A 

3 Function generator  

Waveforms: sine, triangle, square wave, etc. 

Frequency range: 1 μHz~80 MHz 

Amplitude range: 1 mV~10 V 

Agilent 33250A 

4 Power meter 

Power range: -70 dBm~ +20 dBm 

Calibration source frequency: 50 MHz 

Calibration source amplitude: 0 dBm 

Anritsu 

ML2437A 

5  Power sensor 
Frequency range: 10 MHz~50 GHz 

Power range: -70 dBm~ +20 dBm 

Anritsu 

MA2445D 

6 Vector network analyzer Frequency range: 50 MHz~50 GHz 
N5247A or 

36587A 

7 Power divider 
Frequency range: 50 kHz~50 GHz 

Insertion loss: <8 dB 

81313 or 

11667C 

8 RF directional coupler 
Frequency range: 300 kHz~4 GHz, directionality: 35 dB 

VSWR: <1.45 
70607 

9 Directional coupler 

Frequency range: 2 GHz~50 GHz, coupling degree: 16dB 

Directionality: 14 dB, flatness: 0.75 dB 

VSWR: <1.45, insertion loss: <1.3 dB 

70603 

10 Low pass filter 
Stop frequency 1.0 GHz, insertion loss <0.9 dB, 

out-of-band rejection >65 dB  
SLP-1200 

11 Low pass filter Stop frequency 6.8 GHz, insertion loss <2 dB, 81613 
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out-of-band rejection >50 dB  

12 Low pass filter 
Stop frequency 18 GHz, insertion loss <2 dB, out-of-band 

rejection >40 dB 
FLP-1800 

13 Low pass filter 
Stop frequency 26.5 GHz, insertion loss <2 dB, 

out-of-band rejection >40 dB 
FLP-2650 

14 50Ω matcher Impedance: 50 Ω 70508 
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Table 11-2 (Continued) Instrument and equipment recommended for spectrum analyzer 4041 

S/N Instrument name Main technical specifications Recommended model 

15 Adapter 2.4 mm(f)-2.4 mm(f) 711120 

16 Adapter 3.5 mm(m)-3.5 mm(m) 71119 

17 Adapter 2.4 mm(f)-3.5 mm(f) 71125 

18 Adapter 2.4 mm(m)-3.5 mm(m) 71122 

18 Adapter 3.5 mm(f)-3.5 mm(f)  

19 Adapter BNC (f)-SMA (m) BNC/SMA-JK 

20 Adapter BNC (m)-BNC (f)-BNC (m) BNC-KJK 

21 Cable BNC (m)-BNC (m), two Self made 

22 Low loss cable 2.4 mm cable (m-m), two 11PA-11PA-PTH147-1500-J 

23 Computer Win XP or Win7 platform  

24 

Leakage current 

withstanding 

voltage tester 

Leakage current 0.5 mA~20 mA, voltage 242 V, 3 kV, 

5 kV 
CJ2673 

25 
Variable-frequency 

power source 
Frequency 47 Hz~400 Hz, Voltage 0~3,000 V AFC-1kW 

26 

High and low 

temperature 

alternating 

temperature & 

humidity test 

chamber 

Temperature -70℃~+150℃, humidity 25~98%RH ESL-10P 

27 

High and low 

temperature & 

humidity heat 

exchange box 

Temperature -70℃~+80℃, humidity (50~98) %RH Y751C 

28 Crash test bench Maximum load 100 kg, acceleration (50~400) m/s
2
 P-100 

29 
Electrodynamics 

vibration generator 

Maximum load 500 kg, maximum displacement 51 

mm (p-p) 

Rated thrust 31.36 kN, frequency range 5~2,500 Hz 

DC-3200-36 

30 

Leakage current 

withstanding 

voltage tester 

Leakage current 0.5 mA~20 mA, voltage 242 V, 3 kV, 

5 kV 
CJ2673 

31 
Digital 

megohmmeter 
FLUKE1508 FLUKE1508 

It may be replaced by the test device with the equivalent performance characteristics. 

http://department.ei41.com/eiscl/qijian/11PA-11PA-PTH147-1500-J.pdf
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This section provides the recommended test methods for the main technical specifications of spectrum analyzer 

4041. These specifications can fully reflect the performance and status of spectrum analyzer. The spectrum 

analyzer to be measured shall store for at least 2 hours in the working temperature range, and the indicator test can 

only be started after 15min warm-up without the error indication. 

 

The specific test steps for each of the following specifications are prepared according 

to the test instrument as shown in the Fig. When other test instruments with equivalent 

performance characteristics, they shall be operated according to the User's Guide. The 

reset instrument mentioned in the test steps refers to the reset mode of manufacturer. If 

the equipment is in the user-defined reset state, it shall be changed to the reset state of 

manufacturer and reset again to ensure that the equipment is in the known state 

initially. 

11.1 Frequency range 

Description: Test the frequency measurement range of spectral analyzer with a 9 kHz signal and another signal 

with the upper frequency limit of spectrum analyzer. The signal within the upper and lower frequency limits of 

spectrum analyzer 4041 is generated by the signal generator with high frequency stability to check whether the 

frequency measurement capability is qualified. 

A) Testing equipment 

Synthesized signal generator   1464C 

b) Adapter 

2.4 mm (f)-2.4 mm (f) adapter * 2 

2.4 mm (f)-3.5 mm (m) adapter * 1 

One 2.4 mm (f)-3.5 mm (m) adapter 

c) Cable 

One BNC (m-m) cable 

One 2.4 mm (m-m) cable 

d) Test steps 

CAUTION 
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Fig 11-1 Test of frequency range 

1) As the dashed-line connected test device shown in Fig 11-1, spectrum analyzer 4041 (hereinafter referred to as 

the spectrum analyzer) provides the reference frequency for the synthesized signal generator1464C of which the 

low-frequency output is connected to the RF input of the spectrum analyzer (as shown in dotted line of Fig 11-1). 

2) Set the synthesized signal generator as follows: 【Freq】 [Low Frequency Generator Setting] [Frequency 

Setting] 9 kHz, [Amplitude Setting] -10 dBm, [Back], [Low Frequency Output On/Off]. 

3) Set the spectrum analyzer as follows: center frequency: 9 kHz, span: 1 kHz, reference level: 0 dBm, RBW 10 

Hz; other items are set automatically. When the Peak key on the spectrum analyzer is pressed down, the marker 

shall indicate to the maximum signal response, the marked amplitude value is free of significant fluctuation, and 

the signal is clearly distinguishable. The center frequency value at this time is the lower limit measurement value 

of frequency range. Compare this value with the corresponding value in the Performance Test Record Table of 

4041 Series Spectrum Analyzer (hereinafter referred to as "4041 Series Spectrum Analyzer Record Sheet"), and 

mark "√" for the consistent result and "×" for the non-consistent result. 

4) As shown in the solid line in Fig 11-1, connect the RF output of synthesized signal generator1464C to the RF 

input of spectrum analyzer with the adapter and cable. Set the output frequency of signal generator to the highest 

frequency of corresponding model of spectrum analyzer. Turn off the modulation function and set the output 

power at -10 dBm. 

5)  Set the spectrum analyzer as follows: center frequency: maximum value of corresponding model, span: 1 kHz, 

reference level: 0 dBm, RBW 10 Hz; other items are set automatically. When the Peak key on the spectrum 

analyzer is pressed down, the marker shall indicate to the maximum signal response, the marked amplitude value 

is free of significant fluctuation, and the signal is clearly distinguishable. The center frequency value at this time is 

the upper limit measurement value of frequency range. Compare this value with the corresponding value in the 

Performance Test Record table of 4041 Series Spectrum Analyzer  (hereinafter referred to as "4041 Series 

Spectrum Analyzer Record Sheet"), and mark "√" for the consistent result and "×" for the non-consistent result. 

11.2 Frequency readout accuracy 

Description: Frequency accuracy is used to characterize the closeness of the frequency measurement value of 

spectrum analyzer to the corresponding true value. The frequency measurement value of spectrum analyzer during 

the sweep is affected by the factors such as the reference frequency, span, RBW, etc. Test the frequency readout 
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accuracy of spectral analyzer with an input signal of a known frequency, which represents the degree of difference 

between the test value and true value. The smaller the difference is, the higher the accuracy is. 

A) Testing equipment 

Synthesized signal generator 1464C 

b) Adapter 

2.4 mm (f)-2.4 mm (f) adapter * 2 

c) Cable 

2.4 mm(m-m) cable (1) 

d) Test steps 

 Fig 11-2 Test block diagram of frequency readout accuracy 

1) Connect the test instrument as shown in Fig 11-2, and connect the RF output of signal generator to the RF input 

of spectrum analyzer. 

2) Press the reset button on the signal generator, set the output frequency f0 of the signal generator according to 

the “frequency readout accuracy” item in the 4041 Series Spectrum Analyzer Record Sheet and the power level at 

-10 dBm, and turn on the RF output switch. 

3) Set the spectrum analyzer as follows: center frequency: f0, span: 500 kHz, reference level: 0 dBm; the RBW, 

sweep time, etc. are set automatically. 

4) Press 【Peak】 on the spectrum analyzer to read the frequency fs of peak signal with marker. 

5) Calculate the frequency reading error Δf according to equation (1): 

Δf=fs-f0  （1） 

6) Record Δf as the test result in the corresponding item in the 4041 Series Spectrum Analyzer Record Sheet. 

7) Repeat the 2nd ~ 6th steps according to the combination of frequencies and spans in the 4041 Series Spectrum 

Analyzer Record Sheet. 

11.3 Span accuracy 

Description: Two signals of the known frequency provided by two synthesized signal generators are taken as the 

input to the spectrum analyzer. Set the center frequency of spectrum analyzer as the intermediate value of these 

two frequencies. Measure the frequency difference between these two signals with the marker function. Calculate 
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and record the percentage of error between the measured differential marker and the span. Two signal generators 

and spectrum analyzer shall share the common reference frequency. 

Note: The test may be conducted with a signal generator. First, set the center frequency and span of spectrum 

analyzer, set the frequency of signal generator as the value of first signal generator, set the differential marker on 

the spectrum analyzer, and then set the frequency of signal generator as the value of the second signal generator. 

Read the differential marker of two signals on the spectrum analyzer and record it as the measurement value. 

Signal generators and spectrum analyzer shall share the common reference frequency. 

A) Testing equipment 

Synthesized signal generator 1464C 

b) Adapter 

2.4 mm (f)-2.4 mm (f) adapter * 2 

c) Cable 

One BNC (m-m) cable 

2.4 mm (m-m) cable (1) 

d) Test steps 

Fig 11-3 Span Accuracy Testing Setup 

1) Connect the test instrument as shown in Fig 11-3. The spectrum analyzer provides a reference frequency for the 

synthetic signal generator. 

2) Set the spectrum analyzer as follows: center frequency f0: 22 GHz (10 GHz for 4041 D, 13.25 GHz for 4041 E, 

and 16 GHz for 4041 F), reference level: 0 dBm, span: according to the item "span accuracy" in the 4041 Series 

Spectrum Analyzer Record Sheet. 

3) First, set the output frequency of signal generator to f1 (f1= f0-0.4×span, i.e. the frequency span set by the 

spectrum analyzer), set the power to -10 dBm, and turn on the RF output. 

4) Press 【Peak】, 【Marker】, and [Detla] on the spectrum analyzer. 

5) Set the output frequency of signal generator to f2 (f2= f0+0.4×span) and the output power to -10 dBm. 

6) Press 【Peak】 button on the spectrum analyzer to set the differential marker to f2. After the sweep is completed, 

read the frequency difference Δf of two signals on the spectrum analyzer. 
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7) Record the frequency difference Δf and calculate the span accuracy as follows: 

Span accuracy = 100×[Δf-(0.8×span)]/(0.8×span)%   (2) 

Record the result in the corresponding item in the 4041 Series Spectrum Analyzer Record Sheet. 

8) Turn off all frequency markers, set the span of spectrum analyzer and the frequency of signal generator 

according to the span of spectrum analyzer in the record, and repeat steps 3 to 8 until all the span tests are 

completed. 

11.4 Sweep time 

Description: The amplitude modulation signal is displayed on the spectrum analyzer under a zero span, and the 

frequency of modulation signal is adjusted so that the peak intervals are uniformly distributed on the screen. 

Count the frequency of modulation signal and calculate the actual sweep time, and then compare it with the 

specified time to obtain the sweep time accuracy. The sweep time accuracy is guaranteed by design. To reduce the 

test time, the typical sweep time test is selected for verification. 

    Note: The synthesized signal generator and function generator may also be replaced by the synthesized signal 

generator with the built-in AM option. 

A) Testing equipment 

Synthesized signal generator  1464C 

Function generator Agilent 33250A 

b) Adapter 

2.4 mm (f)-2.4 mm (f) adapter * 2 

c) Cable  

BNC (m-m) cable * 2 

One 2.4 mm (m-m) cable 

d) Test steps 

Fig 11-4 Sweep Time Accuracy Testing Setup 

1) Connect the test device as shown in Fig 11-4. The output of function generator is connected to the amplitude 
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input of signal generator, and the RF output of signal generator is connected to the RF input of spectrum analyzer 

to be tested. The spectrum analyzer provides the reference frequency for the synthetic signal generator. 

2) Set the spectrum analyzer as follows: center frequency: 4 GHz, span : 0 Hz, RBW and VBW: 10 MHz, 

minimum settable sweep time: 10 μs, maximum settable sweep time: 600 s, if the above settings meet the 

requirements of the item "sweep time range (zero span)" in the 4041 Series Spectrum Analyzer Record Sheet, 

mark "√", or mark "×." 

3) After resetting the 1464C, set the frequency to 4 GHz and power to -5 dBm, [Modulation], [Amplitude 

Modulation] [Amplitude Input], [External], [Back], [Amplitude Modulation On/Off], and turn on the amplitude 

modulation switch and RF output switch. 

4) Make the following settings with soft keys on the Agilent 33250A: 【Ampt】, 1 [Vrms], [Offset] 0 [V], [Output], 

and set the output waveform to [RAMP]. 

5) Set the scale type of spectrum analyzer to linear and peak detection, RBW to 3 MHz, and VBW to 3 MHz. 

6) Set 【Freq】 on the Agilent 33250A to 10 [kHz]. Set the spectrum analyzer: [Sweep Time] 1 [Milliseconds], 

[Sweep Type Consecutive One-time]. 

7) Set the spectrum analyzer, press 【Peak】 and place the marker on the first peak from the left through [Next Pk 

Left] or [Next Pk Right]. Press 【Marker】 [Detla], press 【Peak】 and place the marker on the ninth peak from 

the left through [Next Pk Left] or [Next Pk Right]. Read the differential marker value and calculate as follows: 

Sweep time error = 100 × ((marker differential reading × 1.25 - preset sweep time) / preset sweep time)%   (3) 

Record the calculated data at 1ms sweep time of the corresponding item in the 4041 Series Spectrum Analyzer 

Record Sheet. 

8) Turn off the marker and repeat steps 6 to 7 for other sweep times listed in the record. Set the frequency in step 

6 as follows: 

Modulation rate = 10/setting of sweep time                           (4) 

11.5 RBW 

Description: The RBW indicates that the spectrum analyzer can clearly separate the two input signals. It is 

affected by factors such as IF filter bandwidth, phase noise, and sweep time. Most spectrum analyzers achieve the 

different RBWs with the different methods such as LC filter, crystal filter, SAW, digital filter, etc. 

The output of synthesized signal generator is connected to the RF input of spectrum analyzer. The bandwidth of 

spectrum analyzer 4041 is approximately set to 2 times the current RBW (to facilitate the measurement, 

bandwidth is subtracted by 3 dB). The output amplitude of tracking generator is reduced by 3 dB to determine the 

actual -3 dB point. After the marker reference is set, the output of tracking generator is increased by 3 dB back to 

the previous level, and then the sweep starts. The differential marker is used as a measurement value of 3 dB 

bandwidth 

The readings with the 3 dB bandwidth test function in the 4041 series can be used as test values. The error of span 

of 4041 series may introduce a certain error in the RBW accuracy. The error of span is negligible relative to the 
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error of RBW itself. 

A) Testing equipment 

Synthesized signal generator  1464C 

b) Adapter 

Two 2.4 mm (f)-2.4 mm (f) adapters 

c) Cable 

BNC (m-m) cable * 1 

One 2.4 mm (m-m) cable 

d) Test steps 

Fig 11-5 RBW Accuracy Testing Setup 

1) Connect the test instrument as shown in Fig 11-5. 1) The spectrum analyzer provides a reference frequency for 

the signal generator. 

2) Set the synthesized signal generator as follows: frequency: 100 MHz, power:-2 dBm and power step: 1 dB. 

3) Reset the spectrum analyzer and press the [measure] [OBW] key to turn on the measured bandwidth. The 

measurement method selects X dB and changes X to -3.01 dB. 

4) Set the spectrum analyzer as follows: center frequency: 100 MHz, span: 30 MHz, amplitude scale: 1 dB/div, 

RBW: 10 MHz, with other items as the system default settings. 

5) Adjust the output power of the synthesized signal generator to make the signal below the reference level by 2 to 

3 divisions. 

6) Search the peak for the 4041 series, records the 3 dB bandwidth marker differential reading Δf-3dB at this time, 

calculate the RBW accuracy δ as follows, and fills in the calculated results to the corresponding item in the 4041 

Series Spectrum Analyzer Record Sheet. 

  

3 100%dBf RBW

RBW
  
 

                                           (5) 

7) Set the spectrum analyzer according to the RBW listed in the item“RBW accuracy” in the4041 Series Spectrum 

Analyzer Record Sheet, set the bandwidth to approximately double the RBW, and repeat steps 6-7 until all RBW 

tests are completed. 
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11.6 RBW switching uncertainty 

Description: Connect the RF output of synthesized signal generator to the input of spectrum analyzer, and adjust 

the amplitude of output signal to make the signal below the spectrum analyzer reference level by 2 to 3 divisions. 

Fix the amplitude of synthesized signal generator and change the RBW of spectrum analyzer to make the 

difference between them equal to the RBW switching uncertainty. The RBW of spectrum analyzer 4041 is 1-3 

steps. 

A) Testing equipment 

Signal generator 1464C 

b) Adapter 

2.4 mm (f)-2.4 mm (f) adapter * 2 

c) Cable 

BNC (m-m) cable * 1 

2.4 mm (m-m) cable (1) 

d) Test steps 

Fig 11-6 RBW Switching Uncertainty Testing Setup 

1) Connect the test device as shown in Fig 11-6. The spectrum analyzer provides a reference frequency for the 

synthesized signal generator 1464C. 

2) Set up the spectrum analyzer as follows: 

Center frequency 2,000 MHz 

Span .......................................................................................................................................................... 10 MHz 

Logarithmic scale dB/div .......................................................................................................................... 1 dB 

RBW ......................................................................................................................................................... Auto 

RBW/VBW ............................................................................................................................................... 10 

SPAN/RBW .............................................................................................................................................. 100 

3) At this point, the RBW which is automatically associated with by spectrum analyzer is 100 kHz. Press 【Peak】 

on the spectrum analyzer to set the marker to the peak and at the differential mode. 
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4) Set the span of spectrum analyzer according to the resolution of corresponding item in the 4041 Series 

Spectrum Analyzer Record Sheet, and set the ratio between the span and RBW to 100. 

5) Search for the peak and read out the amplitude differential of marker, and record it in the 4041 Series Spectrum 

Analyzer Record Sheet as the current RBW conversion uncertainty 

6) Repeat the steps 4~5 until all RBWs are tested. 

11.7 Sideband noise 

Description: Sideband noise is an indicator of the short-term stability of the local oscillation signal frequency of 

spectrum analyzer. 

Measure the sideband noise of the reference signal (1.0 GHz, 0 dBm) at the offset carrier of 10 kHz, 100 kHz, 1 

MHz and 10 MHz. Average the sideband noises at various frequency offset points with the noise marker and 

video averaging function. In case of the spurious response at the set frequency offset, deviate the marker from the 

spurious response to ensure the accuracy of measurement. 

A) Testing equipment 

Synthesized signal generator 1464C 

b) Adapter 

Two 2.4 mm (f)-2.4 mm (f) adapters 

c) Cable  

BNC (m-m) cable * 1 

2.4 mm (m-m) cable (1) 

d) Test steps 

Fig 11-7 Diagram of sideband noise test 

1) Connect the test instrument as shown in Fig 11-7. The spectrum analyzer provides a reference frequency for 

the synthetic signal generator. 

2) Set the output frequency of signal generator to 1 GHz and the output power to 0 dBm; 

3) Set the spectrum analyzer as follows: 【Freq】 to 1 [GHz], [Span] to 30 [kHz], and 【Ampt】 [Ref Level] 

to 0[dBm]. 

4) Press 【Peak】, 【Marker】, [Detla] on the spectrum analyzer, set the differential marker to 10 kHz, and turn 
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on the noise marker function. 

5) Set the RBW and VBW according to Table 11-3, turn on the averaging function, and then conduct 10 

averaging operations. 

6) Record the differential marker amplitude at the corresponding measurement item in the 4041 Series 

Spectrum Analyzer Record Sheet as the sideband noise at the offset point of +10 kHz. 

7) Press 【Marker】 at -10 [kHz] on the spectrum analyzer. Record the differential marker amplitude at the 

corresponding test item in the 4041 Series Spectrum Analyzer Record Sheet as the sideband noise at the 

offset of -10 kHz. 

8) Set the spectrum analyzer according to Table 11-3 to test the single sideband noise at the offset of ±100 kHz, 

±1 MHz and ±10 MHz, and record the differential marker amplitude at the corresponding item in the 4041 

Series Spectrum Analyzer Record Sheet. In case of the spurious response at the frequency offset, avoid this 

spurious response when reading the marker value during the test. 

Table 11-3 Settings of sideband noise measurement 

Offset frequency Δf Span Resolution Bandwidth VBW and average 

±10 kHz 30 kHz 300 Hz VBW 30 Hz, averaging function 

On 

±100 kHz 300 kHz 3 kHz  VBW 300 Hz, averaging function 

On 

±1 MHz 2.2 MHz 10 kHz VBW 1 kHz, averaging function 

On 

±10 MHz 25 MHz 100 kHz VBW 10 kHz, averaging function 

On 

11.8 Displayed average noise level 

Description: The displayed average noise level refers to the background noise observed by the spectrum analyzer 

itself in the absence of external noise or signal. 

The input end of the spectrum analyzer is connected with a 50 matcher, and the normalized noise value observed 

when the input attenuation value is set to 0 dB is the test value of displayed average noise level. 

A) Testing equipment 

50Ω Matcher  70508 

b) Test steps 

1) Connect the 50 matcher to the RF input port of the spectrum analyzer as shown in Fig 11-8. 
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Fig 11-8 Displayed average noise level testing setup 

Displayed average noise, preamplifier on (2 MHz~10 MHz) 

2) Set up the spectrum analyzer as follows: 

Start frequency ............................................................................................................................................... 2 MHz 

End frequency .............................................................................................................................................. 10 MHz 

Reference level ........................................................................................................................................... -50 dBm 

Marker ................................................................................................................................................... Markers off 

Resolution bandwidth .................................................................................................................................... 1 MHz 

Video bandwidth ......................................................................................................................................... 100 kHz 

Preamplifier ......................................................................................................................................................... On 

Detection type ..............................................................................................................................................Average 

3) Press 【Marker】 [Marker Noise Off On], 【Peak】 [Maximum Value]. 

4) Press 【BW】 [Average On Off] 5 [Enter] and wait for completion of new sweep the average 5/5 appears on 

the left side of the screen. 

5) Read out the peak value where the marker locates as the displayed average noise level of the 2 MHz to 10 

MHz band when the preamplifier is on, and record it in the corresponding test item of "4041 Series Spectrum 

Analyzer Record Sheet". Disable the noise marker and averaging function. 

Displayed average noise, preamplifier on (10 MHz~4 GHz) 

6) Press 【Marker】 [Marker Noise Off On], 【Peak】 [Maximum Value]. 

7) Press 【BW】 [Average On Off] 5 [Enter] and wait for completion of new sweep the average 5/5 appears on 

the left side of the screen. 

8) Read out the peak value where the marker locates as the displayed average noise level of the 10 MHz to 4 

GHz band when the preamplifier is on, and record it in the corresponding test item of "4041 Series Spectrum 

Analyzer Record Sheet". Disable the noise marker and averaging function. 

Displayed average noise, preamplifier on (4 GHz~6 GHz) 

9) Set the start frequency of the 4041 series spectrum analyzer to 4 GHz and the stop frequency to 6 GHz, with 

others left unchanged. 

10) Repeat step 3 to step 4. 
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11) Read out the peak value where the marker locates as the displayed average noise level of the 4 GHz to 6 GHz 

band when the preamplifier is on, and record it in the corresponding test item of "4041 Series Spectrum 

Analyzer Record Sheet". Disable the noise marker and averaging function. 

Displayed average noise, preamplifier on (6 GHz~20 GHz) 

12) Set the start frequency of the 4041 series spectrum analyzer to 6 GHz and the stop frequency to 20 GHz, with 

others left unchanged. 

13) Repeat step 3 to step 4. 

14) Read out the peak value where the marker locates as the displayed average noise level of the 6 GHz to 20 

GHz band when the preamplifier is on, and record it in the corresponding test item of "4041 Series Spectrum 

Analyzer Record Sheet". Disable the noise marker and averaging function. 

Displayed average noise, preamplifier on (20 GHz~32 GHz) 

15) Set the start frequency of the 4041 series spectrum analyzer to 20 GHz and the stop frequency to 32 GHz, 

with others left unchanged. 

16) Repeat step 3 to step 4. 

17) Read out the peak value where the marker locates as the displayed average noise level of the 20 GHz to 32 

GHz band when the preamplifier is on, and record it in the corresponding test item of "4041 Series Spectrum 

Analyzer Record Sheet". Disable the noise marker and averaging function. 

Displayed average noise, preamplifier on (32 GHz~40 GHz) 

18) Set the start frequency of the 4041 series spectrum analyzer to 32 GHz and the stop frequency to 40 GHz, 

with others left unchanged. 

19) Repeat step 3 to step 4. 

20) Read out the peak value where the marker locates as the displayed average noise level of the 32 GHz to 40 

GHz band when the preamplifier is on, and record it in the corresponding test item of "4041 Series Spectrum 

Analyzer Record Sheet". Disable the noise marker and averaging function. 

Displayed average noise, preamplifier on (40 GHz~44 GHz) 

21) Set the start frequency of the 4041 series spectrum analyzer to 40 GHz and the stop frequency to 44 GHz, 

with others left unchanged. 

22) Repeat step 3 to step 4. 

23) Read out the peak value where the marker locates as the displayed average noise level of the 40 GHz to 44 

GHz band when the preamplifier is on, and record it in the corresponding test item of "4041 Series Spectrum 

Analyzer Record Sheet". Disable the noise marker and averaging function. 

Displayed average noise, preamplifier off (2 MHz~10 MHz) 

24) Set the start frequency of the 4041 series spectrum analyzer to 2 MHz, the stop frequency to 10 MHz, the 

reference level to -20 dBm, and the preamplifier \OFF, with others left unchanged. 
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25) Repeat step 3 to step 4. 

26) Read out the peak value where the marker locates as the displayed average noise level of the 2 MHz to 10 

MHz band when the preamplifier is off, and record it in the corresponding test item of "4041 Series Spectrum 

Analyzer Record Sheet". Disable the noise marker and averaging function. 

Displayed average noise, preamplifier off (10 MHz~4 GHz) 

27) Set the start frequency of the 4041 series spectrum analyzer to 10 MHz, the stop frequency to 4 GHz, the 

reference level to -20 dBm, and the preamplifier \OFF, with others left unchanged. 

28) Repeat step 3 to step 4. 

29) Read out the peak value where the marker locates as the displayed average noise level of the 10 MHz to 4 

GHz band when the preamplifier is off, and record it in the corresponding test item of "4041 Series Spectrum 

Analyzer Record Sheet". Disable the noise marker and averaging function. 

Displayed average noise, preamplifier off (4 GHz~6 GHz) 

30) Set the start frequency of the 4041 series spectrum analyzer to 4 GHz, the stop frequency to 6 GHz, the 

reference level to -20 dBm, and the preamplifier \OFF, with others left unchanged. 

31) Repeat step 3 to step 4. 

32) Read out the peak value where the marker locates as the displayed average noise level of the 4 GHz to 6 GHz 

band when the preamplifier is off, and record it in the corresponding test item of "4041 Series Spectrum 

Analyzer Record Sheet". Disable the noise marker and averaging function. 

Displayed average noise, preamplifier off (6 GHz~20 GHz) 

33) Set the start frequency of the 4041 series spectrum analyzer to 6 GHz, the stop frequency to 20 GHz, the 

reference level to -20 dBm, and the preamplifier \OFF, with others left unchanged. 

34) Repeat step 3 to step 4. 

35) Read out the peak value where the marker locates as the displayed average noise level of the 6 GHz to 20 

GHz band when the preamplifier is off, and record it in the corresponding test item of "4041 Series Spectrum 

Analyzer Record Sheet". Disable the noise marker and averaging function. 

Displayed average noise, preamplifier off (20 GHz~32 GHz) 

36) Set the start frequency of the 4041 series spectrum analyzer to 20 GHz, the stop frequency to 32 GHz, the 

reference level to -20 dBm, and the preamplifier \OFF, with others left unchanged. 

37) Repeat step 3 to step 4. 

38) Read out the peak value where the marker locates as the displayed average noise level of the 20 GHz to 32 

GHz band when the preamplifier is off, and record it in the corresponding test item of "4041 Series Spectrum 

Analyzer Record Sheet". Disable the noise marker and averaging function. 

Displayed average noise, preamplifier off (32 GHz~40 GHz) 

39) Set the start frequency of the 4041 series spectrum analyzer to 32 GHz, the stop frequency to 40 GHz, the 
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reference level to -20 dBm, and the preamplifier \OFF, with others left unchanged. 

40) Repeat step 3 to step 4. 

41) Read out the peak value where the marker locates as the displayed average noise level of the 32 GHz to 40 

GHz band when the preamplifier is off, and record it in the corresponding test item of "4041 Series Spectrum 

Analyzer Record Sheet". Disable the noise marker and averaging function. 

Displayed average noise, preamplifier off (40 GHz~44 GHz) 

42) Set the start frequency of the 4041 series spectrum analyzer to 40 GHz, the stop frequency to 44 GHz, the 

reference level to -20 dBm, and the preamplifier \OFF, with others left unchanged. 

43) Repeat step 3 to step 4. 

44) Read out the peak value where the marker locates as the displayed average noise level of the 40 GHz to 44 

GHz band when the preamplifier is off, and record it in the corresponding test item of "4041 Series Spectrum 

Analyzer Record Sheet". Disable the noise marker and averaging function. 

11.9 Second harmonic distortion 

Description: When the signal is input into a nonlinear device (such as a mixer, amplifier, etc.), the nonlinear 

device will generate the harmonics of the input signal, and the unwanted second harmonic component attached to 

the signal is called the second harmonic distortion. 

The synthesized signal generator provides a signal to the spectrum analyzer to measure the second harmonic 

distortion via a low pass filter. The low pass filter is used to eliminate any harmonic distortion from the signal 

source. The spectrum analyzer provides a 10 MHz reference frequency for the synthesized signal generator. 

A) Testing equipment 

Synthesized signal generator  1464C 

1.0 GHz low pass filter * 1 

6.8 GHz low pass filter * 1 

18 GHz low pass filter * 1 

b) Adapter 

2.4 mm (f)-3.5 mm (f) adapter * 1 

2.4 mm (f)-3.5 mm (m) adapter * 1 

3.5 mm (f)-3.5 mm (f) adapter * 1 

c) Cable 

BNC (m-m) cable * 1 

3.5 mm (m-m) cable * 1 

d) Test steps 
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Fig 11-9 Second harmonic distortion testing setup 

Second harmonic distortion (4 GHz) 

1) Connect the test instrument as shown in Fig 11-9. The spectrum analyzer provides a 10 MHz reference 

frequency for the synthesized signal generator and the 1 GHz low pass filter is used. 

2) Set the frequency of 1464C to 900 MHz, the amplitude to -30 dBm, and the RF output on. 

3) Set up the spectrum analyzer as follows: 

Center frequency 900 MHz 

Span 200 Hz 

Reference level -30 dBm 

4) Press 【Peak】 on the spectrum analyzer. Adjust the power level of 1464C so that the reading of spectrum 

analyzer is -30 dBm0.1 dB. 

5) Press 【Marker】 [" Differential Mode] to set the center frequency to 1.8 GHz. 

6) Press 【Peak】 after the spectrum analyzer completes a new sweep. Record the differential marker reading in 

the corresponding test item of the "4041 Series Spectrum Analyzer Record Sheet" as the second harmonic 

distortion value (4 GHz). 

Second harmonic distortion (4 GHz~10 GHz) 

7) Connect the test instrument as shown in Fig 11-9 and use a 6.8 GHz low pass filter. 

8) Set the frequency of 1464C to 6 GHz and its amplitude to -30 dBm. 

9) Set up the spectrum analyzer as follows: 

Center frequency 6 GHz 

Span ........................................................................................................................................................ 200 Hz 

Amplitude ............................................................................................................................................. -30 dBm 

Marker ............................................................................................................................................. Markers off 

10) Press 【Peak】 on the spectrum analyzer. Adjust the power level of 1464C so that the reading of spectrum 
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analyzer is -30 dBm0.1 dB. 

11) Press 【Marker】 [" Differential Mode] to set the center frequency to 12 GHz. 

12) Wait for completion of new sweep, and then press 【Peak】. Record the differential marker reading in the 

corresponding test item of the "4041 Series Spectrum Analyzer Record Sheet" as the second harmonic 

distortion value from 4 GHz to 10 GHz. 

Second harmonic distortion (10 GHz~22 GHz) 

13) Connect the test instrument as shown in Fig 11-9 and use a 18 GHz low pass filter. 

14) Set the frequency of 1464C to 18 GHz and its amplitude to -30 dBm. 

15) Set up the spectrum analyzer as follows: 

Center frequency 18 GHz 

Span ............................................................................................................................................................ 200 Hz 

Amplitude ................................................................................................................................................. -30 dBm 

Marker ................................................................................................................................................. Markers off 

16) Press 【Peak】 on the spectrum analyzer. Adjust the power level of 1464C so that the reading of spectrum 

analyzer is -30 dBm0.1 dB. 

17) Press 【Marker】 [" Differential Mode] to set the center frequency to 36 GHz. 

18) Wait for completion of new sweep, and then press 【Peak】. Record the differential marker reading in the 

corresponding test item of the "4041 Series Spectrum Analyzer Record Sheet" as the second harmonic 

distortion value from 10 GHz to 22 GHz. 

11.10 Third-order intermodulation distortion 

Description:  Third-order intermodulation distortion refers to the unwanted frequency components generated by 

the interaction of the spectral components of two or more input signals under the effect of non-linearity of 

instruments. 

Two synthesized signal generators generate two sine wave signals with frequency space of 100 kHz and with the 

same power, and input them into the spectrum analyzer at the same time. The third-order intermodulation 

distortion products is then measured indirectly through the marker function of the spectrum analyzer. The filter is 

used to filter out the signal distortion product that is closest to the one being measured. The spectrum analyzer 

provides a 10 MHz reference frequency for the synthesized signal generator. 

Note: If the output of signal generator #1 and signal generator #2 is subject to the load-pull effect and thus the test 

result is to be effected, a pair of isolators corresponding to the measurement frequency band can be added to the 

output ends of signal generators #1 and #2 respectively to reduce the impact on the test results of third-order 

intermodulation distortion. 

A) Testing equipment 
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Power meter ML2437A 

Power sensor ............................................................................................................................................ MA2445D 

Synthesized signal generator#1 ..................................................................................................................... 1464C 

Synthetic signal generator #2 ............................................................................................................................ 1461 

Millimeter wave directional coupler ............................................................................................................... 70603 

RF directional coupler .................................................................................................................................... 70607 

1.0 GHz low pass filter * 2 

6.8 GHz low pass filter * 2 

18 GHz low pass filter * 2 

b) Adapter 

2.4 mm (f)-2.4 mm (f) adapter * 2 

3.5 mm (m)-3.5 mm (m) adapter * 2 

2.4 mm (f)-3.5 mm (f) adapter * 2 

2.4 mm (f)-3.5 mm (m) adapter * 1 

BNC T type (m) (f) (f) adapter * 1 

c) Cable 

BNC (m-m) cable * 2 

2.4 mm (m-m) cable * 2 

3.5 mm (m-m) cable * 2 

d) Test steps 
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Fig 11-10 Third-Order Intermodulation Distortion Testing Setup (50 MHz~4 GHz) 

Third-order intermodulation distortion (50 MHz~4 GHz) 

1) Connect the instrument as shown in Fig 11-10. As shown in the Fig, use the RF directional coupler, and 

select the appropriate low pass filter and adapter according to the test frequency. Do not connect the 

directional coupler to the spectrum analyzer. 

2) Set the frequency of the synthesized signal generator #1 to 900 MHz, the amplitude to 0 dBm, and the RF 

output on. 

3) After the synthesized signal generator #2 is reset, set its frequency to 900.1 MHz, the amplitude to -110 dBm, 

and the RF output off. 

4) Connect the power meter ML2437A and the power sensor MA2445D, and zero them. Set the frequency of 

the power meter to 900 MHz. 

5) Set up the spectrum analyzer as follows (for other settings, the defaults apply): 

Center frequency ................................................................................................................................ 900 MHz 

Frequency step .................................................................................................................................... 100 kHz 

Span ........................................................................................................................................................ 1 kHz 

Reference level ................................................................................................................................... -10 dBm 

6) Connect the power sensor to the output of the RF directional coupler with an adapter instead of a cable. 

7) Adjust the output amplitude of synthesized signal generator #1 so that the reading of power meter is close to 

-15 dBm. 

8) Remove the power sensor from the RF directional coupler. Use an adapter to connect the RF directional 
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coupler directly to the RF input port of the spectrum analyzer. 

9) Press 【Peak】 on the spectrum analyzer and wait for completion of a new sweep. Press 【Marker】 [Detla], 

【Freq】 【↑】. 

10) Turn on the RF output of the synthesized signal generator #2, and set the power to –15 dBm. 

11) Press 【Peak】 on the spectrum analyzer. 

12) Adjust the power level of synthesized signal generator #2 so that the differential marker reading of the 

spectrum analyzer approaches 0 dB. 

13) Press 【Marker】 [Detla], 【Freq】 【↓】 【↓】 on spectrum analyzer. Wait for completion of new sweep. 

Press 【BW】 [Average On] 5 [Enter]. Wait for the video is averaged 5 times, and press 【Peak】. 

14) The peak-marker reading of spectrum analyzer is the low-end third-order intermodulation distortion product 

△A. According to the third-order intermodulation distortion product, the third-order intercept point is 

calculated as follows (where L0 is the level of mixer): 

0
2

A
TOI L


                                               (6) 

15) On the spectrum analyzer, press 【Freq】 【↑】 【↑】 【↑】, wait for completion of new sweep, and then 

press 【Peak】. 

16) The marker difference at this time is the high-end intermodulation distortion product. Calculate the 

third-order intercept point according to Equation 6 and compare the high-end intermodulation distortion 

product with the low-end intermodulation distortion product. Record the smaller value as the final test result 

in the corresponding test item in the “4041 Series Spectrum Analyzer Record Sheet”. 
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Fig 11-11 Third-Order Intermodulation Distortion Testing Setup (4 GHz to 44 GHz) 

Third-order intermodulation distortion (4 GHz~13 GHz) 

17) Connect the instrument as shown in Fig 11-11. Replace the RF directional coupler with millimeter wave 

directional coupler, and select the appropriate low pass filter and adapter according to the test frequency. Do 

not connect the directional coupler to the spectrum analyzer. 

18) Set the frequency of synthesized signal generator #1 to 6 GHz, the amplitude to 0 dBm, and the RF output 

on. 

19) Set the frequency of synthesized signal generator #2 to 6.0001 GHz, the amplitude to -110 dBm, and the RF 

output off. 

20) Set the frequency of the calibration factor of the power meter to 6 GHz. 

21) Disable the difference marker function of the spectrum analyzer and set the center frequency to 6 GHz, with 

other settings left unchanged. 

22) Repeat steps 6~16. 

Third-order intermodulation distortion (13 GHz~44 GHz) 

23) Connect the instrument as shown in Fig 11-11. Replace the RF directional coupler with millimeter wave 

directional coupler, and select the appropriate low pass filter and adapter according to the test frequency. Do 

not connect the directional coupler to the spectrum analyzer. 

24) Set the frequency of the synthesized signal generator #1 to 15 GHz and amplitude to 0 dBm. 

25) Set the frequency of synthesized signal generator #2 to 15.0001 GHz, the amplitude to -110 dBm, and the RF 

output off. 
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26) Set the frequency of the calibration factor of the power meter to 15 GHz. 

27) Disable the difference marker function of the spectrum analyzer and set the frequency to 15 GHz, with other 

settings left unchanged. 

28) Repeat steps 6~16. 

11.11 1dB gain compression 

Description: When the input signal level increases, the unit circuits of such devices as spectrum analyzer mixer, 

amplifier, etc., can work near the saturation point. At this time, the output signal component no longer changes 

linearly with the input signal. Usually, the input level corresponding to output 1dB lower than linear value is used 

to represent 1 dB compression point. 

This test measures the gain compression of the spectrum analyzer with two signals spaced by 10 MHz. During the 

test, input a small signal to the spectrum analyzer (below -10 dBm) at first. Then input the specified large 

amplitude signal into the spectrum analyzer. The reduction in the amplitude of the first signal caused by the 

second signal is the measured gain compression. 

A) Testing equipment 

Power meter ............................................................................................................................................... ML2437A 

Power sensor .............................................................................................................................................. MA2445D 

Synthesized signal generator#1 ....................................................................................................................... 1464C 

Synthetic signal generator #2 .............................................................................................................................. 1461 

RF directional coupler ...................................................................................................................................... 70607 

Millimeter wave directional coupler ................................................................................................................. 70603 

b) Adapter 

2.4 mm (f)- 2.4 mm (f) adapter  * 2 

BNC T type (m) (f) (f) adapter  * 1 

2.4 mm (f)-3.5 mm (m) adapter * 2 

c) Cable 

BNC (m-m) cable * 2 

2.4 mm (m-m) cable * 2 

d) Test steps 
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Fig 11-12 1 dB gain compression test block diagram 

1 dB gain compression (50 MHz~4 GHz) 

1) Connect the power meter ML2437A and the power sensor MA2445D, and zero them. 

2) Connect the test instrument with cable as shown in Fig 11-12. The spectrum analyzer provides a reference 

frequency for the two signal sources, and the RF directional coupler is used. 

3) After the synthesized signal generator #2 is reset, set its frequency to 2 GHz, the power to 0 dBm, and the 

external reference and RF output ON. 

4) After the synthesized signal generator #1 is reset, set its frequency to 2.01 GHz, the power to -10 dBm, and 

the external reference and RF output OFF. 

5) Set the spectrum analyzer as follows (for other settings, the defaults apply): 

Center frequency ............................................................................................................................................ 2 GHz 

Span ................................................................................................................................................................ 1 kHz 

Reference level ........................................................................................................................................... -10 dBm 

Logarithmic scale ....................................................................................................................................... 1 dB/div 

6) Adjust the output power level of synthesized signal generator #2 to make the peak value of the signal 2-3 

divisions below the 4041 reference level. 

7) Press 【Peak】 【Marker】 [Difference Mode] on the 4041, and activate the Difference Marker function. 

8) Turn on the RF output of synthesized signal generator #1. Adjust the output power level of synthesized signal 

generator #1 until the differential marker reading is close to -1 dB. Turn off the output of synthesized signal 

generator #2. 

9) Disconnect the output of RF directional coupler from the 4041. Connect it with the power sensor as shown 

by the dashed line in Fig 11-12. Set the frequency of the calibration factor of power meter to 2 GHz. At this 

time, the reading of power meter is the 1 dB compression point at 50 MHz to 4 GHz band. Record it as test 
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result in the "4041 Series Spectrum Analyzer Record Sheet". 

1dB gain compression (4 GHz~13 GHz) 

10) Connect the test instrument as shown in Fig 11-12. As shown in the Fig, a millimeter wave directional 

coupler is used. Set the center frequency of 4041 to 9 GHz and the frequency of synthesized signal generator 

#1 to 9.01 GHz, and the frequency of synthesized signal generator #2 to 9 GHz. 

11) Set the calibration factor frequency of power meter to 9 GHz. 

12) Repeat steps 6~8. 

13) Disconnect the output of millimeter wave directional coupler from the 4041. Connect it with the power 

sensor as shown by the dashed line in Fig 11-12. At this time, the reading of power meter is the 1 dB 

compression point at 4 GHz to 13 GHz band. Record it as test result in the "4041 Series Spectrum Analyzer 

Record Sheet". 

1dB gain compression (13 GHz~44 GHz) 

14) Connect the test instrument as shown in Fig 11-12. As shown in the Fig, a millimeter wave directional 

coupler is used. Set the center frequency of 4041 D/E/F/G to 18 GHz, the frequency of synthesized signal 

generator #1 to 18.01 GHz, and the frequency of synthesized signal generator #2 to 18 GHz. 

15) Set the calibration factor frequency of power meter to 18 GHz. 

16) Repeat steps 6~8. 

17) Disconnect the output of millimeter wave directional coupler from the 4041. Connect it with the power 

sensor as shown by the dashed line in Fig 11-12. At this time, the reading of power meter is the 1 dB 

compression point at 13 GHz to 44 GHz band. Record it as test result in the "4041 Series Spectrum Analyzer 

Record Sheet". 

11.12 Image, Multiple, and Out-of-band Responses 

Description: In the frequency mixing process, two input signals can mix with the same signal of the local 

oscillator and generate IF signals of the same frequency. The frequency of one signal is lower than the signal of 

local oscillator by one intermediate frequency, and the frequency of the other signal is higher than the signal of 

local oscillator by one intermediate frequency. In such a condition, one signal is called the image of the other 

signal. For each frequency of the local oscillator, each input signal has an image, and the frequencies of signal and 

mirror differ by twice intermediate frequency. 

Test the image, multiple and out-of-band responses on all frequency bands. Apply the signal to the input port of 

the spectrum analyzer for measurement of reference amplitude. Then, tune the synthesized signal generator to a 

frequency that can cause image, multiple or out-of-band responses, and then measure the amplitude, and record 

the amplitude displayed on the spectrum analyzer. 

A) Testing equipment 

Synthesized signal generator  1464C 

b) Adapter 
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2.4 mm (f)-2.4 mm (f) adapters * 2 

c) Cable 

BNC (m-m) cable  * 1 

2.4 mm (m-m) cable * 1 

d) Test steps 

Fig 11-13 Image, Multiple, and Out-of-band Response Testing setup 

1)  Connect the test instrument as shown in Fig 11-13. The spectrum analyzer provides a reference frequency 

for the synthesized signal source. 

2)  Sets the frequency of 1464C to 2 GHz, and power to -10 dBm. 

3) Set up the spectrum analyzer as follows: 

Center frequency .......................................................................................................................................... 2 GHz 

Span ............................................................................................................................................................ 10 kHz 

Reference level ......................................................................................................................................... -10 dBm 

Resolution bandwidth ................................................................................................................................... 10 Hz 

Video bandwidth ........................................................................................................................................... 10 Hz 

4) Adjust the output power level of synthesized signal generator so that the peak value of the signal close to the 

reference level of the spectrum analyzer. 

5) Press 【Peak】 【Marker】 [Detla] on the spectrum analyzer. 

6) Set the 1464C to each frequency point where image, multi and out-of-band responses can occur at 2GHz in 

the corresponding test item listed in the “4041 Series Spectrum Analyzer Record Sheet”. Set the reference 

level of spectrum analyzer to -40 dBm and the resolution bandwidth to10Hz. Press 【Peak】, and record the 

differential marker amplitude as the response amplitude in the corresponding test item of the “4041 Series 

Spectrum Analyzer Record Sheet. 

7) For the image, multiple, and out-of-band responses of the remaining frequency points listed in the "4041 

Series Spectrum Analyzer Record Sheet", refer to steps 2 to 6 for testing until all frequency points have been 

tested. 
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11.13 Residual response 

Description: The residual response is the discrete response observed on the display when the spectrum analyzer 

doesn’t receive input signals. 

a) Test device 

50  Matched load 

b) Test steps 

Fig 11-14 Residual Response Testing Setup 

Residual response, 10 MHz~20 GHz (preamplifier on) 

1) Connect the test device according to Fig 11-14. Connect the 50  matcher with the signal input port of the 

spectrum analyzer, and set the spectrum analyzer as follows: 

Center frequency .................................................................................................................................. 65 MHz 

Frequency step ................................................................................................................................... 100 MHz 

Span ................................................................................................................................................... 110 MHz 

Reference level ................................................................................................................................... -50 dBm 

Preamplifier ................................................................................................................................................. On 

Resolution bandwidth ........................................................................................................................... 10 kHz 

Video bandwidth ..................................................................................................................................... 3 kHz 

2) Activate the limit line function and set the upper limit line at -100 dbm. The noise level shall be at least 5 dB 

below the limit line. If not, it is necessary to reduce the noise level by reducing the resolution BW and video 

BW. 

3) Observe whether there is residual response signal on the noise baseline of the spectrum analyzer. If there is 

residual response signal, read the residual response amplitude with the marker and record the measurement 

results. During the test, make the residual response signal amplitude 10 dB higher than the displayed average 

noise level at least. If the residual response signal amplitude is smaller, further reduce the resolution BW to 

reduce the displayed average noise level. 

4) Change the center frequency according to [Frequency [Center Freq] 【↑】. Repeat step 3 Check the residual 

response of the frequency to 20 GHz, and record the tested maximum response value in the measurement 

result of the corresponding test item in the 4041 Series Spectrum Analyzer Record Sheet. 

Residual response, 20 GHz~44 GHz (preamplifier on) 

50 Matcher 

Spectrum 
Analyzer 
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5) Set up the spectrum analyzer as follows: 

Center frequency ................................................................................................................................20.055 GHz 

Frequency step ....................................................................................................................................... 100 MHz 

Span ....................................................................................................................................................... 110 MHz 

Reference level ....................................................................................................................................... -50 dBm 

Preamplifier ..................................................................................................................................................... On 

Resolution bandwidth ............................................................................................................................... 10 kHz 

Video bandwidth ......................................................................................................................................... 3 kHz 

6) Activate the limit line function and set at -95 dBm. The noise level shall be at least 5 dB below the limit line. 

If not, it is necessary to reduce the noise level by reducing the resolution BW and video BW. 

7) Observe whether there is residual response signal on the noise baseline of the spectrum analyzer. If there is 

residual response signal, read the residual response amplitude with the marker and record the measurement 

results. During the test, make the residual response signal amplitude 10 dB higher than the displayed average 

noise level at least. If the residual response signal amplitude is smaller, further reduce the resolution BW to 

reduce the displayed average noise level. 

8) Change the center frequency according to [Frequency [Center Freq] 【↑】. Repeat step 7 Check the residual 

response of the frequency to 44 GHz, and record the tested maximum response value in the measurement 

result of the corresponding test item in the 4041 Series Spectrum Analyzer Record Sheet. 

Residual response, 10 MHz~13 GHz (preamplifier off) 

9) Set up the spectrum analyzer as follows: 

Center frequency .......................................................................................................................................... 65 MHz 

Frequency step ........................................................................................................................................... 100 MHz 

Span ........................................................................................................................................................... 110 MHz 

Reference level ........................................................................................................................................... -20 dBm 

Preamplifier ........................................................................................................................................................ Off 

Resolution bandwidth ................................................................................................................................... 10 kHz 

Video bandwidth ............................................................................................................................................. 3 kHz 

10) Activate the limit line function and set the limit at -90 dBm. The noise level shall be at least 5 dB below the 

limit line. If not, it is necessary to reduce the noise level by reducing the resolution BW and video BW. 

11) Observe whether there is residual response signal on the noise baseline of the spectrum analyzer. If there is 

residual response signal, read the residual response amplitude with the marker and record the measurement 

results. During the test, make the residual response signal amplitude 10 dB higher than the displayed average 

noise level at least. If the residual response signal amplitude is smaller, further reduce the resolution BW to 



Chapter XI Performance Characteristics Test 

163 

reduce the displayed average noise level. 

12) Change the center frequency according to [Frequency [Center Freq] 【↑】. Repeat step 11. Check the residual 

response of the frequency to 13 GHz when the preamplifier is off, and record the tested maximum response 

value in the corresponding test item in the 4041 Series Spectrum Analyzer Record Sheet. 

Residual response, 13 GHz~20 GHz (preamplifier off) 

13) Set up the spectrum analyzer as follows: 

Center frequency ....................................................................................................................................13.055 GHz 

Frequency step ........................................................................................................................................... 100 MHz 

Span ........................................................................................................................................................... 110 MHz 

Reference level ........................................................................................................................................... -20 dBm 

Preamplifier ........................................................................................................................................................ Off 

Resolution bandwidth ................................................................................................................................... 10 kHz 

Video bandwidth ............................................................................................................................................. 3 kHz 

14) Activate the limit line function and set the limit at -85 dBm. The noise level shall be at least 5 dB below the 

limit line. If not, it is necessary to reduce the noise level by reducing the resolution BW and video BW. 

15) Observe whether there is residual response signal on the noise baseline of the spectrum analyzer. If there is 

residual response signal, read the residual response amplitude with the marker and record the measurement 

results. During the test, make the residual response signal amplitude 10 dB higher than the displayed average 

noise level at least. If the residual response signal amplitude is smaller, further reduce the resolution BW to 

reduce the displayed average noise level. 

16) Change the center frequency according to [Frequency [Center Freq] 【↑】. Repeat step 15. Check the residual 

response of the frequency to 20 GHz when the preamplifier is off, and record the tested maximum response 

value in the corresponding test item in the 4041 Series Spectrum Analyzer Record Sheet. 

       Residual response, 20 GHz~44 GHz (preamplifier off) 

17) Set up the spectrum analyzer as follows: 

Center frequency ....................................................................................................................................20.055 GHz 

Frequency step ........................................................................................................................................... 100 MHz 

Span ........................................................................................................................................................... 110 MHz 

Reference level ........................................................................................................................................... -20 dBm 

Preamplifier ........................................................................................................................................................ Off 

Resolution bandwidth ................................................................................................................................... 10 kHz 

Video bandwidth ............................................................................................................................................. 3 kHz 
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18) Activate the limit line function and set the limit at -80 dBm. The noise level shall be at least 5 dB below the 

limit line. If not, it is necessary to reduce the noise level by reducing the resolution BW and video BW. 

19) Observe whether there is residual response signal on the noise baseline of the spectrum analyzer. If there is 

residual response signal, read the residual response amplitude with the marker and record the measurement 

results. During the test, make the residual response signal amplitude 10 dB higher than the displayed average 

noise level at least. If the residual response signal amplitude is smaller, further reduce the resolution BW to 

reduce the displayed average noise level. 

20) Change the center frequency according to [Frequency [Center Freq] 【↑】. Repeat step 19. Check the residual 

response of the frequency to 44 GHz when the preamplifier is off, and record the tested maximum response 

value in the corresponding test item in the 4041 Series Spectrum Analyzer Record Sheet. 

11.14 Reference level 

Description: The calibrated vertical scale position on the screen of the spectrum analyzer is used as a reference 

for amplitude measurement, and the reference level usually indicates the top division of the scale. The switch of 

the reference level can cause gain/attenuation linkage. The reference level switch error is used to evaluate the 

error of the switch gain of the spectrum analyzer. 

A) Testing equipment 

Signal generator ............................................................................................................................................. 1464C 

Power meter ............................................................................................................................................. ML2437A 

Power sensor ............................................................................................................................................ MA2445D 

Power divider .................................................................................................................................................. 81313 

b) Adapter 

2.4 mm (f)-2.4 mm (f) adapter * 1 

c) Cable 

BNC (m-m) cable * 1 

2.4 mm (m-m) cable * 1 

d) Test steps 
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Fig 11-15 Reference Level Uncertainty and Scale Fidelity Testing Setup 

1) Connect the power meter ML2437A and the power probe MA2445D and zero them, and set the calibration 

factor frequency to 50 MHz. 

2) Connect the test device according to Fig 15. The spectrum analyzer provides the reference frequency for the 

synthesized signal generator 1464C, and the output of the signal generator is connected to the spectrum 

analyzer and the power probe respectively through the power divider. 

3) Set the 【Ampt】 [Ref Level] on 4041 series, and use the knob or step key 【↑】 【↓】. If the maximum 

reference level can be set to +30 dBm and the minimum reference level can be set to -120 dBm, the 

specifications of the reference level range meet the requirements. In this case, mark “√” in the 4041 Series 

Handheld Spectrum Analyzer Record, otherwise, mark “×” in the test result column. 

4) Set the output frequency of 1464C to 50 MHz, and adjust the output frequency to make the power meter 

reading be -3 dBm0.05 dB. 

5) Set the spectrum analyzer as follows: 

Center frequency .......................................................................................................................................... 50 MHz 

Reference level .............................................................................................................................................. 0 dBm 

Span ................................................................................................................................................................ 1 kHz 

Logarithmic scale dB/div .................................................................................................................................. 1 dB 

Resolution bandwidth ..................................................................................................................................... 10 Hz 

6) Adjust the output amplitude of 1464C to make the signal 2-3 divisions below the reference level of the 

spectrum analyzer. 

7) Press 【Peak】 【Marker】 [Detla] on the spectrum analyzer. 

8) Press 【↓】 key on 1464C once. 

9) Set the reference level of the spectrum analyzer to the reference level listed in the 4041 Series Spectrum 

Analyzer Record Sheet; wait for completion of sweep, and press 【Peak】. 
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2.4 mm cable 
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10) Record the differential marker amplitude reading of the spectrum analyzer; carry out the following 

calculation (reading of the differential marker amplitude of the spectrum analyzer - current set reference 

level), and record the calculated value as the current reference level uncertainty in the corresponding test item 

of the 4041 Series Spectrum Analyzer Record Sheet. 

11) For remaining settings of the residual reference level of the spectrum analyzer listed in the corresponding test 

item of the 4041 Series Spectrum Analyzer Record Sheet, repeat steps 7~9. 

11.15 Scale fidelity 

Description: The scale fidelity is the error between the vertical scale and the theoretical value on the screen of the 

spectrum analyzer, which is used to evaluate the linearity of the analog-digital converter of the spectrum analyzer. 

Test the scale fidelity under conditions of 10 dB/division, and test with the resolution BW set to 10 Hz and the 

start amplitude of the input signal at 0 dBm reference level. When the signal amplitude is reduced, the displayed 

signal amplitude is compared with the reference level. The spectrum analyzer provides 10 MHz reference 

frequency for the signal generator. 

A) Testing equipment 

Signal generator ........................................................................................................................................... 1464C 

Power meter ........................................................................................................................................... ML2437A 

Power sensor .......................................................................................................................................... MA2445D 

Power divider ................................................................................................................................................ 81313 

b) Adapter 

2.4 mm (f)-2.4 mm (f) adapter * 1 

c) Cable 

BNC (m-m) cable * 1 

2.4 mm (m-m) cable * 1 

d) Test steps 

1) Connect the power meter and the power probe and zero them, and set the calibration factor frequency to 50 

MHz. 

2) Connect the test device according to Fig 15. The spectrum analyzer provides the reference frequency for the 

synthesized signal generator 1464C, and the output of the signal source is connected to the RF input port of 

the spectrum analyzer and the power probe respectively through the power divider. 

3) Set up the spectrum analyzer as follows: 

Center frequency ...................................................................................................................................... 50 MHz 

Reference level .......................................................................................................................................... 0 dBm 

Marker ............................................................................................................................................................ Off 
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Span ............................................................................................................................................................ 1 kHz 

Resolution bandwidth ................................................................................................................................. 10 Hz 

4) Set the frequency of 1464C to 50 MHz and the amplitude to 6 dBm, with the amplitude step of 0.05 dB. 

5) Press 【Peak】 on the spectrum analyzer. 

6) Press 【Ampt】 on 1464C and adjust the amplitude with 【↑】 and 【↓】 keys till the spectrum analyzer 

accurately reads 0 dBm0.05 dB. Set the amplitude step to 10 dB. 

7) Press 【Peak】 【Marker】 [Detla] on the spectrum analyzer. 

8) Adjust the output signal amplitude of 1464C to reduce the power meter reading by 10 dB0.05 dB. 

9) Carry out the following calculation (reading of the differential marker amplitude of the spectrum analyzer - 

power change value of the signal source); record the calculated data in the corresponding test item of the 

4041 Series Spectrum Analyzer Record Sheet, and repeat steps 8-9. 

11.16 Total level uncertainty 

Description: The difference between the output power reading of the test synthesized signal generator of the 

power meter and the output reading of the test signal generator of the spectrum analyzer is the total level 

uncertainty. The indicator will be affected by the indicator of the front end programmed step attenuator and the 

frequency response indicator of microwave & millimeter-wave variable frequency channel, and considering this, 

the amplitude accuracy specifications of different frequency points of different attenuation test setup and when the 

attenuation is 0dB, so as to ensure the comprehensiveness of the indicator test. 

A) Testing equipment 

Synthesized signal generator  ................................................................................................................... 1464C 

Power meter ......................................................................................................................................... ML2437A 

Power sensor ........................................................................................................................................ MA2445D 

Power divider .............................................................................................................................................. 81313 

b) Adapter 

2.4 mm (f)-2.4 mm (f) adapter * 2 

c) Cable 

BNC (m-m) cable * 1 

2.4 mm (m-m) cable * 1 

d) Test steps 



Chapter XI Performance Characteristics Test 

168 

 

Fig 11-16 Total Level Uncertainty Testing Setup 

1) Connect the power meter and the power probe and zero them. 

2) As shown in Fig 16, connect the outputs of the test device and the signal generator with the SUM port of the 

power divider, and connector the PORT1 port and PORT2 port to the RF input port and power probe of 4041 

spectrum analyzer respectively. 

Total level uncertainty (change the attenuator setting) 

3) Set the frequency of 1464C to 50 MHz and the amplitude to -15 dBm after reset. 

4) Set up the spectrum analyzer as follows: 

Center frequency ...................................................................................................................................... 50 MHz 

Span ........................................................................................................................................................ 100 kHz 

Reference level ....................................................................................................................................... -10 dBm 

Resolution bandwidth ................................................................................................................................. 1 kHz 

Video bandwidth ....................................................................................................................................... 100 Hz 

5) Adjust the output signal amplitude of the signal generator to make the power meter reading be -25 dB. 

6) Set the spectrum analyzer marker to the peak value, read the level L displayed by the spectrum analyzer marker 

and the test reading Lpower meter of the power meter. Calculate the total level uncertainty △L as follows: 

L L L   功率计                                                  (7) 

Record the calculated △L as the test result of the total level uncertainty in the 4041 Series Spectrum Analyzer 

Record Sheet. 

7) Repeat step 6 to test the total level uncertainty indicator when the attenuation value of the internal 

programmed step attenuator is 10 dB and 20 dB. 

8) Set the reference level of the spectrum analyzer to 20 dBm, and change the output power level of the signal 

generator to make the power meter reading be -5 dBm. 

9) Repeat step 6 to test the total level uncertainty indicator when the attenuation of the programmed step 
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attenuator is 30 dB, 40 dB and 50 dB. 

10) Change the frequency setting of the signal generator, power meter and spectrum analyzer according to the 

4041 Series Spectrum Analyzer Record Sheet, and repeat steps 5~9 until the test of all frequency points 

needing the attenuator setting changes is completed. 

Total level uncertainty (frequency response test) 

11) Set the frequency of the signal generator 1464C to 500 MHz and the output power to -15 dBm. 

12) Set the calibration factor frequency of the power meter to be the same as that of the signal generator, and 

adjust the output power level of 1464C to make the power meter reading close to -25 dBm. 

13) Set the center frequency of the spectrum analyzer to 500 MHz, reference level to -10 dBm, and attenuation to 

0 dB, and repeat step 6. 

14) Change the frequency setting of the signal generator 1464C, power meter and spectrum analyzer according to 

the 4041 Series Spectrum Analyzer Record Sheet, and repeat steps 11~13 until the test of all frequency points 

when the attenuation is 0 dB is completed. 

11.17 Input attenuator 

Description: The test is intended to measure the attenuation switching uncertainty within the 50 dB range of the 

attenuator in the whole frequency band. The reference input of the synthesized signal generator is provided by 10 

MHz of the spectrum analyzer. The switching uncertainty is set based on 0 dB attenuator. 

A) Testing equipment 

Synthesized signal generator  1464C 

b) Adapter 

2.4 mm (f)-2.4 mm (f) adapter * 2 

c) Cable 

BNC (m-m) cable×1 (120 cm) 

2.4 mm (m-m) cable×1 (100cm) 

d) Test steps 

Fig 11-17 Input Attenuator Switching Uncertainty Testing Setup 

1) Connect the test device according to Fig 11-17. The spectrum analyzer provides reference frequency for the 
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synthesized signal generator 1464C. 

2) Set the output power level frequency of the signal generator to -13dBm and the output frequency to 100 

MHz. 

3) Press 【Preset】 on the spectrum analyzer, and set it as follows: 

Center frequency .............................................................................................................................. 100 MHz 

Span .................................................................................................................................................... 100 Hz 

Reference level ................................................................................................................................. -10 dBm 

Attenuation ............................................................................................................................................. 0 dB 

Resolution bandwidth ........................................................................................................................... 10 Hz 

4) Wait for completion of the new sweep, and press 【Peak】, 【Marker】 and [Detla]. In this case, the attenuator 

attenuation value at 0 dB can be made as a reference. 

5) Set the spectrum analyzer; press 【Ampt】 [Attenuation Automatic Manual], and set the attenuation value of 

the attenuator according to the test form. 

6) After the sweep is completed, press 【Peak】, and the amplitude of the current differential marker is the 

attenuator switching error. 

7) Repeat steps 5-6 until the test of all the attenuation values of the attenuator is completed, and then record the 

test result in the 4041 Series Spectrum Analyzer Record Sheet. 

11.18 Input voltage standing wave ratio test 

A) Testing equipment 

Network analyzer N5245A 

A set of 2.4 mm calibration kit (including open circuit, short circuit and load) 

2.4 mm (m-m) calibration cable×1 

b) Test steps 
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Fig 11-18 Input Port Voltage Standing Wave Ratio Test 

1) Set the frequency range and source output power of the vector network analyzer as appropriate and select 

VSWR display mode. 

2) Carry out the single port measurement calibration (including open circuit, short circuit and load calibration) 

of the vector network analyzer at the end of the calibration cable. 

3) After the calibration, remove the calibration kit from the end of the calibration cable and connect it to the RF 

input port of the spectrum analyzer, as shown in Fig 11-18. 

4) Press 【Preset】 on the spectrum analyzer, wait for restart and enter the Spectrum Analyzer measurement 

interface. 

5) Read the maximum voltage standing wave ratio (VSWR) on the vector network analyzer with marker 

functions. 

6) Record the test result in the corresponding test item of the 4041 Series Spectrum Analyzer Record Sheet. 

11.19 Maximum fail-safe input level 

After 4041 spectrum analyzer is powered on and normally started, set 【Ampt】 [Ref Level] to +30 dBm. If the 

reference level displayed by the instrument is +30 dBm, there is no error message and the reference level 

displayed on the left side of the spectrum analyzer is +30 dBm, it means that the maximum fail-safe input level of 

the spectrum analyzer is normal. 

This performance test is guaranteed by the design of RF front-end microwave parts in the spectrum analyzer. 

11.20 Displayed scale 

After 4041 spectrum analyzer is powered on and normally started, set 【Ampt】 [Scale Type Logarithm Linearity], 

and manually set the requirements of “0.1~10 dB per division, 0.1 dB step per division (10-division display)”. 

【Ampt】 [Scale Type Logarithm Linearity] display range is 10 divisions. The 【Ampt】 [Amplitude unit] can 

provide 11 scale units including dBm, dBW, dBV, dBmV, dBμV, dBA, dBmA, dBμA, Volts, Watts. It means that 

the displayed scale of the spectrum analyzer is normal. 

11.21 Video BW 
After the 4041 series spectrum analyzer is powered on and normally started, set the resolution BW to 10 MHz, 

and press 【↓】. In case of every change of the resolution BW, the corresponding BW will be deemed to be 

automatically changed once. In addition, it will have an automatic coupling with the resolution BW, with the 
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minimum frequency of 1 Hz, and 1-3 steps.



 

173 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Article III Maintenance 

Instructions 



 

174 



Chapter XII Fault Information Description and Repair Methods 

175 

Chapter XII Fault Information Description and Repair Methods 

This chapter will show you how to discover problems and receive after-sales service. It also includes an 

explanation of the fault information of the spectrum analyzer. 

If you have purchased 4041 series spectrum analyzer and encountered some problems during operation, or you 

need to purchase relevant parts, options or accessories of the spectrum analyzer, the company will provide perfect 

after-sales service. 

Usually, the cause of the problem comes from the improper use of hardware, software or misuse by the user. 

Please contact us if there is any problem. If the spectrum analyzer you purchased is still in the warranty period, we 

will carry out free-of-charge maintenance to your spectrum analyzer according to the commitment on the warranty 

bill. If the spectrum analyzer is beyond the warranty period, we will only charge for the cost. 

Section 1 Fault Information Description 

 
 Description 

This part is to guide you how to carry out simple judgment and handling when the 

4041 series spectrum analyzer has any fault. If necessary, please feed back the 

problem to the manufacturer as accurately as possible, so that we can solve it as soon 

as possible. 

If there is a problem with the 4041 series you use, you can check it according to the following tips. If the problem 

still exists, please contact us. 

 If the 4041 series can’t be started after the power button is pressed down, please check whether the power 

supply is normal. If there is no problem, the device will be deemed to have faults, please contact us for 

repair. 

 If the 4041 series can’t enter the system or application procedure after start, please press 【Preset】 button to 

make it return to a known state. If it can’t normally work yet, it will be deemed to have faults, please contact 

us for repair. 

 If the performance indicator of 4041 series is abnormal, please check whether the test tools and test 

environment conform to the requirements and test whether the port connector is damaged or normal. If there 

is no problem, the device will be deemed to have faults, please contact us for repair. 

 If the 4041 series can’t communicate via the LAN , firstly confirm the tester IP address setting, and check 

the yellow indicator light next to the top panel LAN interface. If the light is not flashing, check the LAN 

cable and connection. If there is no problem, the device will be deemed to have faults, please contact us for 

repair. 
Section 2 Repair Methods 

Please contact us by phone or fax when your 4041 series has an unsolvable problem. If the instrument has to be 

repaired, please pack it according to the following steps: 

1) Prepare a paper document describing the malfunction of the instrument and put it in the packaging box with 

the tester; 

2) Wrap the instrument with the original packaging material to reduce possible damage; 

3) Put the linings at four corners of the outer packaging box, and put the instrument in the outer packaging box; 

4) Seal the packaging box with tapes, and reinforce it with nylon tape; 

5) Mark “Fragile! No Touch! Handle with Care!” on the box; 

6) Consign for shipment as the precision instrument, and keep copies of all transport documents.
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Appendix A Test Results of Performance Characteristics 

Attached Table Test Results for Performance Characteristics of 4041 Series Spectrum Analyzer 

Instrument No.: Tested by:                                    

Test conditions: Test date: MM         DD         YY  

Table A.1 4041 Series Spectrum Analyzer Record Sheet 

No. Test Item Unit Standard Requirements Test Result 

1 
Design and 

structure 

/ Structure type: Portable 

 

/ 
Appearance color: Front panel: Gray-white, housing: 

Black 

/ 

The appearance of the complete unit shall be clean 

and pleasant; the panel identification shall be legible; 

the key and knob shall be flexible, and the structure 

shall have convenient and proper plugging and 

without obvious mechanical damage or stain 

2 Function 

/ Spectrum measurement function  

/ Power kit measurement function  

/ Audio demodulation function  

/ IQ capture function  

3 Option 

/ Tracking generator function  

/ GPS function  

/ USB Power meter  

 Interference Analyzer  

 AM/FM/PM analyzer  

/ Scan Channels  

/ Field Strength Measurement  

/ Zero span intermediate frequency output  

4 Frequency range 

/ Lower frequency limit 9 kHz±21 Hz  

/ Upper frequency limit 
Upper limit of the model 

frequency range ±21 Hz 
 

5 
Frequency readout 

accuracy 

kHz 
3.0 GHz (frequency 

width 500 kHz): 
±12.70  

MHz 
3.0 GHz (frequency 

width 50 MHz): 
±1.03  

MHz 
3.0 GHz (frequency 

width 500 MHz): 
±10.30  
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Note: The test form is applicable for the normal temperature test of 4041D/E/F/G spectrum analyzers. During the test, the content 

shall be tailored according to the specific model as well as the configuration of the option to adapt to the actual test and inspection 

requirements. 

kHz 
5.5 GHz (frequency 

width 500 kHz): 
±14.70  

MHz 
5.5 GHz (frequency 

width 50 MHz): 
±1.03  

MHz 
5.5 GHz (frequency 

width 500 MHz): 
±10.30  

kHz 
7.0 GHz (frequency 

width 500 kHz): 
±15.90  

MHz 
7.0 GHz (frequency 

width 50 MHz): 
±1.03  

MHz 
7.0 GHz (frequency 

width 500 MHz): 
±10.30  

kHz 
8.5 GHz (frequency 

width 500 kHz): 
±17.10  

MHz 
8.5 GHz (frequency 

width 50 MHz): 
±1.03  

MHz 
8.5 GHz (frequency 

width 500 MHz): 
±10.30  

kHz 
10.0 GHz (frequency 

width 500 kHz): 
±18.30  

MHz 
10.0 GHz (frequency 

width 50 MHz): 
±1.03  

MHz 
10.0 GHz (frequency 

width 500 MHz): 
±10.30  

kHz 
12.0 GHz (frequency 

width 500 kHz): 
±19.90  

MHz 
12.0 GHz (frequency 

width 50 MHz): 
±1.03  
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Table A.1 (Continued 1) 4041 Series Spectrum Analyzer Record Sheet 

S/N Test Item Unit Standard Requirements Test Result 

5 
Frequency readout 

accuracy 

MHz 
12.0 GHz (frequency width 500 

MHz): 
±10.30  

kHz 
15.0 GHz (frequency width 500 

kHz): 
±22.30  

MHz 
15.0 GHz (frequency width 50 

MHz): 
±1.04  

MHz 
15.0 GHz (frequency width 500 

MHz): 
±10.31  

kHz 
19.0 GHz (frequency width 500 

kHz): 
±25.50  

MHz 
19.0 GHz (frequency width 50 

MHz): 
±1.04  

MHz 
19.0 GHz (frequency width 500 

MHz): 
±10.31  

kHz 
24.0 GHz (frequency width 500 

kHz): 
±29.50  

MHz 
24.0 GHz (frequency width 50 

MHz): 
±1.04  

MHz 
24.0 GHz (frequency width 500 

MHz): 
±10.31  

kHz 
29.0 GHz (frequency width 500 

kHz): 
±33.50  

MHz 
29.0 GHz (frequency width 50 

MHz): 
±1.05  

MHz 
29.0 GHz (frequency width 500 

MHz): 
±10.32  

kHz 
34.0 GHz (frequency width 500 

kHz): 
±37.50  

MHz 
34.0 GHz (frequency width 50 

MHz): 
±1.05  

MHz 
34.0 GHz (frequency width 500 

MHz): 
±10.32  

kHz 
43.0 GHz (frequency width 500 

kHz): 
±44.70  

MHz 
43.0 GHz (frequency width 50 

MHz): 
±1.06  
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MHz 
43.0 GHz (frequency width 500 

MHz): 
±10.33  

6 Span accuracy 

/ 1 kHz ±2.0%  

/ 10 kHz ±2.0%  

/ 100 kHz ±2.0%  

/ 1 MHz ±2.0%  

/ 10 MHz ±2.0%  

/ 100 MHz ±2.0%  

/ 1GHz ±2.0%  

/ 10 GHz ±2.0%  

7 
Sweep 

Time 

Range / 10 μs~600 s (zero span)   

Accuracy 

/ 1 ms ±2.0%  

/ 10 ms ±2.0%  

/ 100 ms ±2.0%  

/ 1 s ±2.0%  

/ 10 s ±2.0%  

8 
Resolution BW 

accuracy 

/ 10 MHz ±20.0%  

/ 3 MHz ±10.0%  

/ 1 MHz ±10.0%  

/ 300 kHz ±10.0%  

/ 100 kHz ±10.0%  

/ 30 kHz ±10.0%  
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Table A.1 (Continued 2) 4041 Series Spectrum Analyzer Record Sheet 

S/N Test Item Unit Standard Requirements Test Result 

8 
Resolution BW 

accuracy 

/ 10 kHz ±10.0%  

/ 3 kHz ±10.0%  

/ 1 kHz ±10.0%  

9 

Resolution 

Bandwidth 

Switching 

uncertainty 

dB 10 MHz ±1.20  

dB 3 MHz ±1.20  

dB 1 MHz ±1.20  

dB 300 kHz ±1.20  

/ 100 kHz Reference  

dB 30 kHz ±1.20  

dB 10 kHz ±1.20  

dB 3 kHz ±1.20  

dB 1 kHz ±1.20  

dB 300 Hz ±1.20  

dB 100 Hz ±1.20  

dB 30 Hz ±1.20  

dB 10 Hz ±1.20  

dB 3 Hz ±1.20  

dB 1 Hz ±1.20  

10 

Sideband noise        

(carrier frequency 

1GHz) 

dBc/Hz +10 kHz                              ≤-102  

dBc/Hz -10 kHz                          ≤-102  

dBc/Hz +100 kHz                            ≤-106  

dBc/Hz -100 kHz                             ≤-106  

dBc/Hz +1 MHz                              ≤-111  

dBc/Hz -1 MHz ≤-111  

dBc/Hz +10 MHz                            ≤-123  

dBc/Hz -10 MHz                             ≤-123  
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11 
Displayed average 

noise level 

dBm 
2 MHz~10 MHz (preamplifier 

on) 
≤-150  

dBm 
10 MHz~20 GHz (preamplifier 

on) 
≤-157  

dBm 
20 GHz~32 GHz (preamplifier 

on) 
≤-154  

dBm 
32 GHz~40 GHz (preamplifier 

on) 
≤-148  

dBm 
40 GHz~44 GHz (preamplifier 

on) 
≤-140  

dBm 
2 MHz~10 MHz (preamplifier 

off) 
≤-135  

dBm 
10 MHz~20 GHz (preamplifier 

off) 
≤-138  

dBm 
20 GHz~32 GHz (preamplifier 

off) 
≤-135  

dBm 
32 GHz~40 GHz (preamplifier 

off) 
≤-127  

dBm 
40 GHz~44 GHz (preamplifier 

off) 
≤-120  

12 
Second harmonic 

distortion 

dBc <4 GHz <-60  

dBc 4 GHz~10 GHz <-60  

dBc 10 GHz~ 22 GHz <-60  
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Table A.1 (Continued 3) 4041 Series Spectrum Analyzer Record Sheet 

S/N Test Item 
Unit 

Standard Requirements 
Test 

Result 

13 

Third-order 

intermodulation 

distortion 

dBm 50 MHz~4 GHz    ≥+7  

dBm 4 GHz~13 GHz ≥+6  

dBm 13 GHz~44 GHz ≥+6  

14 1dB gain compression 

dBm 50 MHz~4 GHz    ≥-2  

dBm 4 GHz~13 GHz ≥-3  

dBm 13 GHz~44 GHz ≥-3  

15 

Image, 

multiple, 

and 

out-of-band 

responses 

2GHz 

dBc 
Image frequency 15,080.5 

MHz 
<-65  

dBc Image frequency 2,280.5 MHz <-65  

dBc Image frequency 2,062.5 MHz <-65  

8GHz 

dBc Image frequency 11,480.5 MHz <-65  

dBc Image frequency 8,280.5 MHz <-65  

dBc Image frequency 8,062.5 MHz <-65  

15GHz 

dBc Image frequency 21,680.5 MHz <-65  

dBc Image frequency 15,280.5 MHz <-65  

dBc Image frequency 15,062.5 MHz <-65  

24GHz 

dBc Image frequency 40,800 MHz <-60  

dBc Image frequency 20,519.5 MHz <-60  

dBc Image frequency 24,280.5 MHz <-60  

dBc Image frequency 24,062.5 MHz <-60  

42GHz 

dBc Image frequency 21,600 MHz <-60  

dBc Image frequency 38,519.5 MHz <-60  

dBc Image frequency 42,280.5 MHz <-60  

dBc Image frequency 42,062.5 MHz <-60  

16 Residual response 

dBm 10 MHz~20 GHz (preamplifier on)  ≤ -100  

dBm 
20 GHz~upper frequency limit 

(preamplifier on) 
≤ -95  
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dBm 

 
10 MHz~13 GHz (preamplifier off) ≤ -90  

dBm 

 
13 GHz~20 GHz (preamplifier off) ≤ -85  

dBm 

 

20 GHz~upper frequency limit 

(preamplifier off) 
≤ -80  

17 
Reference 

Level 

Range / 
Logarithmic scale: -120 dBm~+30 dBm, 1 dB step  

Linear scale: 22.36uV~7.07V, 0.1% step 
 

Switching 

error 

/ 0 dBm Reference  

dB -10 dBm ±1.20  

dB -20 dBm ±1.20  

dB -30 dBm ±1.20  

dB -40 dBm ±1.20  

dB -50 dBm ±1.20  

18 Scale fidelity 

dB -10 dBm ±1.00  

dB -20 dBm ±1.00  

dB -30 dBm ±1.00  

dB -40 dBm ±1.00  

dB -50 dBm ±1.00  

dB -60 dBm ±1.00  
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Table A.1 (Continued 4) 4041 Series Spectrum Analyzer Record Sheet 

S/N Test Item Unit Standard Requirements Test Result 

19 
Total level 

uncertainty 

dB 50 MHz (attenuation 0 dB, input -25 dBm): ±1.80  

dB 50 MHz (attenuation 10 dB, input -25 dBm): ±1.80  

dB 50 MHz (attenuation 20 dB, input -25 dBm): ±1.80  

dB 50 MHz (attenuation 30 dB, input -5 dBm): ±1.80  

dB 50 MHz (attenuation 40 dB, input -5 dBm): ±1.80  

dB 50 MHz (attenuation 50 dB, input -5 dBm): ±1.80  

dB 6 GHz (attenuation 0 dB, input -25 dBm): ±1.80  

dB 6 GHz (attenuation 10 dB, input -25 dBm): ±1.80  

dB 6 GHz (attenuation 20 dB, input -25 dBm): ±1.80  

dB 6 GHz (attenuation 30 dB, input -5 dBm): ±1.80  

dB 6 GHz (attenuation 40 dB, input -5 dBm): ±1.80  

dB 6 GHz (attenuation 50 dB, input -5 dBm): ±1.80  

dB 10 GHz (attenuation 0 dB, input -25 dBm): ±1.80  

dB 10 GHz (attenuation 10 dB, input -25 dBm): ±1.80  

dB 10 GHz (attenuation 20 dB, input -25 dBm): ±1.80  

dB 10 GHz (attenuation 30 dB, input -5 dBm): ±1.80  

dB 10 GHz (attenuation 40 dB, input -5 dBm): ±1.80  

dB 10 GHz (attenuation 50 dB, input -5 dBm): ±1.80  

dB 15 GHz (attenuation 0 dB, input -25 dBm): ±2.30  

dB 15 GHz (attenuation 10 dB, input -25 dBm): ±2.30  

dB 15 GHz (attenuation 20 dB, input -25 dBm): ±2.30  

dB 15 GHz (attenuation 30 dB, input -5 dBm): ±2.30  

dB 15 GHz (attenuation 40 dB, input -5 dBm): ±2.30  

dB 15 GHz (attenuation 50 dB, input -5 dBm): ±2.30  

dB 20 GHz (attenuation 0 dB, input -25 dBm): ±2.30  

dB 20 GHz (attenuation 10 dB, input -25 dBm): ±2.30  

dB 20 GHz (attenuation 20 dB, input -25 dBm): ±2.30  
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dB 20 GHz (attenuation 30 dB, input -5 dBm): ±2.30  

dB 20 GHz (attenuation 40 dB, input -5 dBm): ±2.30  

dB 20 GHz (attenuation 50 dB, input -5 dBm): ±2.30  

dB 25 GHz (attenuation 0 dB, input -25 dBm): ±2.30  

dB 25 GHz (attenuation 10 dB, input -25 dBm): ±2.30  

dB 25 GHz (attenuation 20 dB, input -25 dBm): ±2.30  

dB 25 GHz (attenuation 30 dB, input -5 dBm): ±2.30  

dB 25 GHz (attenuation 40 dB, input -5 dBm): ±2.30  

dB 25 GHz (attenuation 50 dB, input -5 dBm): ±2.30  

dB 32 GHz (attenuation 0 dB, input -25 dBm): ±2.30  

dB 32 GHz (attenuation 10 dB, input -25 dBm): ±2.30  

dB 32 GHz (attenuation 20 dB, input -25 dBm): ±2.30         

dB 32 GHz (attenuation 30 dB, input -5 dBm): ±2.30  

dB 32 GHz (attenuation 40 dB, input -5 dBm): ±2.30  
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Table A.1 (Continued 5) 4041 Series Spectrum Analyzer Record Sheet 

S/N Test Item Unit Standard Requirements Test Result 

19 
Total level 

uncertainty 

dB 32GHz (attenuation 50 dB, input -5 dBm): ±2.30  

dB 40GHz (attenuation 0 dB, input -25 dBm): ±2.30  

dB 40GHz (attenuation 10 dB, input -25 dBm): ±2.30  

dB 40GHz (attenuation 20 dB, input -25 dBm): ±2.30  

dB 40GHz (attenuation 30 dB, input -5 dBm): ±2.30  

dB 40GHz (attenuation 40 dB, input -5 dBm): ±2.30  

dB 40GHz (attenuation 50 dB, input -5 dBm): ±2.30  

dB 500MHz(attenuation 0 dB, input -25 dBm): ±1.80  

dB 1.5GHz (attenuation 0 dB, input -25 dBm): ±1.80  

dB 2.5GHz (attenuation 0 dB, input -25 dBm): ±1.80  

dB 3.5 GHz (attenuation 0 dB, input -25 dBm): ±1.80  

dB 4.5GHz (attenuation 0 dB, input -25 dBm): ±1.80  

dB 5.5GHz (attenuation 0 dB, input -25 dBm): ±1.80  

dB 6.5GHz (attenuation 0 dB, input -25 dBm): ±1.80  

dB 7.5GHz (attenuation 0 dB, input -25 dBm): ±1.80  

dB 8.5GHz (attenuation 0 dB, input -25 dBm): ±1.80  

dB 9.5GHz (attenuation 0 dB, input -25 dBm): ±1.80  

dB 10.5GHz(attenuation 0 dB, input -25 dBm): ±1.80  

dB 11.5GHz(attenuation 0 dB, input -25 dBm): ±1.80  

dB 12.5GHz(attenuation 0 dB, input -25 dBm): ±1.80  

dB 13.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 14.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 15.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 16.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 17.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 18.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 19.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  
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dB 20.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 21.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 22.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 23.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 24.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 25.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 26.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 27.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 28.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 29.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 30.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 31.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  

dB 32.5GHz(attenuation 0 dB, input -25 dBm): ±2.30  
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Table A.1 (Continued 6) 4041 Series Spectrum Analyzer Record Sheet 

S/N Test Item Unit Standard Requirements 
Test 

Result 

19 Total level uncertainty 

dB 
33.5GHz (attenuation 0 dB, input -25 

dBm): 

±2.30 
 

dB 
34.5GHz (attenuation 0 dB, input -25 

dBm): 

±2.30 
 

dB 
35.5GHz (attenuation 0 dB, input -25 

dBm): 

±2.30 
 

dB 
36.5GHz (attenuation 0 dB, input -25 

dBm): 

±2.30 
 

dB 
37.5GHz (attenuation 0 dB, input -25 

dBm): 

±2.30 
 

dB 
38.5GHz (attenuation 0 dB, input -25 

dBm): 

±2.30 
 

dB 
39.5GHz (attenuation 0 dB, input -25 

dBm): 

±2.30 
 

20 Attenuator 

Range / 0~50 dB, 10 dB step  

Switching 

uncertainty 

/ Attenuation 0 dB Reference  

dB Attenuation 10 dB ±1.20  

dB Attenuation 20 dB ±1.20  

dB Attenuation 30 dB ±1.20  

dB Attenuation 40 dB ±1.20  

dB Attenuation 50 dB ±1.20  

21 
Input voltage 

standing wave ratio 

/ <20 GHz                             ≤ 1.80:1  

/ 20 GHz~ 44 GHz                  ≤ 2.20:1  

22 Maximum safe input level 
/ +30 dBm (continuous wave, automatic 

coupling of input attenuator) 
 

23 Displayed scale 
/ 0.1~10 dB per division, minimum 0.1 dB step 

(10-step display) 
 

24 Video Bandwidth / BW range: 1 Hz10 MHz (1-3 steps)  

25 Interface RF interface 

/ RF input interface (corresponding to the 

interface type of the product model) 
 

/ RF output interface: type N(f) (assemble only 

when the tracking generator option is 
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configured) 

Communication 

interface 

/ Front panel USB interface: Type A, two  

/ Rear panel USB interface: Type A, two; type 

B, one 
 

/ LAN interface: RJ45 type  

Frequency 

reference 

/ 
Reference input/output, BNC female type  

Other interface 

/ GPS antenna, external trigger output, zero 

span medium frequency output: BNC female 

type 

 

/ VGA interface: 15-pin D-SUB adapter  

26 Safety 

/ Electrical strength resistance requirements: 

AC 1,500 V, 10 mA/min; no breakdown, no 

arc. 

 

mA Voltage 242 V, leakage current: ≤  3.5 mA, 

1 min. 
 

MΩ 

The insulation resistance between the power 

input end and the housing shall not be smaller 

than 100 MΩ under standard atmospheric 

pressure. 

 

The insulation resistance between the power 

input end and the housing shall not be smaller 

than 2 MΩ in the humid environment 

respectively. 

 

Description 

1. “√” indicates that the function is normal or it meets the requirements; “X” indicates that the 

function is abnormal or it doesn’t meet the requirements; 

2. “/” indicates that this test item is not available. 

 Comprehensive judgment: PASS□   FAIL□ 
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Table A.2 4041 Series Spectrum Analyzer Record Sheet (Tracking Generator Option) 

S/N Test Item Unit Standard Requirements Test Result 

1 Frequency range 

/ Lower limit of the frequency range: 100 kHz  

/ Upper limit of the frequency range: 20 GHz  

2 
Frequency 

accuracy 

kHz 1 GHz ±0.80  

kHz 2 GHz ±1.60  

kHz 6 GHz ±4.80  

kHz 18 GHz ±14.40  

3 
Phase noise 

(6GHz carrier) 

dBc/Hz +10 kHz -85  

dBc/Hz -10 kHz -85  

dBc/Hz +100 kHz -90  

dBc/Hz -100 kHz -90  

4 Amplitude range / Range: -5 dBm~-35 dBm  

5 
Amplitude 

accuracy 

dB 100 MHz, -5 dBm 

output 
±3.5  

dB 100 MHz, -10 dBm 

output 
±3.5  

dB 100 MHz, -20 dBm 

output 
±3.5  

dB 100 MHz, -30 dBm 

output 
±3.5  

dB 100 MHz, -35 dBm 

output 
±3.5  

dB 4 GHz, -5 dBm output ±3.5  

dB 4 GHz, -10 dBm output ±3.5  

dB 4 GHz, -20 dBm output ±3.5  

dB 4 GHz, -30 dBm output ±3.5  

dB 4 GHz, -35 dBm output ±3.5  

dB 8 GHz, -5 dBm output ±3.5  

dB 8 GHz, -10 dBm output ±3.5  

dB 8 GHz, -20 dBm output ±3.5  

dB 8 GHz, -30 dBm output ±3.5  
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dB 8 GHz, -35 dBm output ±3.5  

dB 12GHz, -5 dBm output ±3.5  

dB 12GHz,-10 dBm output ±3.5  

dB 12GHz,-20 dBm output ±3.5  

dB 12GHz,-30 dBm output ±3.5  

dB 12GHz,-35 dBm output ±3.5  

dB 16 GHz, -5 dBm output ±3.5  

dB 16GHz,-10 dBm output ±3.5  

dB 16GHz,-20 dBm output ±3.5  

dB 16GHz,-30 dBm output ±3.5  

dB 16GHz,-35 dBm output ±3.5  

Description 

1. “√” indicates that the function is normal or it meets the requirements; “X” indicates that the 

function is abnormal or it doesn’t meet the requirements; 

2. “/” indicates that this test item is not available. 

 Comprehensive judgment: PASS□   FAIL□ 

 


